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Preface

This ASG-SmartQuest User’s Guide provides information to help you use
ASG-SmartQuest (herein called SmartQuest). SmartQuest is a powerful yet easy-to-use
tool for analyzing Batch and CICS transaction abends. It has been designed to make the
maximum use of simple point-and-shoot techniques to enable fast and easy navigation
through any data dump. An action bar, with associated pull-down screens, allows for
rapid selection of al areasin the dump as well as other dump- or product-related
information. Such features make the product easy to use and almost command free.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours aday, 7 days aweek.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

- Chapter 1, "Introducing SmartQuest," provides an introduction to SmartQuest.

- Chapter 2, "Using SmartQuest," describes how to use SmartQuest.

=  Chapter 3, "Anayzing Dumps," provides information for analyzing SmartQuest
dumps.

<  Chapter 4, "Utilities," describes the utilities that are available to provide additional
functions or to support the online features.

=  Chapter 5, "Reporting Problems," discusses the action that you should take in the
event of a problem with any component of this software.
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Related Publications

Vi

The documentation library for ASG-SmartQuest consists of these publications (where nn
represents the product version number):

e  ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-ESW suite of products.

e  ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for thisrelease.

e  ASG-SmartQuest Installation Guide (SQM0300-nn) provides installation
instructions for SmartQuest.

e  ASG-SmartQuest Quick Reference Card (SQM0900-nn) provides asummary of the
commands and functions within SmartQuest.

e  ASG-SmartQuest User’s Guide (SQM0200-nn) providesinstructions for using
SmartQuest.

Note:
To obtain a specific version of a publication, contact ASG Customer Support.




ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW

products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figurele+ ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Center

Analytical Engine

Application
Knowledge
Repository (AKR)

Y

[

ASG-Alliance for Application Understanding
ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis
ASG-SmartDoc for Program Documentation
ASG-SmartEdit for COBOL Intelligent Editing
ASG-SmartQuest for Analyzing Abends

ASG-SmartTest for Testing/Debugging
-TSO
- CICSs
- IMS
- ASM
- APS
- PLI
- TCA for Test Coverage Analysis
- DB2 Stored Procedure

Vi
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viii

This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by I T professionalsto conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance alows the programmer/
analyst to accurately perform application analysis
tasks in afraction of the time it would take to
perform these tasks without an automated
analysistool. Theimpact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

Thebridging product that enablesfield expansion
for program source code, without being required
to simultaneously expand the fieldsin files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for al ESW products.
Center providesthecommon Analytical Engineto
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergisticaly.




ASG-Encore

Encore

The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
Thecode generation facilitiesallow you to usethe
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate

Estimate

The resource estimation tool that enablesthe user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight

Insight

The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify dataflow,
find program anomalies, and trace logic paths. It
also has automated proceduresto assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap

Recap

The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysisinformation can also be viewed
interactively or exported to a database,
Spreadsheet, or graphics package.

ASG-SmartDoc

SmartDoc

The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
sourcelisting, structure charts, program summary
reports, exception reportsfor program anomalies,
and software metrics.




ASG-SmartQuest User’s Guide

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the | SPF/PDF
Editor isinvoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supportsall versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest  SmartQuest Thediagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programsin the TSO,
MV S Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembl ed object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site startsa
product directly, use the I SPF selection or CLIST asindicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the I SPF selection or CLIST asindicated by your systems administrator and then
typing in the product command on the command line.

The product names can a so vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration” on page xi for more information about
using ESW.




To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CcC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure P Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As aresult, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Allianceisinstalled, SmartTest provides a dynamic
link to Alliance that can be used to display program analysisinformation. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data rel ationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

xi
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Accessto these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure2+« EncorePrimary Screen

File Uiew Edtract Generate 3Zearch List Odptions Help

AEE-Encore
CoHHand ===
Aotttk Hetebbek bbbl Stk
Atk Hbtebk bbbkl ettt
Atttk Atttk Hhtebkbt kekR Atk
Aetetoick Aetetoick Atttk etk Atk
Atttk
Aotttk

Copyright ALLen $ystens Group, IncC., an unpublished work.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASGE Support Web Site at www.asg.cod

Xii



Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer » Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displaysif Insight isinstalled.

Figure 3+« ESW Encore Primary Screen

File Uiew Edtract Generate fearch Logic List Options Help

AZG-EZN — Prograd Re-engineering

CorAdand ===
Atttk Eoos 2 I S s 2 Atk
Aotttk Aebbt bbbk Aotk
Atttk Atttk Atttk stk Atk
Atttk Atttk debittck deboiolk Aok
Aotk
ettt

Copwright Allen Systens Group, INC.. an unpubliszhed vork.
A proprietary product of ASG, InC. Use restricted to authorized licensess.
Wigit the AZG Support Web Zite at wuw,asg.coH

Example 2

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xiv shows the File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figured« File- Analyze Submit Screen

File - Analyze SUbHiT
ConAand ===

E - Edit JCL % = EubMiT JCL

CoHpile and link JCL [PDE or sequentiall:
Data set nane

Analyze features [T-M]:
ASG-3HartTests ¥ Extended Analysis:s M

AKR data set nawe
AKR proghad nade  NEWDEHO [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y«H] « o o o o o« o T [¥ if needad by features)
Link 1oad Hodule reusable® [Y-M] T

Xiii
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The actions shown on these screens can also vary. For example, the D - Doc Options
action isonly available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc isinstalled on your system. In Figure 4 on page xiii, the Doc Options

action is not displayed.

Figure5e« ASG-ESW - Prepare Program Screen (accessed through ESW)

CoHHand ===

AZE-EIN - Prepare Prograd

E - Edit TCL % - Eubmit TCL

CoHpile and link JCL [PDE oF sequentiall:
Data =&t nane

0 - Doc options

Analyze features [T-M]:
Understand: M Testl T
Re-&ngineetl N Abend<DuMpl N

AKR data set nane

Extended Analysiss M

Docurent: M

AKR prograd nane  MEWMDEHO

Analyze options:

[if overriding PROGRAR-IO)

CoHpile? [¥«<H] « « o« @ & o & o T
Link l1oad Hodule reusable® (v-M] T

[¥ if needad by features)
[Test and Abend-Ounp onlyl

Notice that the Analyze featuresfield in Figure 5 lists additional ESW products than
shown on Figure 4 on page xiii. Thisfield is automatically customized to contain the
ESW products you have installed on your system. These are the names of the analyze

types:
ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test
Extended Analysis (ASG-SmartTest with  Extended Analysis

Insight installed)

Xiv



Publication Conventions
ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plussign
(+) isinserted for key combinations (e.g., Alt+Tab).

lowercase italic Information that you provide according to your
monospace particular situation. For example, you would replace
T1lename with the actual name of thefile.

Monospace Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examplesin a paragraph.

Vertical Separator Bar (|) Optionsavailablewith thedefault valueunderlined (e.q.,
with underline Y|N).

Underline Denotes a cursor-selectable field or line.

ASG Customer Support

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG productsis the responsibility
of the respective vendor. In the event avendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of
that unsupported version.

XV
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (1SP). Y our logon information for ISP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where:

NNNNNNNNNN is your customer 1D supplied by ASG Product Distribution.
XXXXXXXXXX isyour unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide providesinstructions on how to usethe
ISP and islocated on the ASG Support web page.

Telephone Support

To expedite response time, please have this information ready:

- Product name, version number, and rel ease number

- List of any fixes currently applied

- Any alphanumeric error codes or messages written precisely as displayed
- A description of the specific steps that immediately preceded the problem

- Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in atext file on the distribution media
included with the Service Pack. Y ou can access the latest software corrections and Service
Packs viathe | SP.

- The severity code (ASG Customer Support uses an escalated severity system to prioritize
serviceto our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes
2 Major component of product disabled Within 2 hours
3 Problem with the product, but customer has ~ Within 4 hours
work-around solution
4 "How-to" questions and enhancement Within 4 hours
regquests

XVi


http://www.asg.com/support/support.asp

The Americas

Phone

Fax

E-mail

United States and
Canada

Europe, Middle East, and Africa (EMEA)

800.354.3578

1.703.464.4901

support@asg.com

During normal business hours, we recommend that you call the Central Support number

first (except in South Africa).

Phone Fax E-mail
Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl @asg.com
Spanish 34.913.523.800 34.917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com
Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com
All Other Countries (Also for any non-working numbers)

Phone Fax E-mail
All other countries  1.239.435.2201 support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.

XVvii



ASG-SmartQuest User’s Guide

ASG Documentation/Product Enhancements

XViii

Submit all product and documentation suggestions to ASG’ s product management team
at http://www.asg.com/asp/email productsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’ s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

1 Introducing SmartQuest

This chapter introduces SmartQuest and contains these sections:

SmartQuest Overview 1
Capturing Dumps 2
Examining Dumps Captured by SmartQuest 5
SmartQuest Abend Notification 5
SmartQuest Overhead 6
SmartQuest Resources 6
SmartQuest Robustness 7

SmartQuest Overview

SmartQuest is atool for analyzing Batch and CICS transaction abends, which provides
source-level support for your COBOL, PL/I, and Assembler programs. This means that
you can view the source code for your abending programs online with the failing
statement clearly highlighted. In addition, the individual contents of your program
variables are displayed for quick and easy examination. Most MV S and CICS control
blocks are shown mapped with their field names automatically and, if you use the source
support feature, SmartQuest al so automatically maps areas such as your COBOL working
storage and your PL/I DSA.

Source support can be obtained from ASG-SmartTest analyzed programs that residein an
ESW Application Knowledge Repository (AKR), or from ASG-SmartQuest’s own
support features.
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For DL/1 abends, a screen showing details of the last five CALLsis provided. These
screens enable you to quickly examine any of the DL/1 control blocks or CALL
parameters.

The dump index file allows you to view dumps captured in any of your CICS regions
from asingle CICS region or from a TSO/I SPF session.

Capturing Dumps

SmartQuest must be initialized before it can capture dumps. Y ou can do this
automatically in CICS by adding an entry to your start-up PLT, or manually by using the
CICS transaction (1QST) supplied with the product. The initiaization starts the
SmartQuest abend trapping mechanism.

Dump Capture Overview

SmartQuest can process multiple dumps and uses the dump repository to store and
manage each dump in a unigue dataset. The dump index file contains control records for
each dump file. Figure 6 is an overview of how SmartQuest manages dumps.

Figure 6+ SmartQuest Overview

CICS TSO/ISPF

Dump Viewer
Dump Capture Dump Viewer
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g

Dump
Index

Single
Single Dump
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File
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1 Introducing SmartQuest

Dump Repository Consists of one Dump File Index and one or more dump
files. Y ou can alocate one or more repositories.

Dump Repository Performs all required dump storage, retrieval, maintenance,
Manager and administrative functions. The Dump Repository
Manager runs as an MV S subtask in CICS systems.

Dump Index Contains control records that provide this information:
-  Dataset naming standards
«  Last used dump sequence number

e  Authorized volumes for dynamic VSAM file
alocation

Y ou can allocate and modify the Dump Index File using
option 2, Dump Index List Maintenance, on the SmartQuest
Maintenance Menu screen.

Dump File Containsanindividual, uniquely identified dump. Thedump
fileis dynamically allocated and catal oged by the Dump
Repository Manager as adump is recorded. The dataset
name is assigned based on the user-supplied naming
standards in the dump index file.

Processing Abends
Using an SVC 51 Intercept

When Batch jobs that have a SY SABEND, SYSUDUMP, or SYSMDUMP DD card in
their JCL deck abend, MV S issues an SV C 51 instruction unless you are using PL/I with
the STAE or SPIE run-time options or if you are using Language Environment run-time
libraries with TRAP(ON). SVC 51 isthe SNAP SV C and causes a snapshot dump to be
taken.

SmartQuest works by intercepting the SVC 51 calls (using approved, documented IBM
services) and, optionaly, writing all relevant information to aVSAM KSDS dataset, a
print SY SOUT, or both.
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When SmartQuest for MV S has completed its own dump capture, control is passed to the
true SVC 51 routine so that an IBM dump can also be captured. Y ou can suppress the
IBM dump using a SmartQuest customization option.

Note:

Y our job must contain a SY SABEND, SYSUDUMP, or SYSMDUMP DD card. The
SVC 51 routineis not driven if none of these DD cards are specified.

Using PL/I STAE and SPIE Run-time Options

If you use the PL/I STAE or SPIE run-time options, the SV C 51 snapshot dump is not
produced even if you include a SY SABEND, SY SUDUMP, or SY SMDUMP DD card.
Thisisbecause PL/I hasits own error handling routines that are given control when the
error occurs. Often these simply inform the programmer that an error has occurred at a
particular offset in a certain PL/I procedure, and also provides a brief description of the
nature of the error.

SmartQuest for MV S provides afull dump in such situations, including PL/I source-level
support. Thisis achieved by relinking the PL/I module that contains the PL/I error
handling routines. The relink of this module replaces the PL/I error handling routines
with a SmartQuest PL/I error handling routine. This allows SmartQuest to capture all of
the relevant dump information and write this to the VSAM KSDS dump file before
passing control on to the original PL/I error handling routine.

Using Language Environment Run-time Libraries

Like PL/I STAE/SPIE, Language Environment hasits own error handling routines. If you
have the option TRAP(ON), which IBM recommends, then the LE error handling
routines obtain control when an error occurs and a Language Environment dump is
produced (usually to the CEEDUMP SY SOUT dataset). While the information in this
SYSOUT file may be sufficient to resolve simple abends, many have found it to be
inadequate when investigating more serious errors and would prefer to have the SVC 51
type dump.

For Language Environment, SmartQuest gives you more than the CEEDUMP dump. Y ou
get the whole dump, as though from an SV C 51, but with the powerful source support and
easy point-and-shoot analysis interface.

The dump capture is accomplished by defining a Language Environment abend
termination exit program. Thisis also an IBM approved and documented technique. The
exit program that performs the dump captureis provided with SmartQuest and the simple
steps to enable this exit are described in the ASG-SmartQuest Installation Guide. After
dump capture is complete, control is passed to the true Language Environment error
handler which produces the normal CEEDUMP.
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How Abends are Processed in a CICS/ESA Environment

A CICS transaction dump can be requested due to a program abend, or by issuing an
EXEC CICS DUMP command. When SmartQuest is activated, it intercepts these
transaction dump requests and captures the entire transaction environment to a VSAM
KSDS dump dataset. It does this by suspending the dumping transaction and attaching an
MV S subtask to perform the actual capture. When capture is completed, the suspended
task resumes and continues with its normal processing, which may be to terminate.

Examining Dumps Captured by SmartQuest

Y ou can analyze any abend through a TSO/I SPF dump viewer session that can be
installed as a selection on the | SPF screen or invoked through a REXX EXEC.
Alternatively, you can use the CICS dump display interface (transaction IQDS) if thishas
been installed. The TSO/ISPF interface and the CICS interface are identical, with the
exception that ASG-SmartTest AKR source support is available only in the TSO viewer.

See "Using SmartQuest" on page 9 for detailed information about using the dump display
feature.

SmartQuest Abend Notification

When a transaction abends and terminates, and after the dump is captured, SmartQuest
displays a notification screen at the terminal where the abend occurred. This screenis
customizable and contains information asking the user to report the abend to a person, a
programming team, or ageneral help desk. Y ou can vary the contact name on this screen
according to the transaction ID or generic transaction ID of the abending task. You can
customize SmartQuest for CICSto issue a TSO notification to a specified TSO user and
vary the user 1D by transaction ID or generic transaction ID. Y ou can a so suppress the
displaying of this screen.

If aBatch job abends, SmartQuest issues a TSO notify to a specified TSO user or to
several TSO users. The user | Ds can be defined for a specific job or for a generic group of
jobs. Messages are also written to the MV S Console and JES job log. These messages
mark the progress of each abend asit is processed by SmartQuest.

Note:

See the ASG-SmartQuest Installation Guide for more information about customizing the
Notification screen.




ASG-SmartQuest User’s Guide

SmartQuest Overhead

In terms of processor usage, SmartQuest creates no overhead on your system until a
dump occurs. When a dump does occur, additional processing and /O take place. The
time that this requires varies depending on the size of the programs, storage areas being
used by the abending task, and whether dumps are occurring concurrently. In al cases,
the additional elapsed time is not excessive. The design of the product is such that only
the abending task is suspended while capture takes place. Other tasks are scheduled and
run as normal.

If you use the source-level support feature, overhead also increases when you compile
your programs. Again this varies greatly depending upon the size of the program you are
compiling and the number of declared variables that it contains.

SmartQuest Resources

Precise requirements are difficult to specify because the programs loaded, storage areas
acquired, and amount of temporary storage in use are highly variable depending on the
feature currently in use.

Where possible, SmartQuest makes use of above-the-line storage. Almost al of the
SmartQuest programs and storage reside above the line. Y ou can examine program size
with these methods:

 Using the CEMT transaction for CICS.
- Browsing the products LOADLIB and LINKLIB using the TSO browse facility for
MVS.

The dump viewer is pseudo conversational, so any storage that it obtains is freed upon
termination of the task.
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SmartQuest Robustness

Because the product is designed to run in production environments, its robustness has
been amajor feature of its design.

During dump capture, if errors occur (possibly dueto corruption of control blocksthat the
capture mechanism uses), SmartQuest recovers and continues the dump capture process.
If control blocks are so badly damaged that dump capture isimpossible, then the capture
process terminates and the suspended abending task resumesto allow it to produce a
normal dump.

Both the CICS and TSO/ISPF versions of the display feature can recover from any
internal error in the unlikely event of an abend. This prevents termination of your dump
analysis session and preserves such things as user-defined labels for marking areas of the
dump.
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2 Using SmartQuest

This chapter describes how to use SmartQuest and contains these sections:

Starting SmartQuest 9
Customizing Dump Captures (MV S Only) 14
Accessing the Dump Viewer Using the TSO Interface 15
Using the Dump Viewer Navigation Aids 17
Using the Dump Viewer 21

To analyze dumps, you can use the CICS or the TSO interface. For CICS, use the IQDS
transaction to enter the dump viewer. For TSO, select the SmartQuest TSO Facilities
Menu option that was added to one of your TSO menus at installation. If you do not know
which menu this has been added to, consult your systems programmer.

Note:

For SmartQuest Release 7.0, dumps that you captured using a previous rel ease of
SmartQuest cannot be viewed using the SmartQuest 7.0 viewer.

Starting SmartQuest

The method you use to invoke SmartQuest depends on your system setup. If your site
starts SmartQuest directly, use the ISPF selection or CLIST asindicated by your systems
administrator. After you activate the session, the SmartQuest primary screen displays.

If you need assistance to activate SmartQuest, see your systems administrator.
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If your site uses the ESW screen to start SmartQuest, initiate the ESW primary screen by
using the ISPF selection or the CLIST asindicated by your systems administrator. The
ESW primary screen, shown in Figure 7, displays.

Figure 7« Existing SystemsWorkbench Primary Screen

File Understand Change Test Docunent Re-engineer Heasure Help

1. Progrand ing Systens Morkbench - ASG-ESW

Conda | 2. Application
Z. Abend<DUHp
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Aottt Aetebbt bbbk Aotttk
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Aotttk
etttk

Copyright Allen Eystens Group, IncC., an unpublished vork.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wWW.asq.coH

To access SmartQuest, follow this step:

» Select Understand » Abend/Dump or type SQV on the command line and press Enter.
After you activate the session, the SmartQuest Primary Screen displays, as shownin

Figure 8.

Figure8+« SmartQuest Primary Screen

File Ujew Help

REG-EHartiuest
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Hepotedoh:

capyright Allen fwstens Group, INC., an unpublished wark.
A proprietary praduct of ASG, IncC.  Use pestricted to authorized 1licensess.
Uisit the AZG Zupport Uebk Zite at wuw.asg.cod
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To access the Maintenance facility screens to customize SmartQuest

1  Fromthe ESW primary screen, select File » Config Abend/Dump Facility on the
command line and press Enter. The ASG-SmartQuest - Configuration and

Customization Menu, shown in Figure 9, displays.

Note:

Thisfacility can be protected by a security product and may not be available, or can
fail, if you are not authorized.

If the Config Abend/Dump Facility option does not display on the File pull-down,

the CONFIG parameter in the VIASGBL CLIST has been set to NO and this option
isnot available. See the ASG-Center Installation Guide for more information about
the CONFIG parameter.

Figure9+ ASG-SmartQuest - Configuration and Customization Menu

option ===

Configuration:

1]  Allocate
2]  Allocate
3] Allocate
4]  Allocate
5]  Allocate

Customi zation:

and Initialize
and Initialize
and Initialize
and Initialize
and Initialize

UZER PROFILE V=AM datasetr

PRODUCT CONFIGURATION WEAH dataset
AEEND CODEZ and HELP UZAKH dataszets
APPLICATION PROGRAH ZOURCE UZAH datasetr
PRODUCT DUHP INWDEX UZAH datazet

SUpport i

Al Hanage APPLICATION PROGRAR SOURCE definitions
E] Hanage PRODUCT DURP INDEX definitions

] Hanage PRODUCT HUE DUMP CAPTURE PARAHETERE

o] Hanage PRODUCT CICE DUHP CAPTURE PARAHETERE:
El Hanage DUHP UIEMER CICE and HUZ PARAHETERS

HOM] Honitor SPECIFIC HUS or CIGES DUHP GAPTURES
IHU] DUHF FILE UTILITY

Enter OPTION or EMD to edit.

2  Select the option you want to modify. See the ASG-SmartQuest Installation Guide
for more information about these options.
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Performing a SmartQuest Analyze

To begin an analyze, follow this step:

» From the SmartQuest primary screen, select File » Prepare Program. The ASG-ESW

Prepare Program pop-up, shown in Figure 10, displays.

Figure 10« ASG-ESW Prepare Program Pop-up

AEG-EZW - Prepare Progr-an
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Analyze options:
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Under-stand: N
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CoHpile? [TM] o o o o & & & & ¥

Link 1oad Hodule reusable® (YoMl T

[ if meeded by features)
[Test and Abend<OuHp only]

Options

E - Edit JCL

Displaysthe compile/analyze JCL to review or changethe JCL,
if necessary. When the E option is selected, the JCL to be edited
is generated from the JCL member specified in the Data Set
Name field, applying the rules outlined in the Automatic JCL
Modifications section. The generated JCL isthen displayed on
the Edit screen.

When editing is complete, type ISPF SUBMIT to submit the
edited JCL for execution. Optionally, the edited JCL can be
saved in apartitioned dataset by using the CREATE command.
Otherwise, any changes made at this time are not saved.

S - Submit JCL

Submitsthe JCL to compile/analyze the specified program. The
JCL submitted is generated from the JCL member specified in
the Data Set Name field, applying the rules outlined in the
Automatic JCL Modifications section.

D - Doc Options

Displaysonly if SmartDoc isinstalled. Type D to display the
File - SmartDoc Options pop-up that is used to request an
Extended SmartDoc analysis and to specify which reports (if
any) areto be generated.
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Data set name

Specifies the PDS member or sequential dataset containing the
JCL to compile and link the program. If the JCL residesin a
source manager such as CA-Librarian or CA-Panvalet, use the
VIASUB edit macro to submit the compile/analyze job.

Understand

Displaysonly if Insight isinstalled. This type of analysis
provides the logic and program execution flow capabilities of
Insight. If Insight isthe only product installed, thisfield contains
aY value and cannot be changed. The defaultisY.

Test

Displaysonly if SmartTest isinstalled. Thistype of analysis
provides the testing and debugging information required by
SmartTest. If SmartTest isthe only product installed, thisfield
containsa 'Y value and cannot be changed. The defaultis Y.

Extended Analysis

Displaysonly if SmartTest isinstalled. Thistype of analysis
provides comprehensive program analyzing capabilities for
SmartTest FLOW and TRACE commands in addition to the
testing and debugging of SmartTest. The defaultisY.

Document

Displays only if SmartDoc isinstalled. Thistype of analysis
provides the report information generated by SmartDaoc. If
SmartDoc isthe only product installed, thisfield containsa Y
value and cannot be changed. The default is N, unless you are
accessing this feature from within SmartDoc.

Re-engineer

Displaysonly if Encoreisinstaled. Thistype of analysis
provides the logic and program execution flow capabilities of
Encore. If Encoreisthe only product installed, thisfield contains
aY value and cannot be changed. The default isN, unless you
are accessing this feature from within Encore.

Abend/Dump

Displays only if SmartQuest isinstalled. This type of analysis
lets you analyze the source used in diagnosing dumps. The
default valueis N.

AKR data set name

Specifies the AKR that will contain the information for the
analyzed program.

13
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AKR program name  Specifies an alias name used by the analyze process to save its
resultsin the AKR. If avalueisnot entered in thisfield, the
analyze job uses the program name from the PROGRAM-ID
statement inthe COBOL source asthe name under which to save
resultsin the AKR.

Note:

Thisfield isonly used for the AKR program name and does not
change the COBOL program name in the source.

Analyze options Specifies analyze options that are to be overridden. Default
options for the analyze job are established at installation time.
Analyze optionsthat can be entered in thisfield are described in
the user’ s guide for each ESW product.

Compile? Indicates whether the program is to be compiled. A program
need not be compiled if Insight, Encore, or SmartDoc are the
only features specified. Y ou can suppress the compile step by
typing N inthisfield. Thisfield isforced to avalue of Y if
SmartTest and/or Extended Analysis are selected.

Link load module Tests aprogram using SmartTest (non-CICS) that is

reusable dynamically loaded and will be tested with RUN
NOMONITOR. It is necessary to mark the load module as
reusable so that the Breakpoints are retained across calls. The
defaultisY.

Customizing Dump Captures (MVS Only)

14

By default, SmartQuest for MV S captures dumps for all jobs. Y ou can determine the
dumps that are captured by customizing the Include and Exclude tables and using special
DD cards. For example:

=  Usethe Maintenance - Included Job Names screen to only capture dumps for jobs
listed on this screen.

«  Usethe Maintenance - Excluded Abend Codes screen to exclude abends with codes
that you list there. To avoid unnecessary dump file reorganization, we strongly
recommend that you exclude common abends that do not require a dump.

= AddthisDD card to your JCL to exclude an individua job:

//NONINQST DD DUMMY
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Add this DD card to your JCL to override a No setting (for example, subpool
storage or loaded program storage) for an individua job:

//FULINQST DD DUMMY

Add thisDD card to your JCL to override aVSAM setting output destination for an
individual job and enable you to print the dump:

//PRTINQST DD DUMMY

Accessing the Dump Viewer Using the TSO Interface

After you access SmartQuest, use the View pull-down to set the default viewer files or
access the dump viewer.

To specify your SmartQuest datasets

1

3

From the SmartQuest primary screen, select View » Settings and press Enter. The
ASG-SmartQuest - Default Viewer Files screen, shown in Figure 11, displays.

Type the names of your datasets, replacing ASG and VIACENXX with your
high-level and mid-level qualifiers. Check with your installation administrator if you
do not have these dataset names. The names are saved in your | SPF profilefile.

Figure1le« Default Viewer Files Screen

AEG-ERartiuest - Default Viewer Files
CoHHand ===

Load Library o o 0 0w AZG.UIACENXY .LOADLIE

Uiewer Help o & & o o o & AZG.UIACENSY . SOUTEMHP
CICE Abend Codes . . . . ASG.UIACENME.EQCICAHP
HUE Abend Codes o o & . & AZG.UIACENRY . Z0HAEHLP
HUE Hzgs and Codes . . . ASG.UIACENMY.EQHHCHLP
Uzer Profile File « « « « ASG.VIACENMH.SQUPROF
Configuration File o . « ASG.UIACENHS.EQCONFIG
[CICE Omly] DFHCHACD . . GICE?FF¥.0DFHCHACD

Hake changes to file naWes or PF3 [EWD) to exit.

Press Enter to save your changes, then PF3 to exit.

15



ASG-SmartQuest User’s Guide

To access the SmartQuest dump viewer

1  Select Understand » Abend/Dump or type SQV on the command lineand press Enter.
The SmartQuest primary screen, shown in Figure 12, displays.

Figure12« SmartQuest Primary Screen
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Copyright Allen Eystens Group, IncC., an unpublished vork.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wWW.asq.coH

2  Sdect View » Dump/Abend and press Enter. The ASG-SmartQuest Dump Viewer
screen, shown in Figure 13, displays.

Figure 13+ ASG-SmartQuest Dump Viewer Screen
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Using the Dump Viewer Navigation Aids

Action Bar

The action bar in SmartQuest enables you to access any portion of the dump or
product-related information without needing to remember commands or to navigate
through many screens. The action bar options are described in detail in "Using the Dump
Viewer" on page 21.

Labeling Screens

Every SmartQuest screen, with the exception of the pull-downs and the last 3270 display
(CICS only), can be assigned alabel and redisplayed at any time during a session using
that l1abel. See "The Labels Action Bar Option" on page 60 for more information.

Assigning Labels

To assign or reassign labels, follow this step:

» TypeSET label or S label, where label isaname from 1 to 30 charactersin
length. The first character must be an alphabetic character (A through Z), but the
remaining can be any keyboard characters, including imbedded blanks.

These are examples of valid and invalid labels:

L abel Status
MY AREA valid
MYAREA 2 valid

AN AREA OF INTERESTING STORAGE valid

A(STOR1) Vvalid

ACB#3 valid

&MYLAB Not valid (does not begin with an
alphabetic character)

Note:

Y ou can reassign any label to a new screen by reissuing the SET command.

17
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Displaying a Labeled Screen
To redisplay alabeled screen, follow this step:

» TypeLOCATE label or L label.

Using the Labels Action Bar Option

If you have created several labels, it can be difficult to remember all the names that you
assigned. The Labels action bar option displays your assigned labels.

To locate a labeled screen

1  Position the cursor on the word Labelsin the action bar line and press Enter or type
LABELS to display the Labels pull-down screen shown in Figure 14.

Note:
If you have not assigned any labels, a message to that effect displays.

Figure 14 « LabelsPull-down Screen

AZG-ZHartOuest 7.0.4 T80
File Filter List Details Labels Haps Toggles  Help

CoMHand === t Labkels t
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BEOSERdE apaoaaan CEEEINIT
HAFCCE4D aoaoaaae DFZECaD0
BAASEGE2 adadaaad DFIPCCIA
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-- PF3=End 7v-8=%cProll  —--—-——- —k

—-— CLEAR=E®it 1=Help 3=End 7-&=icroll
Pozition cursor at required label and press Lenteri

2  Tabtothedesired label and press Enter to display the screen that has the selected
label assigned toit. Usethe Up and Down PF keysto scroll through the list of labels.

Stacking Views

The view stacking mechanism of SmartQuest is an extremely useful feature. Each time
you view a new screen using the action bar, by ZOOMing, or using an equivalent
command, the previous screen is pushed onto astack. A stack has 10 levels and holds
your last 10 screens. The product does not save the entire screen in the stack, only
sufficient information to rebuild it exactly. PF3 or the END command returns you to a
previous screen in the stack.
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View stacking is useful in these situations:

Using the ZOOM feature to follow astorage chain. If you make a mistake, or if you
want to chain back and take a different route, you can press PF3 to return along the
chain to the point where the mistake was made or to where the new route begins.
Thisis significantly easier than finding your start position again.

Examining a particular area. Y ou may want to view other information, such asthe
register contents. Y ou can display the registers using the Details action bar option,
obtain the information required, and return to your original screen by pressing PF3.

Examining the contents of several addresses displayed in an area of core. ZOOM to
the first occurrence and press PR3 to return to the original storage area screen. Now
ZOOM to the second and return with PF3. Continue doing this until you have
examined al the required addresses.

Managing Multiple Views

SmartQuest enables you to preserve a stack of displays. If you have followed a storage
chain, you can use the view stack mechanism to return to the anchor point. SmartQuest
lets you open a maximum of four view stacks at any onetime. The view stack you are
currently using is clearly shown on the screen. The fourth line always says VIEW n,
where n isanumber from 1 to 4. By default you are awaysin VIEW 1.

To open anew view stack, follow this step:

» TypeVIEW n, wheren isanumber between 1 and 4. Y ou can also use this command

to switch between open views.

To switch between view stacks, follow this step:

>

Type SWAP to switch to the next open view. Each time you type SWAP, the next open
view displays. For example, if you had four view stacks open, you would move from
view 1 to view 2, from view 2 to view 3, from view 3 to view 4, and from view 4 to
view 1.

To close aview stack, follow this step:

» TypeCLOSE n. Closing aview stack does not delete its contents. It merely stops it

from being shown when the SWAP command is used. If you reopen a closed view its
entire stack is still available for use.
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ZOOMing

20

To save aview stack, follow this step:

» TypeLABEL. See"Labeling Screens' on page 17 for more information.

Note:

Y ou can also use labeling to move ascreen from one view stack to another by labeling the
screen in one view stack and locating the label in another view stack.

The point-and-shoot technique, referred to as ZOOMing, enables you to access additional
screens from the screen you are viewing. Any field shown in light blue on aterminal
capable of handling full extended 3270 data streams, or any highlighted field on a
monochrome display that can be TABbed to, isavalid field for ZOOMing.

In almost al cases, these fields contain an address or a potential address. The only
exception isthe CICS/ESA Trace display, where an abbreviated trace entry can be used
for ZOOMing to the expanded trace entry.
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The dump viewer is the same when using the CICS interface or the TSO interface.

To access the dump viewer, follow this step:

» Select View » Dump/Abend or type SQV on the ASG-SmartQuest primary screen. The
initial ASG-SmartQuest logo screen, shown in Figure 15, displays.

Figure 15+« SmartQuest Initial Screen

AEGE-EHartQuest 7.0.8 TI0
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Wizit the AEG Support Web fite at www.asg.cod

copytight Allen Systeds Group, INC., an unpublished work.
A proprietary praoduct of AEG, Inc. Use restricted to authorized licensees.

—-— CLEAR=EHitT
UView stack enptv. Enter coWnand or use action bar

Note:

Y ou can disable the tab function for the action bar using the ABAR command. Once
disabled, use your cursor to click on an action bar option or the command keyword
equivalent. See Appendix B, "Command Summary," on page 113 for alist of these

commands.

These are the action bar options:

File Usethisoption to add or select current source file dsnames used by
SmartQuest, or to display alist of the available dump index files.
See"TheFile Action Bar Option™" on page 23 for more information.

Filter Use this option to filter the number of dumps displayed on the
Dump Selection List pull-down screen. See "The Filter Action Bar

Option" on page 24 for more information.
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List

Lists the dumps matching the criteria entered in the Dump Filter
Criteria pull-down screen. Y ou can select, print, hold, or delete
dumps from this screen. See"The List Action Bar Option" on
page 26 for moreinformation. The List optionisenabled only if you
have previously specified default criteriaor if there are dumps that
match the default filter criteria.

Details

Enables you to choose the areas or details that you want to analyze
within the dump. See "The Details Action Bar Option" on page 28
for more information.

Labels

Enables you to assign labels to the dump screens and use those
labelsto redisplay ascreen at any time while the dump is open. See
"The Labels Action Bar Option" on page 60 for more information.

Maps

Displays the DSECTs and other storage arealayouts for the dump.
See "The Maps Action Bar Option" on page 63 for more
information.

Toggles

Providesaset of simple switchesfor SmartQuest features. See"The
Toggles Action Bar Option" on page 63 for more information.

Help

Provides high-level reference information for the experienced user.
See "The Help Action Bar Option" on page 65 more information.

Note:

There is no split screen when using the TSO interface. However, you can issue | SPF
commands defined in your |SPF commands table (for example SDSF), aswell as any
command normally prefixed by TSO (for example, TSO LISTCAT).




The File Action Bar Option
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Usethe File option to add or select current source file dataset names used by SmartQuest,
or to display alist of the available dump index files (see Figure 16). Selecting a dump

index file specifies the dump index file to be processed.

Figure16+ File Selection Menu

AZE-EHartQUest 7.0.0 TI0
File Filter List Details Labels Haps Toggles Help
Hm—— File Zelection Henu --——- —k

Felect dunp inded file
Zelect pride source file
select alternate source file

#-- PF3=End
etttk Hebbtk bbbk Aotk
Aottt Aebebebt bbbk Aottt
Aotk Aotk bttt ekl
Hetetek Hetetek Hetstebtck Hetsielk
Aetststek
Aotttk

Uisit the ASG Support Web Zite at www.asq.Cod

copwright ALlen $ystens Group, IncC., an unpublished vork.
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--= CLEAR=EXit
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To select a dump index file

1  Seect File» Select dump index file, or type FILE, and press Enter. The Dump

Index List pop-up, shown in Figure 17, displays.

Figure17« Dump Index List Pop-up
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--- CLEAR=EHit
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2  Tabto the name of the dump index file you want to use and press Enter.
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To specify the primary sourcefile

1  Sdect File» Select prime sourcefile or type FILE and press Enter. The Source File
List pop-up, shown in Figure 18, displays.

Figure 18+ SourceFileList Pop-up

AZE-ZHAFTOUesT 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help
Hmmmmmm Source File List ——--—-—- —

EEFETADL 30 HUS - CICE SOURCE

etttk Aokt

etttk Aottt
Hetetettek debelelk b oo
Aotttk Aebebclk Aotk

up, InC., an unpublished work.
Use pestricted to authoriZed licensees.
b Zite at wwd.asg.coH

== PF3=End 7<&=%cCroll ====--- ok
--- CLEAR=EHit
Fozition cursor at regquired choice and press <enter>

2  Tabtothe name of your primary source file and press Enter.

To specify the alternate sourcefile

1  Sdect File» Select alternate source file or type F I LE and press Enter. The Source
File List pop-up, shown in Figure 18, displays.

2  Tabto the name of your secondary source file and press Enter.

The Filter Action Bar Option

Depending on the number of dumps that occur and the length of time you retain these
dumps on file, the number of dumps currently on the dump index can become quite large.
The Filter option enables you to restrict the number of dumps displayed on the Selected
Dump List pull-down screen.

Y ou can chose to view CICS dumps, Batch dumps, or both. Thefilter criterialets you
filter dumps using these options:

- Date

<  Abend code

=  Jobname (#)

=  Transaction (*)
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e Termind (*)
< CICSapplid (*)

Filter criteriafields marked with an asterisk (*) are applicable only to CICS abends, and
those marked with a pound sign (#) are applicable only to Batch abends.

To filter the number of dumps displayed

1  Select Filter on the action bar or type FILTER and press Enter. The Dump Filter
Criteria pull-down screen, shown in Figure 19, displays.

Figure 19« Dump Filter Criteria Pull-down Screen

AEG-EHartiuest 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help
CoHHa #-—— OuUMp Filter Criteria ———
IEM
[Blatch-[ClICE. g
Fron [wywynndd] 2eez 19 14
To  [yywunndd] 2082 19 1d | #eek seketokck
etk shetetedok
Abend code.....
Job nadel(#t].... etdelobk debobeisk etk
Hetstobobsk dhebetedok ook
Transaction(+].
TerHinall*]....
Cics applidi#®]. » INC., an unpublished work.
A pr Use restricted to authorized 1licensees.
-- PF3=End --———-————--——- =k Zite at wWW.asq.CoH
——— CLERR=EHi T
[#]=CICE abends only. [#]=Batch abends only

2 Typeyour filtering criteria. Y ou can request dumps within a specific date range, for
aparticular transaction ID, with a particular abend code, or that occurred in a
particular CICSregion or at a particular terminal. The From and To date fields are
required but all others are optional. If you do not specify a dump type (Batch or
CICS), you receive both.

a By default, the From date and To date contain the current date, which builds a
list that includes only today’ s dumps. Change the From date to 1900 01 01, for
example, for afull list of all the dumps on your file.

b Youcan modify your current dump viewing list at any time by reselecting the
Filter action bar option and changing the filter criteriato rebuild the list.

Y ou can use the trailing asterisk (*) and the question mark (?) as wildcard
characters when specifying your search criteria. These can beused in al fields
except the Dump Type (CICS or Batch) field and the Date field. For example,
in the Abend Code field, you can specify S* to indicate all Batch system
abends, or S?37 to indicate any SB37, SD37, SE37, and so forth.
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3 PressEnter to display the Selected Dump List pull-down screen. This screen also

displays anytime you select the List action bar option.

The List Action Bar Option

26

The List option displays alist of the dumps on your system for which you can perform
various functions. The Filter option enables you to filter the number of dumps displayed
in the Selected Dump List pull-down screen. If you do not enter any filter criteriabefore
choosing the List option, only the dumps with the current date are displayed.

Usethe List option to delete, hold, print, or select different dumps at any time. To rebuild

the list with different filter criteria, select the Filter action bar option.

To analyze and manage system dumps

1  Position the cursor on the word List in the action bar line or type LIST and press
Enter. The Selected Dump List pull-down screen shown in Figure 20 displays.

Note:

If you do not specify filter criteriaand if there are no dumps that match the default
criteria, you receive the message No matching dumps for current
filter criteria. UsetheFilter option to specify filter criteriaand try the List

option again.

Figure20 ¢ Selected Dump List Pull-down Screen

UIEW

A pr

AZGE-EHartQuest F.0.0 TI0

File Filter List Details Labels Haps Toggles Help

CorAa &

——— CLERR=EHi T
Key “g"elect, "D"elete, “H'old, “R"elease or "P'rint.

Date TiHe
2082-18-1d asiaz;
2002-18-1d aSI02;7
2002-180-1d a4 1597
2002-18-1d 047567
2a02-18-1d a4 I553
2o02-10-1d ad231:
2002-10-1d ad23ag
2002-10-1d4 a4 2260
2002-18-1d ad 257
2002-18-1d adi227
2002-180-1d adi21:
2002-180-1d 047153
2a02-18-1d ad4i17;
2a02-10-1d adi17:
2o02-10-1d 4117

PFI=End 7-&=fcroll

Zelected DuWp List
Job<Appl Tran Abnd Terd Prograd  Cot Notes

UIATEETU ZACT HUCOELR
UIATEZTU ZACT HUCOELR
UIATESTT 1a0d1 Unknown
UIATEST = 1edi DFZEIPER
UIATEST = ZECF HUDLIC
UIATEZTQ ZOCF HUEHPC
UIATEETQ 1e0d1 Unknown
UIATESTR 2AC? HUDE2CE
UIATEETH Z0CE HUDE2CE
UIATEZTH daai TE4EIT
UIATESTL ZACY CPROGA
UIATESTE 403G HUPLIF
UIATESTT dEa3E HPLIE
UIATEZTH das7 CEEBINIT
UIATEETG ZOCE HUPLZA




2 Using SmartQuest

Type an action selection to the left of the listed dump. The message linetells you
which selection options you can enter for each dump on the list.

Deletes the dump. At installation time, if the delete confirmation
customization variable is set to Y ES, the word Pending appearsin the
Notes column to the right of the dump that you want to delete. TypeD in
the selection field again to confirm your intention to delete this dump. If
delete confirmation is set to NO, the first D entered executes the dump
delete process. Y ou can delete as many dumps as you like by keying
multiple Ds before pressing Enter. When dumps have been deleted
successfully, the word Deleted appears in the Notes column.

Holds the dump. SmartQuest is supplied with an optional automatic
dump delete facility. This helps maintain the file by deleting dumps that
are older than a user-specified number of days. If thisfeatureisactivein
your installation, you can use this hold selection to exclude individual
dumps from the auto-del ete process. Y ou can type multiple Hs before
pressing Enter. The word Held appears in the Notes column. Use the
Release option to delete these dumps when you no longer require them.

Submits a Batch job to print one or more dumps. See "Online Print Job
Submission" on page 52 for more information about using this option.

Releases a held dump.

Selectsadump for analysis. Y ou can select asingle dump for viewing at
any onetime. Multiple S options are ignored. When you have selected a
dump and pressed Enter, the Details pull-down screen displays. Y ou can
a so display this screen by positioning the cursor on the Detail s action bar
option and pressing Enter.

Note:

If you do not enter a selection character, an Sis assumed for the dump your cursor
is on when you press Enter.

Y ou can choose to suppress the capture of duplicate dumps. Thisfeature is optional
and is controlled by a customization variable that is set during installation. Where
duplicate dumps have been detected and suppressed, a number appearsin the Cnt
(Count) column to indicate how many times an individual dump has occurred.
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The Details Action Bar Option

28

The Details action bar option allows you to choose the areas or details of the selected
dump that you want to analyze. Choosing the Details option or typing DETAILS displays
the Dump Details Menu screen shown in Figure 21. The screen is also displayed
automatically when you select a dump from the Selected Dump List pull-down screen.

Figure 21« Dump Details Menu Pull-down for a CICS Dump

AEG-EHartQuest V.0.80 T20

File Filter List Details Labels Haps Toggles Help
COHHA # #——— —————— e DuHp Details Aenu t
LUIEW Date EbEI’Id SUHHArY cnt HNotes

PEW and registers

2002-18 [ Prograd calling chain sudnary
2e82-18 [ Prograd calling chain detail
2a0z2-18 | Language environdent trace
2eez-18 | Acquired storage + control blocks
208z2-18 IEH help infornation

2002-18 [ File IO sunnary

2a8z-18 | IR diagnostic infornation
2E0z-18 | DE2 diagnostic information

2002-18 %--  PF3I=End

2002-10-14 a4 122235 UTATESTH daei TE4EIT

2002-1a-1d adi2i a7 UIATESTL ZACH CPROGA

2002-180-1d 04115213 UIATESTK 4azs HUPLIF

2002-18-1d 411758 UIATESTT 4a3s HUPLIE

2002-18-1d4 04717231 VIATESTH 437 CEEBINIT
A pr 2e02-10-1d adi1i7i16 UIATESTG ZECE HPLZA

PF3=End Tv-&=2Croll

--— CLEAR=EHMit
Position cursor at detail required and press <enterk

Select an analyze option by positioning your cursor on an option on the Dump Details
Menu pull-down and pressing Enter. This pull-down is dightly different depending on
whether you selected an MV S or a CICS dump. These are the possible choices on the

pull-down:

Abend summary Abend summary

PSW and registers PSW and registers

Program chain calling summary Program chain calling summary
Program chain calling detail Program chain calling detail
Language environment trace Trace table entries

Acquired storage and control block Acquired storage and CICS control blocks

IBM help information Last 3270 display

File 10 summary IBM help information (from DFHCMACD)
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IMS diagnostic information IMS diagnostic information

DB2 diagnostic information DB2 diagnostic information

Not all of the options on this pull-down may be selectable. For example, IMS diagnostic
information is not available if the abending task does not use DL/1. Available options are
highlighted (shown in white), and non-available options are normal intensity (shown in
blue).

Abend Summary

The Abend summary option enables you to quickly resolve simple dumps such as abends
due to non-handled CICS conditions. A sample of the abend information included on the
Abend Summary screen for a CICS transaction task is shown in Figure 22.

Y ou can access this screen from the Dump Details Menu pull-down screen or by typing
SUMMARY.

Figure22« CICS Abend Summary Screen

AEG-FHartuest 7.0.80 TE0
File Filter List Details Labels Haps Toggles Help
CoHHand ===

VIEN 1----- AEend SuRHary
TranzactioNesseas IOLE Date-TiHGuauanuns 2002-18-16 ~ adi23idf
Task NUALEF . ..., 265 Dataloc-Datakey.. Ane  ~ User
TerHIiNAlesasunnns Laa? CICE applid-rel. WVIACDAZ -~ B20
Abend Codessunnns ARCT User idisssnsnnns CICEUZER
Progran-rap not defined to CIGS, disabled o load failed
Abend PEM..eaaaas BEERCCTA L3 L e | i1
Abend occurted at offset @OE16A  in prograd TEZTPROG
At offset a08id2  in CEECT TEETPROG

Failing instruction: O5EF EALR 14,15

Last CICE call Rade was EXEC CICE LINK
REsOUrCe . e vannns TEETPROG EibFrespeacsannnns HORHAL
Eibrespleseianuns HESaaaaE

--— CLEAR=E®it 1=Help 3=End

The top portion of the Abend Summary screen provides general information about the
abending transaction task or job, including a brief description of the abend code.

Note:

These descriptions are located in the VSAM KSDS CODES file generated at product
installation. See your system programmer for assistance with adding your own user abend
code descriptionsto thisfile.
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The main portion of the screen is adetailed analysis of the point of abend, including the
abend address, the offset in program, the offset in CSECT and, in the case of PL/I, the
offset in PROCEDURE or BEGIN block. Thefailing instruction is a so disassembled and
its operands broken down into address and contents. Operands that are in fetch or
write-protected storage or that contain invalid packed-decimal data (when the instruction
is a packed decimal instruction) are clearly marked. For COBOL programs, the BL/BLL
cell number and offset in BL/BLL cell are a'so shown when operands are |ocated within
the BL/BLL cells.

If you are working in a CICS environment, the bottom 3 lines of the screen are an extract
from the EIB. It shows the last CICS CALL made, the response received and, for
CICS/ESA where EIBRESP2 is not zero, a brief description of the EIBRESP2 field is
given. For example:

Last CICE call Wade was EXEC CICE RECEIVE MAP
REsoUrCe s sannnnns HAPA EiblresPusnnnnnnns HORHAL
Eiblresplasasnnnns EEOaaaaa

Last CICE call made was EWEC CICE ZEND
RESOUrCE s snnnnnn 003 Eibrespassnnnnnns HORHAL
Eibraspd.iaiiaas DORE000E0

The PSW address and any operand addresses are shown highlighted or in light blue.
These addresses are links. Y ou can place your cursor on any address and press Enter to
ZOOM to additional information.

=  ZOOMing on the PSW address takes you to the point of the abend and shows the
source, if sourceinformation isavailablefor thefailing program. If a Source display
is hot available, SmartQuest provides a Disassembly display. For moreinformation
about these displays, see "The Source Display" on page 73 and "The Disassembly
Display" on page 82.

- If the operand iswithin program storage, ZOOMing on the operand addresses
displays the source or disassembly. If it iswithin a control block, Assembler
DFHEISTG, PL/I DSA, COBOL Working Storage, COMMAREA, or any piece of
GETMAINed storage, the display is shown mapped with field names when possible
or as standard dump format (i.e., hexadecimal on the left, character on the right).
Areas overlaid with field names are referred to as Mapped displays. See "The
Mapped Display" on page 85 for more information about Mapped displays.

=  Theabend code may aso be available for ZOOM use. Thisistruefor all system
abend codes that have an entry on the supplied IBM Help File
(DDNAME=MVCODE1). Thisallowsyou to position the cursor on the abend code
and press Enter for afull description of the code from the IBM system codes
manual. Some IBM code descriptions refer you to an IEC message. If thisistrue,
the associated | EC message appears on the summary display and can also be used
for ZOOMing to afull description of the message.
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- If the LE Condition Msg field displays, place your cursor on the message number
and press Enter to display the LE Condition Description Message screen, shown in
Figure 23. Thisis a Batch feature only.

Figure23« LE Condition Description M essage Screen

AEG-FHartQuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===} g
UIEW 1———— LE Condition Description Hessage
CEEZ258C The systed oF User abend Ul8dl R=MHULL Was issued.

=== CLERR=EXit 1=Help 3I=End 7v-5=icroll

PSW and Registers

The PSW and Registers option displays the PSW and Registers screen, which provides
the PSW and all the register contents, including the floating point registers, at the time of
abend. This screen also includes a brief description of the area of each register address,
along with the offset into that area. If no such description appears, this indicates that the
address in that register is not within the captured storage areas for this dump.
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Y ou can access this screen from the Dump Details Menu pull-down screen or by typing
REGS. The PSW and Registers screen, shown in Figure 24, displays.

Figure24 « PSW and Registers Screen

File Filter List Details Labels Haps Toggles Help
ConHand ===

PEM and Registers
PIVI GOODDEEAN00ATEEE offset @OO2DE within the progran HUCOEVA

RO I AAOOOEEADODELANE

Rl : GO0ODEEASDOETEED offset @OO350 within the progran HUCOELA

RZ I GO0D008A00D00ELE

RT I Q0000080050304

R4 I AOOODOEAQODATEOC offzet AOO2DC within the progran HUGCOBLA

RE I GODODOEASODOTEHY offzet AOO364 Within the progran HUCOELA

RE I GODODEAOD0TI00 offzet AOD0DO within the working stge for pgn HUCOBUR
RT © GOO000EE0008TSOF offset @OO207 within the TGT fof progran HOGOBUA

RS : AAOODEEADDOATSED offset AAO2O5 within the TGT for progran HUCOBUA

B3 GOOODOEADDORTEES offset @OO335 within the progran HUCOELA

RiOZ QOOODEEADDOETIZ0 offset GOOODE yithin the prograd HUCOELA

RiiZ GOO0DEEADD0ETIZ0 offzet AOOODE yithin the prograd HUCOELA

RiZZ AOOOOOEADDDATEFD offzet AOO2CH within the progran HUGCOELA

R13: GODO00EA0DDOTI0S offzet AOOO08 yithin the TGT for progran HUCOBUR

Rid: GOOO00EADDDOTEOZ offzet AOO202 Within the progran HUCOELA

Ri5: AEOODEEASODETEER of fset AOOITA within the progran HUCOELA

AZG-EHartQuest Y.o.8 TE0

2
--= CLERR=EXit 1=Help 3=End

i [+

The format of the Rnn commands is Rnn or Rnn+xxx, where nn is the register number
that you require and xxx is an optional hexadecimal offset from 000 to FFF. Y ou can
also use the PSW command to display the failing source line or point of error
disassembled when source is not available.

Y ou can ZOOM to the PSW address and each of the general register addresses by
positioning the cursor on the address and pressing Enter. Depending on the type of
address, one of these displays appears:

Core

Provides astandard dump format with hexadecimal data on the left and
character data on the right.

Disassembly

Displays when source support is unavailable for a program. Highlights
thefailing or linking instruction, provides the position of each CSECT,
and includes information for diagnosing problems caused by a source
and object misalignment (if sourceis available).

Map

Attemptsto automatically overlay the storage areawith itsfield names
when an area of non-program storage is selected. For each field, the
display givesthe field name, length, data-type, address, offset within
the area and contents at the time of the abend.
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Source Provides access to the source code. When source support information
isavailable, the Source display is shown in preference to any other

display type.

Trace (CICS)  Provides the trace table for examination if you have trace on in the
region where the abend occurred.

Note:
The type of display shown when you choose an address depends on whether source
support is available, and what type of areais selected (for example, program storage or
GETMAINed user storage).

Program Calling Chain Summary

The Program Calling Chain Summary screen displays an overview of the calling chain. It
includes the abend/link address; the address of the working storage (COBOL), DSA
(PL/1) or the DFHEISTG (CICS); and the address of any COMMAREA passed to it. All
of these are available to use for ZOOMing by positioning the cursor and pressing Enter.
Y ou can also ZOOM on the program name, which takes you to the Program Calling
Chain Detail display for the selected entry.

Y ou can access this screen from the Dump Details Menu pull-down screen or by typing
SPROGS. The Program calling chain summary screen is shown in Figure 25.

Figure25+ Program Calling Chain Summary Screen

AZG-EHartiuest 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help
Connand ===k _
VIEM 1-—--- ACtive prograd calling chain sunHary
Abnd<Lnk WEE-DER  Progran  CEECT FL<1 Procedure nare

» DOREBETY OO0O0000 DFIEIFED DFSEIFED N-A
DE0EdIA0 apapaonn IGZCFCC  IGZCFCC  N-A
aceDsies aCBE9OES HUDLIE  HUDLIE  MH-A
OABEIZE0 adadaoaD HUDLIE  HUDLIE  H-A
OAOSEPEE QDA0A0AD DFIFLETA DFEFLETE N-A
ORASEP4E a0a0aoan CEEEINIT CEEBIMIT H-A
DEFCCE4D agaann DFIECO00 DFEECEDD N-A
HEBSEEZZ GOODA000 DFIPCCI0 DFEPCCIE N-A
DENATFeE GOaDaoan DFIRRCOO DFERRCOE N-A

--— CLEAR=E®it 1=Help 3F=End 7-r&=Ecroll
Abending progrean entry Harked it

The most recent entries are listed first. The abending program entry is clearly marked
with agreater than sign (>). Entries after the abending program entry are programs that
are at higher levelsin the calling chain.
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The Program calling chain summary screen displays entries for the programs invoked
through a CICS LINK, COBOL programs invoked through a CALL, and PL/I procedures
invoked internally or dynamically. An entry appearsin this chain for these programs:

e  All programsthat are CALLed through an EXEC CICS LINK
< All statically linked and CALLed COBOL programs

<  All dynamically CALLed COBOL programs

< Allinterna PL/I procedures

< All statically linked and CALLed PL/I procedures

<  All dynamically fetched and CALLed PL/I procedures

Y ou can scroll this screen using the Up and Down PF keys. Thefirst entry isthe abending
program and each subsequent entry represents the next higher level program in the chain.

The Program Calling Chain Detail

34

Y ou can access the Program calling chain detail screen from the Dump Details Menu
pull-down screen or by typing PROGRAM (or PROGS). The Program Calling Chain Detail
screen is shown in Figure 26.

Figure 26« Program Calling Chain Detail Screen

AEG-3HartQuest 7.0.8 TI0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
UIEM 1--——- Active progran calling chain detail

Entry 81 of 89
Abending instruction iz at address QO0EEEVY
offzet @0131C  in progradn DFSEIPER

offzet @O131C  in CIECT DFZEIPER

Load library..... IHZ7i0.2DFZREEL

Load pointeseaass OOOERGSS [ L [uT [ 31

ENtry poiftesas.s OOREAESE LAmGUaGE. s asannnn Azzenbl et
Prograd length. .. ©09019A5 Link-edit date... 10 Jan 2081
REAscecannnnnnns LI LTy 1 T R Lengthe e canunaas BEDaDaaa

No source file information for this prograd
--— CLEAR=EXit 1=Help 3=End 7-&=%croll
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The Program calling chain detail screen identifies these items:

=  Theoffsetin program and in CSECT. If you are using PL/I, the offset is shown in
the PROCEDURE or BEGIN block of the failing or linking statement.

- Information about the load module itself. Thisincludes the load library name, the
load point and entry point addresses, program length, AMODE, language, link-edit
date and, in the case of CICS/ESA, the EXECKEY and DATALOC definitions for
this program.

=  The storage associated with this module. Thisincludes the DFHEISTG for
Assembler programs, Working Storage and TGT for COBOL programs; DSA and
Static storage for PL/I; and any COMMAREA used. For each of these the address
and length are given.

=  Whether source-level support isavailable for this program. The dataset name of the
SmartQuest source file containing this information is shown, and the date this
information was added to thefile.

«  Thedataset name of the analyze source file. If sourceinformation isnot available, a
message to that effect displays.

The abending and linking addresses, the entry point address, and the addresses of the
associated storage areas are all shown highlighted or in light blue. Y ou can tab to these
addresses and ZOOM to any location by positioning the cursor on the address and
pressing Enter. The screen shown depends on the type of area and whether source-level
support is available.

Each entry in the calling chain has its own screen. The top right corner shows the total
entriesin the calling chain and which entry you are currently viewing. The abending
program is always shown first, regardless of its position in the chain. From the abending
program entry, you can use the UP and DOWN commands to scroll through all the
entries.
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When you select the Details » Program calling chain detail, Entry 1 displays, which isthe
abending program. Use the scroll keysto view the other entries. A sample of an entry
higher in the calling chain (Entry 2 of 9) isshown in Figure 27.

Figure 27« Program Calling Chain Detail - Entry 2 of 9

AEG-FHartquest v.0.0 TE0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
VIEW 1-—-—- AcCtive prograd calling chain detail

Entry 82 of 09
LINE or CALL was issued at address 00a643IA0
offset  0O0O27E  in prograd IG2CFCC

Offset  @OAZPE in CIECT IGZCFCE

Load libraryseass CEE.SCEERLN

Load pointeseeass Hoasdl 30 |21 (o [ 3

ENtFy pointe..aue. O0aEd1 30 LamgUage . ceeeauns Azsenbler
Progr-ad length... DEQEEAESD Link-adit date... 1& Feb 2008
RS s smnnmnnnnnnn (LT 113111 SR Lengthae e ansnnnnns AEEREEEE

Mo =source file infornation for this prograd
=== CLERAR=EHit 1=Help 3I=End ?~3=ZCroll

BL/BLL Cells

For COBOL programs you also see a BL/BLL summary selection field. Thisis designed
to assist COBOL programmers who do not have source support available for the
abending or calling programs. By positioning the cursor on the word Summary in the
BL/BLL Cellsfield on the Program calling chain detail screen, you can display afull list
of COBOL BL cellsand BLL cells as shown in Figure 28.

Figure28+« Sample BL/BLL Cell Summary Display Screen

AZG-EHartiuest 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help
Connand ===k _
VIEW 1-———- EL-ELL Cell Sunnary Oisplay
Id. Address Length

ELM= 0ol Goaa7I0e DoDaoaes
ELL= @03 S000GFFE D0@Ealogd [Default length of dk assuned)

=== CLERAR=E®it 1=Help 3=End F7«&=ZCroll
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For each BL/BLL cell, the address and the length displays. In COBOL 2 and COBOL for
MVSand VM, the BL cells start with the number 0 and the BLL cells start with

number 1. Position the cursor on any address to display from the start of that BL/BLL
cell. The offset shown probably does not start at zero since for many Batch programs the
working storage is within program storage. SmartQuest shows the offset within the
program storage for each BL/BLL cell. Y ou can use the +xxx command to view afield at
aparticular offset inaBL/BLL cell.

For example, these are the steps you perform to view afield at offset X'12C' in BL cell 2:
1 ZOOM toBL cell 2.

2 Typetheoffset (for example, +12c) and press Enter to view thefield at X'12C' inthe
BL cell.

3  Returnto the Program calling chain detail display by pressing the PF3 key.

Object/Source Mismatch

One of the most common problems with source-level support isthe sourceinformation on
the SmartQuest file not being valid for the load module in use. This can result in a source
and object misalignment and can cause the product to display the wrong failing or linking
statement. To avoid this problem, the highlighted messageWarning: Possible
source object mismatch displaysif the creation date on the source file
information is different from the link-edit date.

Acquired Storage and Control Blocks

The Acquired storage & control blocks screen displays all the major MVS, CICS, DL/1,
and DB2 control blocks you might want to examine in adump. It also includes this
information:

<  All storage areas acquired directly by the task or by CICS on behalf of the task.

< All storage areas acquired by the job and any programsthat have been loaded by the
job but which do not appear in the calling chain.

Y ou can access this screen from the Dump Details Menu pull-down screen or by typing
STORAGE. Y ou can also use the abbreviated control block name as acommand to display
the individual control blocks. For example, type E 1B to display the Exec Interface Block
or TCB to display the Task Control Block.

Note:
If there is more than one of a particular control block (for example, TIE), only the first
displays in response to the short name command. To display others, use the ZOOM
feature on the Acquired storage & control blocks screen.
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Figure 29 shows the control blocks and storage areas for asmall sample CICS task.

Figure29+ Acquired Storage & CICS Control Blocks Screen

AEG-3RartQuest F.0.0 TE0
File Filter List Details Lakels Haps Toggles Help
CoHHand ===} _
UIEW 1---—- Acquired storage + CICE contral blocks
Id. Address  Resource Description Length Motes
CEECAAR  AO0EEACE LE Connon anchor area AOOTGE
CEECIE  ARATETCS LE Condition infarnation block LR
CEEHZIE  @087ESDY LE Hachine state inforMation blaock @080
CEEEDE  EO0EAR00 LE Enclave data block BEaaAd
CEEPCE  AEEASEE LE Process contral block HEaad S
TCE BaE02a0g Task control block Bl 55
RAECE SOFEDESE Address space control block aaaisa
RETE 01 BISSE0 Address space secondary table entry Q0a0do
AZRE BaSFOESR Address zpace extension block QROAFS
AZEE azdd2Cag Address space secondary block AREL 20
RE BREFOECD Request block BRDACT
wEE TFFFCIAG Extended status block Ll
OEE HOEAEAZE EYE000Ee Deuice edtent block HEDE 28
ACE BASAEAAd EYE0000% User requested area aagaadc
DEE OOSAEDSS EyEaaoed Device extent block Qa2
ACE DASAEERd 2VE000A3 User requested area aaaadc
--= CLERAR=EHit 1=Help 3I=End 7-3=Fcroll

Acquired Storage and Control Blocks Format

Each block or area contains ashort name, an address, alonger description, and the length.
The Notes column is normally blank.

Use the ZOOM feature to display any area by positioning the cursor on the address and
pressing Enter. Most control blocks are automatically displayed as mapped with field
names. Other control blocks and acquired storage are shown in standard dump format but
can be manually mapped with field namesif source-level support for the abending
program is available.

Captured Control Blocks (CICS)

The Acquired storage & control block screen also includes any loaded programs that are
in thetasks LLA list. The Notes column contains the message Bad SAA if acorrupted
storage accounting area is detected.

Control blocks that may be captured and their short names are listed below. Those areas
that should be automatically mapped with field names are marked with an asterisk (*).

* EIB Exec interface block

* TACB Task abend control block
* UTCA User task control area

* STCA System task control area
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TWA Transaction work area

* CSA Common system area

* CSA OPFL Optional features list

CWA Common work area

*TCTTE Terminal control table entry
TCTUA Terminal control table user area
* EIS Exec interface structure

* EIUS Exec interface user structure

* SYSEIB System exec interface block

* APE Active program entry

* PCT Program control table entry

* PPT Processing program table entry
TIE Task interface element

RIE Request interface element

* LIFO LIFO parmg/kernel stack entry
* DLP DL1 parameter area

* PST DL 1 partition specification table
* SCD DL1 system contents directory
* |SB DL1 interface scheduling block
* RSB DL 1 remote scheduling block

* UIB DL1 user interface block

* PCB DL 1 program communication blocks
* DIB DL1 interface block
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* PAPL DBCTL DRA architecture parm list
PAC DBCTL DRA control block

PATE DBCTL DRA thread entry
GLOBDBAT DBCTL DFHDBAT global area
RCT DBZ2 resource control table

RCTE DB2 resource control table entry
CCTE DB2 CICS connection control table
CcsuB DB2 CICS connection subtask area
DB2TCB DB2 subtask TCB

Captured Control Blocks (MVS Only)

Control blocks that may be captured and their short names are listed below. Those areas
that should be automatically mapped with field names are marked with an asterisk (*).

Short Name Control Block Description

* CEECAA LE Common Anchor Block

* CEECIB LE Condition Information Block
CEEMSIB LE Machine State Information Block
* CEEEDB LE Enclave Data Block

* CEEPCB LE Process Control Block

* TCB Task Control Block

* ASCB Address Space Control Block

* ASSB Address Space Secondary Control Block
* ASTE Address Space Secondary Table Entry
* ASXB Address Space Extension Block

QEL Queue Element
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Short Name Control Block Description

QCB Queue Control Block

* RB Request Block

* XSB Extended Status Block

* DEB Device Extent Block

* TIOT Task Input Output Table

* SSAT Sub-System Affinity Table

* STCB Secondary Task Control Block

* SCB STAE Control Block

* SCBX STAE Control Block Extension

* TCBEXT2 Task Control Block Extension

RTM2WA RTM2 Work Area

*LLE Load List Element

* CDE Contents Directory Entry

* XTLST Extent List

* DBPCB DL1 DB Program communication block

* FPPCB DL 1 Fast Path Program communication block
* |OPCB DL1 10 Program communication block

* ALTPCB DL1 Alternate Program communication block
* DIB DL 1 interface block
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File IO Summary Display (MVS Only)

The File IO Summary Display screen, shown in Figure 30, lists all open files (including
VSAM files) and the address and length of the last record read from or written to each
file.

Figure30 e« FilelO Summary Display Screen

AEG-FHartQuest 7.0.80 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
VIEW 1--—-- File I0 SUMHary Display
File Rec Adr Length

2Ye0ur HERECOES DOOOa07e

=== CLERR=EHit 1=Help 3I=End ?~&=iCroll

Y ou can view the last record for each file by ZOOMing on the Rec Adr field to the right
of each file name.

Last 3270 Screen (CICS Only)
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The Last 3270 display buffer screen for the dumping task is available only if the task
actually terminates after dumping. It is not available for dumps produced by an explicit
EXEC CICS DUMP. The displaying of the last 3270 screen is the only piece of
conversational code in the SmartQuest dump viewer. The remainder of the logic uses the
more resource-efficient pseudo-conversational method.

If the last 3270 option is available (highlighted on the Dump Detail Menu), selecting it
displays the screen with the cursor inserted at the position it held at the time of abend.
Press Enter to exit the Last 3270 screen and return to the previous SmartQuest dump
analysis screen.

Y ou can access this screen from the Dump Details Menu pull-down screen or by typing
SCRN or XSCRN. The XSCRN command displays the screen in normal dump format.
This enables you to examine the buffer control characters.



Figure 31 is an example of the Last 3270 screen.

Figure3le« Last 3270 Display Buffer

2 Using SmartQuest

AZG-EHARTOQUEET ZAHPLE REEND HENU

COEQOL ABEND AZRA [DATA EXCEPTION)

COEQOL ABEWD REIL [FILE WOT FOUND)

COBOL ABEWD RICA [INFINITE LOOF TIHE 0UT)
COBOL ABENWD REIR [LINE T NOMEMISTEMNT PROGRAH]

COEQOL EWEC DL<1 AEBEMD
COEQOL EWEC CICE DUHP

PL<1 HAEBEND RZRA [DIVIDE EXCEPTION]

PL-1 HAEEND REIL [FILE NOT FOUND])

PL-1 RABEND AICA [INFINITE LOOF TIHE QUT]

PL<1 RAEBEND REIR [LINE T MOMEXISTENT PROGRAH)

PL-1 E®EC DL<1 REEND
PL<1 EWEC CICZ DUHP

r r=aHITo Mmoo mID

= EXIT

=l

ALL OTHER ZELECTION: GEMERATE AM REIR

A

ENTER ZELECTION CODE

IBM Help Information

For CICS, the IBM Help Information screen displaysinformation relating to all CICS
abend codes. With CICS/ESA, IBM supplies afile with the DD nhame DFHCMACD,
which contains this information.

For MV S, the IBM help information screen provides information extracted from IBM
manuals that relates to abend code and IEC message descriptions. This help file contains
material that is the copyright of IBM, and is used with SmartQuest for MV S with
permission of IBM. The file as supplied must not be used for any other purpose.
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To accessthe IBM help, follow this step:

» Select Details» IBM help information or type 1BMHELP. A sample of the displayed
information is shown in Figure 32.

Figure 32+ Help Information for Abend Code Screen

AZE-SHartOuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
ConAand ===F _
VIEW 1------ Help infornation for abend code ASRA

EXPLAMATION: The task has terdinated abnornally because
of a pragrad check.

EYETER ACTIONZ The task i= abnornally terninated and CICE
izzues ejther Wessage DFHAPDOO1 or DFHIREODO1. Hessage
DFHEROE2ZZ Hay also be iszued.

UZER REZPONZE: Refer to the description of the associated
Hessage or Messages to deterdine and correct the cause of
the prograd chack.

HODULEZ DFHERP

=== CLERAR=EXit 1=Help 3I=End 7-<5=icroll

To view additional help information, use the IBMHEL P command with the required
abend code as a parameter. For example, type IBMHELP ASRA for information about
the abend code ASRA. Type IBMHELP 1EC1411 for adescription of the message
IEC141l.

When the information istoo large to fit on a single screen, the Up and Down PF keys are
enabled.



The Trace Display (CICS Only)

2 Using SmartQuest

If you have trace on in the region where the abend occurred, the trace table is available

for examination.

To access this information, follow this step:

» Select Details P Trace table entries or type TRACE. For CICS/ESA, the Trace table
display looks similar to the example shown in Figure 33.

Figure33+ Trace Table Screen

File Filter List Details Labels Haps

AEE-EHartQUest 7.0.8 TE0
Toggles Help

Connand ===k _
UIEW 1--—-- Trace table
Task Trace point  Description

HE26S QR PG 0E0Z PGLD  EXIT
HE26S QR AP 2008 PCPG ENTRY  AEEND

BA2ES QR =M 08I0l EHGF  ENTRY GETHAIN
DA2ES QR =M 1202 EHPQ EXIT

HE265 QR M o0Z02 EHGF EXIT
HE26S QR AF Bvd2 ABAE EXIT

BA2ES QR ou aEal DUTH  EXIT

HE26S QR AP D502 EUEW  EVENT

LOAD<EXCEPTION
HE2ES QR AP 0741 ABAE ENTRY CREATE_RAEBEMD_RECORD

DA2ES QR EM 1201 EHPQ  ENTRY ALLOCATE_PAGEPOOL_STORAGE ACEAZADL,1360,NO
ALLOCATE_PAGEPOOL_STORAGE-<OK 1008, AEDSGO00, OCE
GETHAI -0k
CREATE_ABEND_RECORD-OK GEDSEEOE
HE26S QR AF 074l ABAE ENTRY ETART_AEEND
HE26S QR U aiel DUDL ENTRY  TRAMEACTIOM_DURP
HE2ES QR OU BeEge DUTH  ENTRY  LOCATE_TRAM_DUAPCODE  APCT
LOCATE_TRAN_DUHPCODE-OK FFFFFFFF,1,0,0,0,8,H0,
DA2ES QR AP D518 APEX ENTRY IWUVOKE_USER_EXIT
DA2ES QR AP D511 APEX ENTRY PARAMETERZ-UNIQUE-TO-EXIT-FOINTZ

HE265 QR AP D=12 APEX ENTRY PARAMETERZ-UNIQUE-TO-EXIT-FOINTZ
LINK-TO-UZER-EXIT-FROGRAH AT EXIT POINT «8suas

--= CLERR=E®it 1=Help 3=End F7«&=icroll le-li=Left-Right ----———————————-

PROGRAM_NOT _LOADAELE, OCE
BOVEASIL . GO0E0EL10,KHxN
115, H0,08, TACE,CICE
BEDGEDEE 120
BEDGEDEE , TES, NO

APCT ,YEZ,TEZ,YEE,VEZ,YES

HOUREQ,YEZ,0DTEELLS , &8

Trace Table Format

The Trace table is formatted using the IBM-supplied trace formatting routines for
printing, which format the trace for 132 columns. To view the portion on the right side of
your screen, use the Right PF key to scroll right.

The Trace tableisin conventional sequence, that is, oldest first. When you select this
option, the screen shown is the last page of the trace because thisis where the pertinent

entries are likely to be.

The Trace table includes al entries for the abending task, from initial detection to the
point where SmartQuest is passed control of the abend. The table includes entries for
other tasks that may be executing at that time.

The Trace table screen also has a FIND command with this format:

FIND string
F “‘quoted string”
X”hex-string”’

FIRST
LAST
PREV
NEXT

start-column end-column

Use the RFIND key to repeat the last FIND command.
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Expanded Trace Table

On the CICS/ESA Trace table screen, use the ZOOM fesature to display the Expanded
trace table entry screen shown in Figure 34.

Figure 34 « Expanded Trace Table Entry Screen

AEG-EHartQuest 7.0.8 T20
File Filter List Details Labels Haps Toggles Help
ConHand ===k _
UIEW 1--——- Expanded trace table entry
PiE @G02 PGLD ESIT - FUMCTIONM(LOAD] REEPOMEE[EWCERTION]
REAZON[PROGRAH_MOT _LOADABLE ] LOAD_POINT (BCETTFE2)] ENTRY_POINT [SE2D3
FROGRAFA_LENETHI 1203020 ]
TREK-00265 KE_NUH-0017 TCE-QR SEBSCOADG RET-SCFDAFDE TIHE-ES620093321EFGQR
—INT ERUVAL —k cetbetsttoistiok SHER2EE=

1-a0ad aad #o tanaa Fasannans *
ao018 EFEQDD0D a0ao00n 82740203 EYEVEVET #.a™ieeseaanas HHHH*
a028 4odadadd ACEYTFOZ SEPDI00L 01903028 #*  LLi.aieeeeas
QO30 Q1020299 GCRACARD ADTVEADAS DCHECE0d F.iiaiseemns y..Iﬁ*

--= CLERR=EXit 1=Help 3I=End Tv«&=iCroll

This screen includes only a single expanded trace entry. If you are not using a
132-column terminal, the entry is reformatted to fit an 80-column display. Y ou can scroll
within expanded trace entries using the L eft and Right PF keys. Use the PF3 key to return
to the abbreviated Trace table screen.

Language Environment Trace (MVS Only)

The Language Environment Trace option lets you view the trace entries. If you are using
the Language Environment run-time libraries with the trace run-time option on and trace
entries have actually been produced, these are captured and preserved on the SmartQuest
for MVS dump file.
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To access the Language Environment trace entries, follow this step:

» Select Details » Language Environment Trace or type LETRACE. The Language
Environment Trace Display screen, shown in Figure 35, displays.

Figure35¢ Language Environment Trace Display Screen

ASG-EHartiuest T.0.8 T30
File Filter List Details Labels Haps Toggles Help
CoHHand ===

VIEW 1-———- Language EnvironHent Trace Display
Entry 001 of 032
TiHEranenn BEEOSIIE25EFO040 Thredd IDeeesesaas SORADADERADDADDEE
HeHbet IDesass 83 FlagSeesss ADEAEE  ENTEY TYDE.aues DOA00AA1
AAELEROE d0d0dode dodododd d0dadodn Hain
40404040 40404040 dO40d0d 40404040

GAEAEE4D FOFSFSSD d4a97edss HTAZSEAD -=*[0B35] printfl
S0dadada dodedada dadadadn dodadada 1

40d0dada dodadada dadadadn dodadada

dadadadd dadadada dadadada dadadada

dadadadn dadadada

-—— CLEAR=EXit 1=Help 3=End 7v-&=%croll

The screen displays a single entry per screen, with the top right showing both the current
entry and the total number of entries. They are listed from oldest to newest and when
initially selected you are always shown the first (oldest) entry. Use the Up and Down
keysto scroll the entries.

Note:

For adescription of the trace entry contents see the Language Environment
Messages and Debugging manual.

IMS Diagnostic Information (MVS Only)

The IMS Diagnostic Information screen displays information captured for the last DL/1
CALL that your Batch or online IMS job issued. This capture is possible in the majority
of cases, depending on whether the DL/1 CALL save areaisstill available and intact. The
information is always captured for EXEC DLI CALLs. The address of thelast DL/1
CALL forms apart of the displayed information in the case of EXEC DLI CALLs. Itis
not available for CALLsusing the CALLDLI interface.

Failed PSB schedule CALLsusing the CALLDLI interface are not captured. Thisis
because the ISB is not yet generated and the CALL parameter area no longer exists. For
schedule failures using the CALLDLI interface, examine the trace table to determine the
reason for the failure.
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The information captured differs depending on whether you are using Remote DL/1 or
DBCTL. It also depends, to alesser extent, on whether you are using the EXEC DLI
interface or the CALLDLI interface.

The IMS Diagnostic Information screen displays this information:

e TheCALL parametersand IMS CALL history data. Y ou can also display a history
summary of thelast 5 CALLSs.

=  Cal addresses (for EXEC DLI CALLS) that can be used for ZOOMing. It also
shows the DL/1 status code returned by the CALL and provides a brief description
of this code.

< Addressof the DIB (if the CALL wasan EXECDLI CALL) and the name of the
PSB being used in MVS. Y ou can ZOOM on the DIB address, if present, to view its
contents mapped with field names.

- Details of the DL/1 CALL parameters and the PSB name. The screen lists the
function code, the PCB address, and the |O area address, and for each SSA it gives
the segment name and address. Y ou can use the ZOOM feature on all parameter
addresses.

To view the CALL history

1  Sdect Details» IMS diagnostic information or typeDL1 (or DL1). The IMS
Diagnostic Information screen, shown in Figure 36, displays.

Figure 36« IMS Diagnostic I nformation Screen

AEG-EHartQuest 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help

Connand ===k _
UIENW 1----- IRz Diagnostic Infornation
IR Eysten idea.s IUPL
PEE NaME. e uuunnas DFHZAH24 PCE Listovanunuas Available

Last CALLDLI refturned & status code of “AC
Hierarchic errar in 3RS

FUnCtion.esasanas G

PCE addressesuaes EEEa0Coa PCE Fornatting... Available
PCE call history. Avrailable

IN area address.. OCEICI4S

Hueber of ZE2As... 0001

EEAL (00 ) aunnnn. OCELC12E BEETROOT[PARTKEY =02HE16995-28 1.

-—= CLEAR=EXit 1=Help 3I=End

Note:
If thiswere a CICS dump, the PAPL Address and DRA Name fields display.
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2  Placethecursor ontheword Availableinthe PCB Call History field and press Enter

to display the Call History Display (from JCB) screen, shown in Figure 37.

Figure 37« Call History Display (from JCB) Screen

AEG-EHartQuest 7.0.8 T20
File Filter List Details Labels Haps Toggles Help
ConHand ===

UIEM 1--——- Call History Display (From TCE)
- Function: GHU or GU
status: "GE" [First byte assuded using function)
Crossing unit of work boundary
- Function: PURGE
Etatus: "5 [Could not deterdine 1st byte of status)

= Function: GHU or GU
Status: "GE" [First byte assuded using function)
Crossing unit of work boundary

- Function: PURGE
status: "#§" [Could not deterdine 1st byte of status)

- Function: GHU aor GU
status: "GEC" [First byte assured using function)
Crossing unit of work boundary

= Function: PURGE
Etatus: "5 [Could not deterdine 1st byte of status)

--= CLERR=EXit 1=Help 3=End

To view the PCB list

1  FromthelMSDiagnostic Information screen, placethe cursor ontheword Available
in the PCB List field and press Enter. The Acquired storage + CICS control blocks

screen, shown in Figure 38, displays.

Figure 38+ Acquired Storage + CICS Control Blocks Screen

AEG-ERartQuest F.0.0 T30
File Filter List Details Labels Haps Toggles Help
CoHHand ===

VIEW 1---—- HEquiPed storage + CICE control blocks

Id. Address  Resource Description

I0PCE BOa0DCES OL1 prograd coWdunication block
DEPCE B0000C0a DIZIPART DL1 prograd CoMAunication block
JCE BrevE0ed DIZIPART DL1 journal control block

Lemgth  Motes

HEEETE
L
aaaiaa

-—— CLERR=E®it 1=Help 3=End 7v-&=2croll

Note:
The JCB field only displays for Batch dumps.
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2 Placeyour cursor on the highlighted PCB Address field and press enter to display
the Map display for that PCB, as shown in Figure 39.

Figure 39« Map Display of the DBPCB

AEG-EHartiuest 7.0.80 T20
File Filter List Details Labels Haps Toggles Help
Connand ===k _
UIENW 1-----— Hap display of the DEPCE [DIZIFART)
Field naHe Length Type  Address Offzet  Contents
DEPCELEN 2 Binary Q0EA0C0OA Q0000 150
DEPCEPLN 2 Binary Q0EA0C02 Q0002 156
DEPCENUA. . 2 Binary o0eaDchd aoaoed 2
DEPCEFLG. « 1 Hex DEOEA0COE DRADAG = A0
DEPCEFLZ 1 Hex CORaDCDT Q0aaa7 & 20
DEPCEBEST 2 Char QORa0DCDE Q0005
DEPCBESC 2 Char DEEa0ChA Dea08aR
DEPCEFLE 1 Hex DEOEA0COC AOE0AC & a0
.............................. 1 Hex DOER0CO0D QRagan = G
.............................. 2 Char DOER0OCOE QRO0EE ¥ Q008
DEPRTERA. sa s snnsnnnnnnnnnnnns 4 EBinary Q0EADCED oaoio 19236560
DEPCEERC 4 Binary 0080D0CE4 aoa0id 0
DEPCECTL 4 Binary O00ADCES aoools 1 PESRTEVE
DEPCENAH . « & Char CORA0DCE: a0801C & S000000000000a08a
DEPCEXTH. « 4 EBinary Q000DCF4 00zd 15EEEL
DEPCESGL 4 Einary D0EA0CFE Q00025 0
-—— CLEAR=Exit 1=Help 3=End 7-&=%croll

3  Fromthe IMS Diagnostic Information screen, place your cursor on the word
Available in the PCB Formatting field. Y ou can also access this screen by placing
your cursor on the highlighted PCB Resource field on the Acquired storage + CICS
control blocks screen and press Enter. The Formatted PCB Display screen, shownin
Figure 40, displays. This screen is available only for DB PCBs. If the last CALL
used on IO PCB, formatting is not available.

Figure40+ Formatted PCB Display Screen

AZG-ZHAFTOUSST 7.0.8 T30
File Filter List Details Labels Haps Toggles  Help

CoHHand ===} _

UIEW 1---—- For-natted PCE Display
DED NAHE. s eannns DIZ1FART
Lewvel Feadback... @0
Ftatus Codé...... A
Hierarchic errar in 3RS
Proc OptionS..... A
ZegHent Made.....

FenSeq COUNtesua. AOaa00aSs

Key Feedback Len. Qo000
key Feedback Adr. @o0apD2c

--= CLEAR=E®it 1=Help 3I=End

4 Place the cursor on the JCB Addressfield and press Enter to display the Call History
Display (from JCB) screen, shown in Figure 37 on page 49.
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DB2 Diagnostic Information

The DB2 diagnostic information option displays information captured relating to the last
DB2 CALL made. The actual CALL addresses are obtained only if the abend occursin
DB2 itself because the save areaislost on return from the CALL.

Note:
To use DSNTIAR formatting of the SQLCA diagnostics, the DB2 library containing the
DSNTIAR and DSNTIA1 modules must be in the LNKLST, or copied to the SmartQuest
LNKLST library.

To access the DB2 diagnostic information, follow this step:

1  Select Details» DB2 diagnostic information or type DB2. The information captured
and presented on the DB/2 Diagnostic Information screen, shown in Figure 41,

displays.

Figure4l+ DB2 Diagnostic I nformation Screen

AEG-EHartQuest 7.0.8 T20
File Filter List Details Labels Haps Toggles Help
ConHand ===k _
VIEW 1-———- DE2 Diagnostic Infornation

Last EXEC QL returned a status code of +@0@
Fuccessfully edecuted
DE<2 subsysted... O71A

Plal.ceeaaanssnns HUDE2CE
EXEC #0L twpe.... FETCH
Statenent..eeus.. 143
Rt iOMe e sannnen 1
SOLCA address.... DCEIT49S
Total wariables.. 5

Address  Length  Type Indicatar
a1 OUT ECEII160 & CHAR L]
a2 OUT ecEITies 1S CHAR Ll ]
803 OUT ECE3IL7S 3 CHAR ADERaa0E
a04 OUT BCE3FLTS 36 CHAR a1 aAdCEHa
05 OUT BCEIZ19C 9,2 DECIHAL OROEQDDd S

--= CLERR=EXit 1=Help 3I=End Tv«&=iCroll

2 Position the cursor on the SQL status code (+000) and press Enter to display the
Formatted SQLCA Display (Using DSNTIAR) screen.

The DB2 Diagnostic Information screen displays this information:

- Fields on the left display information for a Batch DB2 dump, while fields on the
right are unique to CICS.
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- Details of the SQL response code and a brief description of this code. It also
contains these details:

— DB2 control blocks used by the transaction. Y ou can display these blocks by
positioning the cursor on the address of the block that you want to examine and
pressing Enter.

—  SQL response code and a brief description of this code. It also contains details
of the DB2 system plan, some SQL statement information, and the SQLCA
address. To view the SQLCA contents ZOOM on the address.

- DB2 parametersfor the last CALL. It shows the address of each parameter, its
length, its type, the address of any associated indicator variable, and whether the
variable isto be used for input or output. The first five parameters are displayed.
Any additional parameters can be shown by using the Up and Down scroll keys.
You can use al parameter addresses and indicator variable addresses to ZOOM to
thesefields.

Online Print Job Submission

52

If you specify PRINT=Y ES on the ASG-SmartQuest - Customization - MV S Product
Parameters screen (see the ASG-SmartQuest I nstallation Guide for more information), an
INQUDUMP DD is generated and aformatted abend dump report is generated.

Note:
If you are using an AKR, no source codeisincluded in the INQUDUMP file.

Figure 42 is an example of an INQUDUMP:

Figure42+ Sample INQUDUMP

(c)2002 Copyright ASG, Inc. ASG-SmartQuest for MVS 7.0 Page 1

##SUM - Abend summary report
Job name......... VISQSCOB Date............. 2002711708

Abend code....... S0C7 Reason code...... 00000007
A program interruption occurred
Data exception

Abend PSW........ 078D0000 00008382 Ilc 6 Intc 07

Abending instruction details.

Address.......... 0000837C Amode............ 24
Offset 00064C in program VISQSCOB

Offset 00064C in CSECT  VISQSCOB

Failing instruction: FAOO 8000 AOAB AP 0(1,8),171(1,10)
Operand 1 at 0004E398 contains 40 Invalid packed

Operand is at offset 000000 in BLW cell 0000

Operand 2 at 00007E63 contains 1F

Registers at entry to abend

RO 00000000BOOO8DFE R1 0000000000055028
R2 0000000000008226 R3 000000000001D1BC
R4  000000000004E098 R5 000000004000836A
R6 00000000008C5FF8 R7 0000000000058FBO
R8 000000000004E398 R9 0000000000055028



R10 0000000000007DB8 R11 0000000000008154
R12 0000000000007DBO R13 000000000004C370
R14 0000000050052930 R15 0000000000DA06GFO

2 Using SmartQuest

FPRO 493161FE00000000 FPR2 0000000000000000
FPR4 0000000000000000 FPR6 0000000000000000
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##CHAIN - Calling chain summary
Proceeding forward from TCBFSA

Save area at 00006FA8. EPAname=VISQSCOB (Invoked

WD1 00000000 HSA 00000000 LSA 00006BA8 RET 80FCCE40
EPA 00008B70 RO FDO0O0O008 R1 O00006FF8 R2
R3 008D3CD4 R4 008D3CBO R5 008F6920 R6
R7 FDOOO0O0OO R8 O008F6E40 R9 008F62B8 R10
R11 008F6920 R12 O0E2385A

Save area at 00006BA8. EPAname=1GZEINI (Invoked
WD1 00101001 HSA 0001C428 LSA 000000A8 RET
EPA 80009010 RO 00000000 R1 0004C370 R2
R3 OOO0O8ES5E R4 00007D84 R5 0O0006BFC R6
R7 FDOOO0O0OO R8 80007B44 R9 00000000 R10
R11 00000000 R12 00008B70
Invalid Back Chain Detected

Interrupt at 00008382
Proceeding backward from R13

Save area at 00006BA8. EPAname=1GZEINI (Invoked
WD1 00101001 HSA 0001C428 LSA 000000A8 RET
EPA 80009010 RO 00000000 R1 0004C370 R2
R3 O0OO08ES5E R4 00007D84 R5 00006BFC R6
R7 FDOOO0O0OO R8 80007B44 R9 00000000 R10
R11 00000000 R12 00008B70

Save area at 0001C428. EPAname=VISQSCOB (Invoked
WD1 00000000 HSA 00006C70 LSA 0004C370 RET
EPA 00007D30 RO 00000000 R1 O0001AAFO R2
R3 00000000 R4 00000000 R5 00000000 R6
R7 00000000 R8 00000000 R9 00000000 R10
R11 00000000 R12 0001BACO

Save area at 00006C70. EPAname=1GZEPLF (Invoked
WD1 00100001 HSA 00006FA8 LSA 00000000 RET

via link)

00000040
008C5FF8
00000000

via call)
00008DFO
00006BA8
008C5FF8
00000000

via call)
00008DFO
00006BA8
008C5FF8
00000000

via call)
80010280
00000000
00000000
00000000

via call)
00007440

EPA 00007298 RO 00007D30 R1 00006CB8 R2 00006FA8
R3 00006CD4 R4 O00006BFC R5 0000A198 R6 008C5FF8
R7 FDOOO0O0OO R8 00006BA8 R9 0001AAFO R10 00000000
R11 00009198 R12 00000000
Save area at 00006FA8. EPAname=VISQSCOB (Invoked via link)
WD1 00000000 HSA 00000000 LSA 00006BA8 RET 80FCCE40
EPA 00008B70 RO FDOOO008 R1 O00006FF8 R2 00000040
R3 008D3CD4 R4 008D3CBO R5 O008F6920 R6 008C5FF8
R7 FDOOO0O0OO R8 O008F6E40 R9 008F62B8 R10 00000000
R11 008F6920 R12 O0E2385A
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##CHAIN - Active program details
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#HProgram.......... VISQSCOB
***NOTE*** This is the failing program
Load point......... 00007D30
Entry point........ 00007D30
Program Length..... 000012D0
Language. .. ........ Cobol 2
Amode. ... ..oioa.. 24
Link edit date..... 06 Nov 01
Load library....... CONSXO.GENERAL . LOAD
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WKS address........ 0004E398
TGT address........ 0004C370
Abend was at:
Offset 00064C in program
Offset 00064C in CSECT VISQSCOB
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BL Cells for program VISQSCOB
BLF= 000

Address Offset

00055028 000000
00055038 000010
00055048 000020
00055058 000030
Address 00055068

00055128 000100
00055138 000110
Address 00055148

Hex Char

E2FOC3F7 40404040 40404040 40404040 SOC7

4040E3C5 E2E340C1 C2C5D5C4 40C9E2E2 TEST ABEND ISS
E4C5C440 C2E840E5 COE2D8E2 C3D6C240 UED BY VISQSCOB
40404040 40404040 40404040 40404040

to 000550A7 (X"000040" bytes) same as above

40404040 40404040 40000000 00000000
00000000 00000000 00000000 00000000 - oo cocaoonao-s
to 00056017 (X"0O0OEDO" bytes) same as above

00056018 OOOFFO 00000000 00000000 00000000 00000000 . ...oweevnennnn.

BLF= 001
Address Offset Hex Char

00058FBO 000000 E2FOC3F7 40404040 C4C1E3C1 40C5E7C3 SOC7
00058FCO 000010 C5D7E3C9 D6D54040 40404040 40404040 EPTION
00058FDO 000020 40404040 40404040 40404040 40404040

Address 00058FEO to 00058FFF (X"000020" bytes) same as above

DATA EXC

60059090 0000EO
000590A0 0000FO
000590B0 000100

92DA06F0 00000001 00000001 080933F4 k..O. ... ...... 4
00000000 00006450 O005AC8D O005AC8D . ...... [
00000085 00000001 00000000 00000001 ...€..cccuuwuuen-n
000590C0O 000110 C3C5C5D4 7CD4D6E4 00000000 00000000 CEEM@MOU. . ......
000590D0 000120 00000000 00000000 00000000 00000000 ... -cococoeoon-n
Address 000590EO0 to 00059F9F (X"000ECO*" bytes) same as above

00059FAO0 OOOFFO 00000000 00000000 00000000 00000000 - - vccccccccaann-

BLW= 000
Address Offset Hex Char
0004E398 000000

0004E3A8 000010
0004E3B8 000020

40000000 00000000 OO5FO000 00000000
00000000 00000000 00000000 DOCBE4C2 ............ RHUB
C1D9C240 E5C9E2D8 E2D5C1D7 ARB VISQSNAP
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TGT for program VISQSCOB

Address Offset Hex Char
0004C370 000000
0004C380 000010
0004C390 000020
0004C3A0 000030
0004C3B0 000040
0004C3C0 000050
0004C3D0 000060

00108001 0001C428 00000000 700082CC ...... [0 b.
80053548 BOOO8BDFE 00007FDF 0O004E098 .......... Y....q
0001D1BC OOO4E1F8 00000000 OO8CS5FF8 ..J....8...... 8
00000000 0004E398 00055028 00007DB8 ...... T9..&...7.
00008154 00007DBO F2E3C7E3 0002C018 ..a...
03000000 65008220 0004C038 0001D1BC ...... b....... J.
0004C500 00000002 0000002C 00000000 ..E.............

Address 0004C610 to 0004C64F (X"000040° bytes) same as above

0004C650 0002E0 00000000 00000000 0004C0O00 00000088 . ............-. h
0004C660 0002F0 C3E2E3D2 00000000 00000000 00800001 CSTK............
0004C670 000300 00000001 00000068 00000000 00000000 .- wccvcccucuannn
0004C680 000310 00000000 00000000 00000000 00000000 . ...-wecwuonnnnn
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Address 0004C690 to OOO4DFFF (X"001970" bytes) same as above

0004E000 001C90 C8C1D5C3 0001AE68 0001AE68 00000000 HANC............

0004E010 001CAO 0004E001 0004E428 00002000 00001BDS8 ...... [V Q

0004E020 001CBO 0004E000 00000408 OO0O00O3FE 00000000 .- .-cvuccucuannn
0004E030 001CCO 0CBOCO68 00000000 OCBOCO78 00000000 - .. oo e eaaan -

0004E040 001CDO 00000000 01000000 00000000 01055020 ........cu-..- &.
0004E050 001CEO 00844000 000068CO C6000001 9004C584 .d ..... | S Ed
0004E060 001CFO 00900048 008CE030 92DA06FO0 00000000 . ....... K..0....
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0004E070 001DO0 0005193A 08090084 00000000 00006760 ....... d.o...... -
0004E080 001D10 000550AC 000550AC 00000084 00000000 . .&.-.&-...d....
0004E090 001D20 00000000 00000000 C6C3C200 01020000 . ....... FCB.....

0004EOAO 001D30 FFFFFFFF FFFFFFFF FFFFFFFF FFFFFFFF ... ... ... .. .....
0O004EOBO 001D40 FFFFFFFF FFFFFFFF FFFFFFFF 00000000 ............c.o...

0004E2D0 001F60 00000050 00000000 00000000 00000000 .. .&. . ...oooon..
0004E2E0 001F70 00000000 00000000 00000000 00000000 . .- -vcwcvueaannn
0004E2F0 001F80 00000000 OO058FBO 00000000 00000000 - - vcocccvccoan-n-
0004E300 001F90 00000000 00000000 00000000 00000000 ... -covoooeoon-n
Address 0004E310 to 0004E35F (X"000050" bytes) same as above

0004E360 001FFO 00000000 00000000 OOOO0000 00000000 - - vvccccvccaan-n-
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##Program. .. .. ..... 1GZEPLF
Load point......... 00007298
Entry point........ 00007298
Program Length..... 00000880
Language. .. ........ Assembler
Amode.............. 31
Link edit date..... 14 Jul 01
Load library....... CEE . SCEERUN

Last call at:
Offset 008FE8 in program
Offset 000000 in CSECT IGZEPLF
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##Program. .. .. ..... V1SQSCOB
Load point......... 00007D30
Entry point........ 00007D30
Program Length..... 000012D0
Language. .. ........ Assembler
PAY)1To Yo [ 24
Link edit date..... 06 Nov 01
Load library....... GENERAL .LOAD

Last call at:
Offset FFF70E in program
Offset 000000 in CSECT VISQSCOB
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Program storage for program VI1SQSCOB

Address Offset Hex Char

00007D30 000000 47FOF070 23E5C9E2 D8E2C3D6 C240C3F2 .00..VISQSCOB C2
00007D40 000010 40F14BF4 4BF040F1 F161FOF6 61FOF140 1.4.0 11/06/01
00007D50 000020 FOF54BF4 F74BF1F6 00007D84 E4E87E4C 05.47.16.."dUY=<

Address 00008060 to 0000807F (X"000020" bytes) same as above
00008080 000350 00000000 E2E8E2C3 D6C24040 40400000 . ...SYSCOB
00008090 000360 00000000 OOOOE2E8 E2C3D6C2 D6404040 ...... SYSCOBO
000080A0 000370 40404040 40404040 40404040 40404040

(c)2002 Copyright ASG, Inc. ASG-SmartQuest for MVS 7.0
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#HFILES - Open file 1/0 summary

Last record for file with DDNAME=SYSCOBI
Address Offset Hex Char

00058FBO 000000 E2FOC3F7 40404040 C4C1E3C1 40C5E7C3 SOC7 DATA EXC
00058FCO 000010 C5D7E3C9 D6D54040 40404040 40404040 EPTION

00058FDO 000020 40404040 40404040 40404040 40404040

Address 00058FEO to O0058FEF (X"000010° bytes) same as above

O0058FF0 000040 40404040 40404040 40404040 40404040

Last record for file with DDNAME=SYSCOBO
Address Offset Hex Char

00055028 000000 E2FOC3F7 40404040 40404040 40404040 SsoOC7

00055038 000010 4040E3C5 E2E340C1 C2C5D5C4 40C9E2E2  TEST ABEND 1SS
00055048 000020 E4C5C440 C2E840E5 C9E2D8E2 C3D6C240 UED BY VISQSCOB
00055058 000030 40404040 40404040 40404040 40404040

Address 00055068 to O00550A7 (X"000040° bytes) same as above

000550A8 000080 40404040

Last record for file with DDNAME=SYSOUT
Address Offset Hex Char
000550B8 000000 40404040 40404040 40404040 40404040

Address 000550C8 to 00055127 (X"000060" bytes) same as above
00055128 000070 40404040 40404040 40

(c)2002 Copyright ASG, Inc. ASG-SmartQuest for MVS 7.0

#H#HELP - 1BM abend code description

WARNING. The following information on this report is
copyright IBM Corporation. It has been supplied on a
file, with ASG-SmartQuest, by permission of IBM and the
file must not be used for any other purpose.

* ook % %
* ok % %

Explanation: A program interruption occurred, but no routine had been
specified to handle this type of interruption. Refer to the
instruction description in Principles of Operation to find out how the
instruction stops processing for the error condition.

The last digit of this completion code is a hexadecimal number that
indicates the cause of the program interruption. Each X"0Cx" system
completion code has a reason code, which in most cases equals the last
digit. X"0C4" however, has several reason codes.

Abend
Code Explanation

0oc1 Operation exception. The reason code is 1.

0c2 Privileged-operation exception. The reason code is 2.
0C3 Execute exception. The reason code is 3.

0C4 One of the following exceptions occurred:

4 Protection exception. The key of the storage area
that the running program tries to access is different
from that of the running program. The key of the
running program can be obtained from the PSW key
field. The key of the storage can be obtained using
the IPCS LIST subcommand. The programmer should
determine whether the program is running with the
correct key or whether the storage address is set up
correctly.

The protection exception might have occurred when the
program referenced a page that is protected with the
PGSER PROTECT service, or is defined as shared by the
IARVSERV service with a view of read-only.
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10 Segment-translation exception. This error is caused
by one of the following:

A program that was running disabled attempted to
reference storage while the page table for that
storage was paged out. To correct the error,
page-fix the storage before a program running
disabled attempts to reference it.

A program attempted to reference storage that had
not been obtained. To correct the error, allocate
the storage before attempting to reference it.

A program running in a subspace attempted to

(c)2002 Copyright ASG, Inc. ASG-SmartQuest for MVS 7.0

0C5

0C6

0oc7

0cs8

0C9

OCA

ocB

occ

0CD

OCE

OCF

reference storage that was not accessible to the
subspace at the time of error. To correct the
error, ensure that the program running in a
subspace references only the storage assigned to
that subspace, or storage that can be referenced
by all subspaces.

11 Page-translation exception. This error is caused by
one of the following:

A program that was running disabled attempted to
reference storage while that storage was paged
out. To correct the error, page-fix the storage
before a program running disabled attempts to
reference it.
A program attempted to reference storage that had
not been obtained. To correct the error, allocate
the storage before attempting to reference it.
A program running in a subspace attempted to
reference storage that was not accessible to the
subspace at the time of error. To correct the
error, ensure that the program running in a
subspace references only the storage assigned to
that subspace, or storage that can be referenced
by all subspaces.
SMS abend. The reason code is X"12C".
Addressing exception. The reason code is 5.
Specification exception. The reason code is 6.
Data exception. The reason code is 7.
Fixed-point-overflow exception. The reason code is 8.
Fixed-point-divide exception. The reason code is 9.
Decimal-overflow exception. The reason code is A.
Decimal-divide exception. The reason code is B.
Exponent-overflow exception. The reason code is C.
Exponent-underflow exception. The reason code is D.

Significance exception. The reason code is E.

Floating-point-divide exception. The reason code is F.

Source: Supervisor control

System Action: The system abnormally ends the task, unless a recovery
routine was provided to handle the interruption. The hardware action
is given in Principles of Operation.
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(c)2002 Copyright ASG, Inc. ASG-SmartQuest for MVS 7.0

System Programmer Response: Determine whether the problem program or
control program was in error.

1T the problem program contained an error, correct it, and run the job
step again.

End of ASG-SmartQuest dump summary
To print one or more dumps

1  OntheList pull-down screen, type P to the left of the dumps you want to print, as
shown in Figure 43.

Figure43+ Selected Dump List Screen (Print Option)

AZG-ZHAFTOUEST T.0.8 TS0
File Filter List Details Labels Haps Toggles Help

ComAand # Zelected DuMp List t
UIEW 1- Date TiHe Job<Appl Tran Abnd Terd Prograd  Cot Notes

Tran | _ 2082-18-16 04723348 VIACDAZ IQLk APCT LeAav TEZTPROG

Tazk | _ 2002-18-16 904114117 VIACDAZ DLPE DHAC LeAT OAKZ2DLPE

Tern | _ 2002-18-16 04713155 VIACDAZ DLCC DL42 LOA7 OAK2DLCC

Aben | _ 2002-18-16 943711347 VIACDAZ DLCE DHAC Leay OAKZDLCE

Prog [ P z2oa2-18-16 odiaEi26 UWIACDAZ IQL2 ASRA LOAT HEPLLE

- 200Z2-10-16 83154700 UIACDAZ IOQLZ AZRA LOOT HIPLIL
Aben | _ 2002-18-16 02750729 VIACDAZ DEZ21 AEYY LOAY DE2PROGL
Aben | _ 2082-18-16 02749349 VIACDAZ IQLK AZRA LAY HECOEIE

2002-18-16 a27d43id4d UIACDAZ IQLK AEL: LOAT7 HECOE2P
2002-18-16 02143139 UIACDAZ IQLK OQAKE LOAT7 HECOB2P
Fail 2002-18-16 027132034 UIACDAZ  IQLK ASRA LOAT HECOB2G
2002-18-16 02732022 UIACDAZ TIQLK ASRA LO&7 HICOB2F2
2o02-18-16 02331024 UIACDAZ IQLK ASRA LOAF7 HECOBZEZ

Lazt | _ 2002-18-16 0272945 VIACDAZ IQLK AZRA LOAT HICOELA
Reszo [ _ 2002-18-14 05182143 VIATEESTY ZACT HUCOELR
Eibt ®-- PFI=End 7v-&=2croll

——— CLEAR=E®it 1=Help 3=End
Key "s"elect, "D'elete, "H'old, "R"eleasa or "P rint.
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Press Enter to display the User Print Submission Job Card Details screen shown in
Figure 44.

Figure44 « User Print Submission Job Card Details Screen

i m User Print SubHission Job Card Details -—--———————-—- —
s jobnade  JOE  ..rest of jobcard...
ok ——
sk
sk
e FF3=End
Tazk | _ 20@2-18-16 84714217 UIACOAZ OLPE DHAC LEAT OAKZOLPE
Tern | _ 2082-18-16 84713:55 UIACOAZ OLCC DL42 LEAT7 OAK2O0LCC
Aben | _ 2082-18- & 84711243 UIACOAZ OLCE DHAC LEAa7 OAK2O0LCE
Prog | P o2ea2-18-16 8diosi2é UIACOAZ IQL2 ASRA LOAOT HEPLLE
_ 2E0z-18-16 03:540080 UIACDAZ IQL2 AERA LOOY HEIPLIL
Aben _ ZE0Z-18- & 02.5002% UIACDAZ DE21 AEYY LO07Y DEZPROGL
Aben | _ 2002-18-16 82749049 VIACDAZ IOLK ASRA LT HECOBIE
_ 200z2-10-16 02:d3idd UTACDARZ IGLK REIS LAAY HICOBZP
_ 200z2-10-16 02243039 UTACDRZ IqLK ORKS LOO7 HECOBZP
Fail | _ 20@2-18-16 82732:34 UIACOAZ IQLK ASRA LOAT HECOB2E
_ 209 -19-16 922132122 UTACDAZ IALK AZRA LOo7 HECOBIF2
_ 200 —10-16 02131124 UTACDAZ IQLKE AZRA LOOT HECOBZEZ
Last _ 2Ez-18-16 02029045 UIACDAZ IGLKE AERA LO8Y HEICOBUA
Re=o _ 2E0z-18-1d 05182743 VIATESTUY s0CT HUCOELA
Eibt- #-- PFI=End 7v-&=3croll

—--- CLEAR=EXit 1=Help 3=End
Change job card, <enter: to subHit, <end* to cancel

Enter your job card details. Y ou can have amaximum of four lines of job card JCL,
but unused lines should be specified with //* in the first 3 positions.

Thejob card details are saved in your user profile record in the SmartQuest Profile
file. Thisjob card information displays on the User Print Submission Job Card
Details screen the next time you print.

Note:

Only the user that invoked the CICS region has the rights to submit a print dump
job for the dump. The job card information must pertain to that user.

Press Enter to build and submit the print job JCL. If the job has been successfully
built and submitted, a screen similar to Figure 45 on page 60 displays.
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Only onejob is submitted, even if you requested the printing of multiple dumps.
Each dump print is added as a step within the same job.

Figure45+ Selected Dump List Screen Displaying Print Job Details

W m e User Print SubHission Job Card Details -—---——————-—- —
<37 bnane 0B . rest of obcard. .
ok + Felected Dunp List
ke Date Time  Job<Appl Tran Abnd Terd Prograd  Gnt Motes
sk
Hmm - 2002-10-16 Adi23:dA VIACDAZ IGLK APCT LAAY TESTPROG
Tazk | _ 2002-18-16 84714217 UIACOAZ OLPE DHAC LEAT OAKZOLPE
Tern | _ 2002-18-16 84713255 UIACOAZ OLCC DL42 LEAT OAK2O0LCC
Aben | _ 2002-18-16 84711243 UIACOAZ OLCE DHAC LEA7 OAK2O0LCE
Prog | _ 2802-18-16 8dioSi26 UIACDAZ IQL2 ASRA LEOAT HEPLLE Printed
_ o2e0z-18-16 03:54700 UIACDAZ IQL2 AERA LOOY HEIPLIL
Aben _ 2E0z-18-16 0258729 UIACDAZ2 DE21 AEYY LO07Y DEZPROGL
Aben | _ 2002-18-16 82749049 VIACDAZ IOLK ASRA LT HECOBIE
_ 2002-10-16 f2:d3:dd VIACDAZ IGLK REIS LAY HICOEZP
_ 2002-10-16 02243039 UIACDAZ IqLK ORKS LOOV HECOBZP
Fail | _ 2002-18-16 82:32:3d UIACODAZ IQLK ASRA LEOAT HECOB2S
_ 2002-19-16 92132122 UIACDAZ IALK AZRA LOo7 HECOBIF2
_ 2002-10-16 02131124 UIACDAZ IQLK AZRA LOOT HECOBZEZ
Last _ 2E0z-18-16 02029745 UIACDAZ IGLE AERA LOOY HEICOBUA
Reso _ 2o0z-18-1d4 05182743 UIATESTUY s0CT HUCOELA
Eibt #-- PFI=End v-&=3croll

—--- CLERR=EXit 1=Help 3=End
Print job jobnaWe [JOED1954] subMitted

Note:

The dumps printed are marked Printed in the Notes column. The message at the foot of
the screen informs you of the name and number of the print job.

The Labels Action Bar Option

Every SmartQuest screen, except the pull-down screens and the SmartQuest for CICS
Last 3270 screen, can be assigned alabel and redisplayed using that label. The Labels
action bar option displays alist of your assigned labels.

Note:
Assigned labels for a dump are deleted when you select a new dump.
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To access the Labels screen, follow this step:

» Select the Labels action bar option or type LABELS. The Labels pull-down screen,
shown in Figure 46, displays.

Figure46 < LabelsPull-down Screen

AEG-EHartQuest 7.0.80 TE0
File Filter List Details Labels Haps Toggles Help
CoHHand === t Labels
VIEW 1-—--- Active progran © | ghendsummary | —mmmmmmmmm———-
Abnd-Lnk MES-DZA - Prograd Le cond
Of zai pbd
» DOREBETY OOD00000 DFSEIPED | Psw2
BE0GdIA0 BEada0as IG2CFCC Caresty
acensles OCEEYOES HUDLIE
OORE3IZE0 00000000 HUDLIE
DOOSEPEE OOO0A000 DFEFLETE
OORSEP4E OREAA0AE CEEEINIT
OOFCCELD DREOE08E DFSECO00
OONSEE22 DREOE00E DFEPCCI0
DEEATFAE DRagaaaa DFsRRCOE
-- PF3I=End 7r3=3croll --—---- =
--— CLEAR=EMit 1=Help 3I=End 7-3=%croll
Fosition cursor at required label and press <enter:

Note:
If you have not assigned any label, a message to this effect displays.

To assign a label

1  Accessthe screen to which you want to assign the label.

2  TypeSET label or S label, where label isaname from 1 to 30 charactersin
length. The first character must be an alphabetic character (A through Z), but the

remaining can be any keyboard characters, including imbedded blanks.

3 Press Enter to save the label.
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These are some examples of valid and invalid labels:

L abel Status
MY AREA valid
MYAREA 2 valid
AN AREA OF STORAGE valid
A(STOR1) Valid
ACB#1 vdid
&MYLAB Not valid (does not begin with an a phabetic
character)

To redisplay a labeled screen
1  Select Labelsonthe action bar or type LOCATE label (or L 1abel).

2  Tabtothedesired label and press Enter. This redisplays the screen associated with
the selected label. Use the Up and Down keys to scroll through the listed |abels.

Note:
Y ou can reassign any label to a new screen at any time by reissuing the SET command.
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The Maps Action Bar Option

The Maps action bar option displays the Map Selection Menu pull-down screen shown in
Figure 47. This screen lists al the DSECTs and other storage area layouts that are
availablefor usein thisdump. Thisalowsyou to select alayout or map to overlay on any
storage area. As aresult, the current area displays overlaid with the requested field
names. The Maps pull-down list can also be displayed using the MAPSEL command. See
"The Mapped Display" on page 85 for more information on mapped storage displays and
the use of this action bar option.

Figure47+« Map Selection Menu Pull-down Screen

AZG-ERartQuest v.0.0 T30

File Filter List Details Labels Haps Toggles Help
Connand ===3 Hmmmmmm Aap Zelection Heny -------

UIEN 1----- core display of the TGT | Db2progt | —————-
Address  0Offset HedadeciHal DfhcoHHares

Ofheiblk
BO0EVETS DO01dE  OODO0000 DOO0E000 B Mks-db2progl
BODATESS 000158 OOD00000 DO000000 B C=aopfl
ADDATEPS O001G68 QO009000 DO090092 ¥ | Dbpch
ADDATEAS OO017A  OO000008 AO008080 8 | DbpchH
ODDATEES D00150 Q0000000 DO0909000 0 | Dfhabnd
Dfhczads
Ofheiblk
Dfheicds
Dfheisd=s
Dfhldchk=s
Dfhszads
Dfhtcads
Ofhtcady
Dfhtctrs

-- PFI=End 7 &=Ecrall ------ —H

-—= CLERR=EXit 1=Help 3Z=End 7-&=Zcroll d=Roll
Position cursor at required Hap and press {enter’

The Toggles Action Bar Option

The Toggles option provides a set of simple switches. The switches specific to the Source
or Mapped displays are discussed in "The Source Display" on page 73 and "The Mapped
Display" on page 85.
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To access the toggle options, follow this step:

» Select the Togglesaction bar option or type TOGGLES. The Toggles pull-down screen,
shown in Figure 48, displays.

Figure48 e« Toggles Pull-down Screen

AZE-SHartOuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help

CoHHand === Toggles
VIEW 1-----— Core display of the TGET for pr | Disable action bar tabs
Address 0Offset He:adecinal Zat zooW Hode to 2d bit

Di=able assocC data display
AODATEYS G0aide  AOODO0aE COEO0E000 QOOa0ae | Disable field data display

A00ATESS D0al5a Ewitch all data =settings
B0DATESS 00al60 Ehow data in hes

BDDATSAS Daal7a "CORE" display when ZooHing
a0DeTSES a00lsa *-—  PFI=End

--— CLEAR=EMit 1=Help 3I=End 7-3=%croll d=Roll
Fosition cursor at iten required and press <enter>

These are the toggle options:

Disableaction  Switches the action bar tabs on and off. Select this option or use the
bar tabs ABAR command to change the setting.

Set ZOOM Switchesthe ZOOM modeto 24 bit. By default, SmartQuest treats all

modeto 24 bit  addresses as 31 bit when using the ZOOM feature (point-and-shoot).
To switchthe ZOOM modeto 24 bit, or back to 31 bit, usethe MODE
command or select the appropriate entry from the Toggles pull-down
menu.

Disable assoc Disables the Associated Data window. By default, if afailing

data display statement has associated data, an Associated Datawindow displaysat
the bottom of the screen when the abending program's source is
displayed. Associated data describes the field names that are
referenced by the failing statement and shows their contents at the
time of error. Select thistoggle, or usethe ADATA command to turn
this feature on and off.

Disablefield Reverses the current setting if the associated data and the field data

data display toggle. It turns both off, both on, or reverses the settings if oneis
currently off and the other on. Y ou can also usethe DATA command
to switch settings.
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Changedl data Switchesthe associated data and the field data on and off. Note: This

settings togglereversesthe current setting of the associated datatoggle switch
and the field data toggle switch. It turns both off, both on, or reverses
the settingsif one is currently off and the other on. Y ou can also use
the DATA command to switch settings.

Show al datain Displaysfield data values and associated data values in hex. By

hex default, these values are shown in character or numeric format when
possible. When the data type restricts this or when the data contains
non-character or non-numeric valuesit isshownin hexadecimal. This
toggleforces al datavaluesto be shown in hex. Y ou can also use the
HEX command.

CORE display  ForcesaCore display, with hexadecimal on the left and character on

when zooming  theright. By default, SmartQuest displays information appropriate to
the storage you have selected when you ZOOM on an address. For
example, if the addressisin program storage, SmartQuest displays
your source (if available) or a Disassembly display (if no sourceis
available). For control blocks and acquired storage, SmartQuest
displays a Mapped display (if the necessary source file information
exists).

Use the CORE command to switch any current storage or Source
display to aCORE typedisplay. Usethe ZFORMAT toggle command
or select this option on the Toggle pull-down menu to force every
ZOOM to show a Core display.

The Help Action Bar Option

The Help Menu pull-down screen provides several types of help. Y ou can chooseto view
a specific help topic, general help information, PF key settings, or the command
summary.
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To access the online help

1  UsetheHelp action bar option or type HELPMENU. The Help Menu pull-down
screen, shown in Figure 49, displays.

Figure49« Help Menu Pull-down Screen

AZE-SHartOuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
*

CoHdand ===  #e——————————— Help Heny -—————-——————-- —k
UIEW 1-———- Core display of the T General Product Information.
Address  Offset HesadecimHal Uzsing the AcCtion Bar.

Using the File pull-down screen.
B00ATETE ao0lde  DO000008 B000ead | Using the Filter pull-down Screen.
A0DATESS 000158 A0a000ad ad0aaad | Using the List pull-down screen.
BDDATSSE AOOLE0  AO000000 DO0000aE0 Using the DuHp Details Henu.
ODDATSAS AOALTE  AO000000 DO0000aE0 Using the Labels pull-down screen.
G0DOTSES AO0LSE  DO000008 @0000880 | Uzing the Help pull-down Henu.
Using the Haps pull-down sScreen.
Using the Taggles pull-down screen.
Using the Uiews.

Using the PF Keus,

Using the Z200H Feature.

CoHHands Quick Reference.
controlling the Uiews.

Mavigation coMnands.

controlling Display Fornat.
Dizplaving pull-down sScreens.

== PFI=End 7-3=8Croll —-==---==-==---s =
--- CLEAR=EHit 1=Help 3I=End 7-3=5croll  d=Roll
Fosition cursor at help required and press <enter>

2 Scroll the menu using the Up and Down PF keys and select the desired topic by
positioning the cursor and pressing Enter. Figure 50 is an example of the General
Product Information help.

Figure50« Help - General Product Information Screen

AZG-FRartQuest 7.0.0 T30
File Filter List Details Labels Haps Toggles Help
CoHHand ===} _
UIEM 1----- =tttk HELP #ebtek— Genetr-al Product Infornation.

AEG-EHartQuest iz a powerful vet easy-to-use tool for analyzing Batch ab
IHZ online abends, and CICE transaction abends. The pull-down Henus, the
cur-sar selectable fields, and the innovative facilities for rapid naviga
through a dudp Hake this product alWost conHand free.

ASE-EHarTQUest has been specifically designed for ease of use. You will
be able to nake full use of the nany facilities that enable wou to resol
all of wour Batch, IHE online, and CICE Transaction abends. The online h
facilitw, which wou can access by selecting 'Help' on the action bar, or
AZE-ZRartQuest User's Guide provide help in using the product.

These are the nain features of the product:
1. =ouprce level support for- Assenbler, COEOL, and PL-I. AEG-SHartQuest 1

you zee the source code of your abending application prograd with the
failing statenent clearly highlighted and with the contents of all your

--- CLEAR=E®it 3F=End 7V-&=%Croll

If PFn=Help displays at the foot of a screen, you can pressthe HELP key or type
HELP to display the online help text for the screen that you are viewing.
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This chapter describes the types of displays available to analyze SmartQuest dumps and
contains these sections:

The Source Display 73
The Disassembly Display 82
The Mapped Display 85
The Core Display 89

The Source Display

The appropriate source support information for failing programsis held on the
SmartQuest source file or in ASG-SmartTest analyzed programsin the Application
Knowledge Repository (AKR). Thisinformation must accurately reflect the load module
that you are currently running. That is, the source information on file must have been
created by processing the compiled output of the same source that was used to create the
current load module. Failure to ensure that this is the case can lead to misleading
information being displayed.

Note:
AKR source support must be enabled by your systems administrator.
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Post-compile Processor

To produce the necessary source support information, a special program known as the
post-compile processor is provided. Modify your compile JCL decksif you have not
already done so. See "Utilities" on page 91 for more information about using the
post-compile processor.

Note:

See the ASG-SmartQuest Installation Guide for more information about modifying your
compile JCL decks.

Source-level support is provided for these languages:

< COBOL for OS/390 and VM

e COBOL 2Release 3

< COBOL for MVSand VM (also referred to as COBOL/370)

- PL/l Version 2.3.0

- PL/I for MVSand VM (also referred to as PL/I 370)

e  Assembler H

- High-level Assembler

When you use the ZOOM feature on an address that is within program storage,
SmartQuest first determines which program and CSECT this addressisin. It then
examines the source file to see if the necessary information is present for this
program/CSECT combination. If not, it examines the alternate source file if you have
one. When source support information is available, the Source display is shown in

preference to any other display type. The format of the Source display is similar
regardless of the language you are using.
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Figure 51 is an example of a COBOL 2 Source display. The header line shows the name
of the program (the load module name), followed by the CSECT name in brackets. For
COBOL, thisisusually the name you enter on the PROGRAM-ID card and may often be
the same as the load module name.

Figure51« Sample of the Sour ce Display

ASG-EHartouest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k

UIEW 1-——-—- Fource 1ist of the TGT for progrAVCOEZA 2R [HVCOBZA ] -------—-——
0a0al7  PROCEDURE DIMIZION.

naoaLs

aagal®  TEET-PARA.

AA0a2A CALL HEXTPGH.

aaa0zl  TEST-PARA-EXIT.

Aaaaz2 EXIT.

HE0a2E

aaogzd  THE-END.

HEaZS ETOP RUN.

BE0026  TDENTIFICATION DIUIEION.
HEEa27  PROGRAM-ID. HUCOEZAX.

AAOA2E *

a0002%  ENUIRONHENT DIVIZION.

AA0AZA *

000831 DATA DIVIEION.

HEOaZZ *

BE003E  WORKING-ITORAGE ZECTION.

aaoaId a1 WE-FIELDE. Adr= ACYDOETE Data=

=== CLERAR=EHit 1=Help 3I=End 7-<3=ZCroll

Source Display Features

These are the main features of the Source display:

Thefailing or CALLing statement is clearly highlighted.

Thefields referenced by the failing or CALLing statement are shown in the
Associated Data window at the foot of the screen. Each field is shown with its
address and contents at the time of abend.

Each line of source code that defines a field displays showing the address and
contents of the first field defined on theline. Thisis known asthe field data value
feature.

The Up and Down PF keys are enabled to allow you to examine the contents of
other fields that are not shown in the associated data window.

Where afield islarge and its compl ete contents cannot be shown on this screen, you
can position the cursor on its address and press Enter. This displays a normal dump
format display (Core display) starting at thisfield’s address. Y ou are able to view
the entire field contents. Press PF3 to return to the Source display.

Note:
Y ou can ZOOM to any address that might be contained in afield.
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Source Display Commands

These Source display commands are common to all languages.

ASSEM

Switches from a Source display to a Disassembly display.

CORE

Switches from a Source display to a Core display (standard dump
format display - hexadecimal on the left, character on the right).

ADATA

Turns on/off the associated datawindow. Y ou can also use the Toggles
pull-down menu.

FDATA

Turns on/off the field data values. Y ou can aso use the Toggles
pull-down menu.

DATA

Changes both the current ADATA and FDATA switch settings. So it
either turns both off, turns both on, or reverses the settingsif oneis
currently off and the other on. Y ou can also use the Toggles pull-down
menul.

HEX

Forces all data values to be shown in hexadecimal. Use it again to
return to default display state(i.e., turn HEX off). Y ou can also usethe
Toggles pull-down menu.

L nnnnnn

LOCATEs source line number nnnnnn and displays this asthe first
line of the screen (where nnnnnn isfrom 1 to the highest line number
in the current program).

LEFT/RIGHT

Shiftsthe Source display left or right. These commands have no effect
on a132-column display, asthe whole sourceline displaysin thiscase.
On 80-column screens, the Source display is automatically displayed
right shifted, so that the first column shown is the one you would see
inaTSO/ISPF EDIT session. To view the compiler output added on
theleft, usethe LEFT command. To return to the normal view use the
RIGHT command.

Returns to the failing/linking statement after scrolling your Source
display.
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FIND Finds hexadecimal or character strings within your source text. This
does not include field addresses and contents nor any of the
information shown in the associated data window. The FIND
command syntax follows these normal conventions:

FIND string FIRST start-col end-col
F “‘quoted string” LAST
X”hex string’ PREV
NEXT
Note:

Because the source is automatically right shifted, the first column
shown is not column 1. The column numbers are as they would be if
you were doing afind using SDSF, or other online SY SOUT dataset
browse product, less 1, since SmartQuest does not have the print
control characters at the start of each line.

RFIND Repeats the last FIND command.

COBOL Source Support Considerations

All COBOL field types are included in the associated data window, when necessary, and
have field data values displayed as shown in Figure 52. This can include implicitly
defined indexes (index fields defined using the INDEX BY clause).

Figure52« Sample COBOL 2 Source Display

ASG-SHartguest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===X

UIEW 1--———- Fource list of prograd HUCOEZA [HUCOEZA ]

goge3d 01 WE-FIELDZ. Adr= ACYOEETE Data=
LIRS 83 NE-CNTR-PACKED PIC Adr= OCHOEETD Hed = di
LTS 83 FILLER REDEFINE: WE-CNTR- Adr= BC®RAETD Data=
AEaa37 05  ME-CHTR Adr-= ACHOAETE Data=
BOOETE *

B0083% PROCEOURE DIVISION.

Dag0da

gogadl  TEST-PARA.

LTI

LILTTLIE R HOVE ZPACEE TO WE-CHNTR.

—Abnd- ADD 1 TO ME-CHNTR-PACKED.

Aaa0dS

B00846  TEST-PARA-EXIT.

BO0a4 7

LTI B

gagads  THE-END.
—————————— Az=0ciated data for FAILING statewent
Ead--* NE-CNTR-PACKED Adr= DCHMEETD Hex = dA
=== CLERR=EXit 1=Help 3I=End 7v-5=icroll

77



ASG-SmartQuest User’s Guide

Support for these COBOL featuresis also provided:
<  Nested routines

- Statically linked routines

- Dynamically CALLed routines

- Multi-CSECT programs

- Mixed case programs

Coding Restrictions

The only restriction in a COBOL program isthat it cannot contain any COPY
SUPPRESS statements. All COBOL statements, including fully expanded copybooks,
must be included in the compiler output. Failure to comply with this produces a severe
error return code from the post-compile processor and unpredictable results when
attempting to display source.

PL/l Source Support Considerations

PL/I has aliberal language syntax. It may even compensate for any missing semi-colons
(;) or close parentheses () ). PL/I can contain non-declared fields, declared fields without
adeclared data type, structures defined using the LIKE keyword, and other features that
make the provision of source-level support, at times, complex. SmartQuest handles most
of these without problems.

Coding Restrictions
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=  Sincethe Source display showsfield data values for the first field declared on a
single line, you should avoid having multiple variables declared on the same line.
Multiple variable lines do not stop the product from functioning correctly, but
should be avoided to maximize the benefits of the data value feature. The contents
of all variables can be viewed by alternative meansif necessary.

=  Omitting trailing close parentheses () ) or semi-colons (;) may be acceptable to the
compiler, but in some rare instances this may produce unpredictable errorsin the
Source display feature. Examine your compiler output listing for such errors and
correct them to prevent Source display problems.

- A few PL/I field types (BUILTIN, EXTERNAL ENTRY, AREA, and some other
seldom-used types) are not supported. This does not mean that source support
cannot be provided for programs containing such variables, but these variables are
not shown with data values and do not appear in the associated data window.

<  Controlled variables are not supported.

=  Theuse of %NOPRINT is not allowed. If you do suppress any compiler output
using the %NOPRINT compiler command, then the post-compile processor gives a
severe error return code and the source support feature gives unpredictable results.
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Supported Coding Procedures

Support isincluded for multiple internal procedures, procedures statically linked
and CALLed and dynamically FETCHed and CALLed, and the use of BEGIN
blocks.

These field types are fully supported:
—  Structures

—  Character

— Pointer

—  Fixed Decimal
—  Fixed Binary
—  Float Decimal
— Float Binary
—  Picture

—  Graphic

— Bit

— Entry

Automatic fields, static fields, external fields, defined fields, and parameters are
supported.

Support is aso provided for both based fields and based-on-address fields. The
based field level cannot exceed 5. Fields that are based on other based fields are
supported, but only to the fifth base level.
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A sample PL/I Source display is shown in Figure 53. Aswith COBOL, the header line
shows the name of the program (the load module name) followed by the CSECT namein
brackets. The CSECT name for PL/I is aways derived from the main procedure name.

Figure53« Sample PL/l Source Display

REG-FHartQuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
VIEW 1-—--—- Zource 1ist of prograd HUPLIF  [#HUPL3F1]
HO002E UCHARFLD = HY_ARRATIL];
geaeg2d [IZE]DCL FRED CHAR(S): Adr= aea3dds0 HeHd = DEEOODE00E
HA002S BERACKET _TEST = ' AEBC[MYZ '}
D00026 BRACKET _TEST = ' RBCIHYE '}
000027 FLOL:IDCL BILL CHAR(S): Adr= 08834455 Hed = DOAA0EEO0E
BRD0Z2E EEGIN: Adr= a08344ES Hex = §42%5
HR0EZ2H DCL 1 TEST_STRUCTURZ, Adr= Bo83455% Data= AAAAEEEBE
Ll 25 TEST_STR_FIELD1, Adr= BB834d555 Data= AAAAEBEE
Ha0e31 35 TERT_ETR_ZUBFLDL Adr= 80834555 Data= AAAA
LTIl 35 TERT_ETR_EUBFLDZ2 Adr= @083453C Data= EBEBEE
HEERIE TEET _STRUCTURZ.TEET_STR_FIELDL =
aaaa3d TEST _STRUCTUR.TEST_STR_FIELD1 ;
000035 OCL ¥ DEC FIXED [15) INWIT (18 Adr= 00034550 Data= +18
000036 OCL ¥ DEC FINED [15) INWIT (@) Adr= @003457E Data= +8
HR0a3T DL 2 DEC FIMED [15] IMIT [©) Adr= @9034570 Data= +@
—Abnd— SIGNAL ERROR;
Ll END;
Haaada END HUPL3F R
--— CLEAR=EXit 1=Help 3I=End 7-5=%crall

Assembler Source Support Considerations

All Assembler fields are fully supported. Those defined in DSECTs and CSECTs are
shown with field data values. The associated data window for Assembler does not show
the field names asit does for COBOL and PL/I. It only shows operand 1 and operand 2,
where appropriate, with their address and contents as shown in Figure 54.

Figure54 « Sample Assembler Source Display

AEG-EHartQuest F.0.8 T20
File Filter List Details Labels Haps Toggles Help
CoWHand ===k _
UIEM 1---——- Fource list of prograd TE4EIT  [TE4BIT ]
LT EALR 12,8
LIliL1L s UEING #,12
Q00023 LR 15,13
00024 LA 13,3AUE
LIl e BT 13,5(15)
LIl el AT 15,4[13)
LILILTL e ABEND dag8l ,0UHF RR TYPE 3 [GEMERATED SUC 13]
LI e 0 BH Adr= ac%0aFld Data= +1665E
HEER2S + LA 1,488l LOAD PRRAHETER REG 1
aaaala + LA a,1z&(a,0] DUHP-:TEP-DUHPOPT £-REASON BESEAPLF
Q00031 + ILL @L2d4(A) SHIFT T HIGH ORDER
00032 + 0R 1,8 OR IN WITH COHPCODE
—Abnd- + Al 13 LINE TO RBEND ROUTIME
LI RES ECTR Ri,B RR TYPE 1
LTl CH Rl,=H'®’ Re TYPE
LT Y EE EKIPTE EXTENDED HWEHOMIC ERAMCH TYPE
BRI TE FLAGL = TYPE
aaaalis  SKIPTE 15 aH Adr= ACPAaF32 Data= -26606
--- CLEAR=E®it 1=Help 3=End F-&=%croll
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This simplification for Assembler reduces the post-compile processing time. The
operands are always in sequence in the statement.

Coding Restrictions

Avoid the use of PRINT OFF and PRINT NOGEN in Assembler, although when used
within DSECTstheir impact is limited. When they are detected, the post-compile
processor gives areturn code 4. A PRINT OFF or aPRINT NOGEN that hides
executable instructions is more serious and should be removed.

Base Registers

When showing data values for fieldsin DSECTS, the base register used to calculate the
address and contents is taken from the very first USING statement that the post-compile
processor encountersfor the DSECT. In your program, you can DROP a base register and
issue anew USING with adifferent base register. In addition, your program may make
use of the high-level Assembler-dependent USING and labeled USING features.
SmartQuest, therefore, allows you to vary the base register used in the display. For
example, Figure 55 shows a CICS DSECT named DFHEISTG.

Figure55+ Source Display of DSECTs

AEG-EMartQuest 7.0.0 T30
File Filter List Details Labels Haps Toggles Help
CoHHand ===

UIEW 1---—--- Eource list of prograd TESTPROG[TESTRROG)

HEO23T +

HAB2IE EXEC INTERFACE DVNAMIC 2TORAGE #*
HEAZIT +

O0023E +OFHEIETG DEECT EEC INTERFACE ETORAGE BEBACS1A
HAB2IS + UZING #*,DFHEIPLR ESTAELI®H ADDREZZABILITY BEEACE1A
Oaazdn +0OFHEIZA D2 1&F R13 Adr= GEE0RGFA Data= -d473350362

ag02dl +DFHEILME DF F R13 Adr= OEEDD1d42 Data= +1077e5257E0
BEa242 +0OFHEINAE D2 F R1Z Adr= BEE0D14E Data= +1077R52E7E
Oaazd3 +0OFHEIRZE DE F R13 Adr= BEE0D14A Data= +1490072745
a002dd +DFHEIRLT DF F R13 Adr= OEEDOI4E Data= +45d412ivi2
Oaa24% +0OFHEIREL DE F R1Z Adr= BEE0DLSZ Data= -1053293073
Oaazdé +0OFHEIEBR D2 F R13 Adr= BEE0RLSE Data= -1729310705
a0024y +DFHEICAP DF F R1% Adr= DEEDOLSA Data= +134056656
OEa2dE +OFHEIUOR DE H R1Z Adr= BEEDOLSE Data= +8@

gaazde +0OFHEIREZ D2 H R13 Adr= BEE0OLGE Data= +3505
a9025a +DFHEIFL DF 13F R13 Adr= OEEDD162 Data= +23I592960
Oaa2s1 + nE 51F R1Z Rdr= BEEDOLPE Data= 7 *Not in duWpk
BEAZSE +E AND IN WAZ 0N, FOR EMEC CICE ALEO0

--- CLEAR=Exit 1=Help 3I=End ?-&=&croll

Y ou can see that DFHEISTG has a default base register of R13 and so the addresses and
field contents for this DSECT have been calculated using the content of R13 as a base. If
this DSECT were alabeled DSECT and also addressed by R3, you could view the
DSECT field contents using R3 as the base by typing this command:

USING DFHEISTG,R3
This syntax is how you would code asimple basic USING statement in your Assembler

program. The message New using accepted isshown at the bottom left of the
screen as confirmation of the change.
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The Disassembly Display

When source support is not available for a particular program, a Disassembly display is
shown for all program storage, as shown in Figure 56.

Figure 56 « Disassembly Display

AZG-ZMartiuest 7.0.0 T&0
File Filter List Details Labels Haps Toggles Help

CoHHand === -

UIEW 1-—---- Oizaszedbly of prograd TESTPROG(TESTRROG)

Address  Offzet Instructions Disassenbly Chars
AEEACCSE @01dE  dild DOGSE LA i 16d(8,13)
AEEACCER OOALS2 diER C17& LA 1d,376(0,12) . .H.
AEEACCES OOALSE diFA C1&7 LA 15,391(0,12) .OAg
AEEACCEA OOALSA  diff DeGd LA 6,100(8,13)
AEEOCCEE OOALEE  JOED 1080 2T 14,8,8(1)
AEEACCTZ AOALEZ  J6E0 1005 oI &(1),128 O
OEEACCTE DOOLEE SEF0 C17d L 15,372(0,12) .OA.
WEEOCCTA -Abnd-  OSEF BALR 14,15 i
QEEOCCTC OOOLEC 4110 DOGS LA 1,104(@,13)
AEEACCED OOALTE diER ©3E LA dd,3ea(0,12) . eH.
AEEACCEL OOALTAd  SOED 10800 i dd,000,1) B
QEEACCES OOALTE 96&0 1000 ol a[1),123 o...
AEERCCEC OOALTC SEF C17d L 15,372(0,12) JOA.
AEEACCTR AOALE0  ASEF BALR 1d,15 .
AEEOCCHZ DOAL1E2 D000 OC  AL2[00000)

QEEOCCHD DOO1Ed D000 OC  AL2[00000)

--- CLEARSEMit 1=Help 3=End 7-5=%crall

Disassembly Display Features
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These are the main features of the Disassembly display:
<  Thefailing or linking instruction is clearly highlighted.

=  Themachine instruction portion may contain addresses, and you can use any byte
of this portion of the display asthe start of a4-byte addressfor ZOOMing. To zoom
to an address, position the cursor on the address and press Enter.

<  Theposition of each CSECT is shown by the CSECT name appearing on the
right-hand side of the screen. Thisistrue even if thereis no source support
information for this program.

= Ability to scroll using accurate full page scrolling or by partial page using cursor
position.
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-  Ability to modify theinitial starting offset using these commands:

FXXXXXX Adds the hexadecimal offset xxxxxXx to the current start offset.
XXXXXX Subtracts the hexadecimal offset xxxxxx from the current offset.
EXXXXXX Displays from the hexadecimal offset XXXXxX.

In these commands, xxxxxX is a hexadecimal value between 0 and FFFFFF.

=  Ability to switch to a Source display (if source support is available) by typing
SOURCE, or to a standard dump view by typing CORE.

Diagnosing Source and Object Misalignment

The Disassembly display is also useful for diagnosing problems caused by a source and
object misalignment. When you choose a Disassembly display for a program that has
source information on the SmartQuest source file, additional information displaysin the
right column of the screen. For COBOL programs, thisis the verb for each statement, as
shown in Figure 57.

Figure 57 « Disassembly Display With COBOL Verbs

AEG-FHartguest v.0.8 TE0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
VIEW 1-—-—— Oisasserbly of prograd HVCOB2A [HUCOBZA ]
Rddress  Offset Instructions Disassedbly Chars
HCPNE%EA BOa35A D203 DOEC AEaSs HUC 236(d,13],5(10) Kauuua HUCOE2AR
ACPEAPTE 0aa3ra 150 D154 TH Ida[13],125 JeTs
OCHO0ATE BOO39d  SEEE COOd L 11,4(8,12]
OCHONATE BOO3SE 4TE0 BL2E B2 302(0,11)
BCROARTC 003eC  SE20 DASC L 2,02(0,13) naat
ACPOA%50 BOAIAE  SSFE 21CC L 15,460(0,2] e
ACP0a%5d 0003Ad  d118 ALST LA 1,391 (0,18) -]
ACP0A%ES BOOIAS  ASEF EALR 14,15 .
HCPRHEPSA BOOZAA  Pe58 D154 a1 Jda(13),125 dut.
ACPaA%SE OOOIAE  PEdD D154 aI Ida[13],6d a T.
OCHONA82 MOOZE2  P24E PO25 HUI  d@(9),6d K ..  HOUE
OCH009%6 —Abnd- FADED 9028 AGMA AP dal1,9],7d4(1,18) ... 4 ADD
ACRRAReC DOOIEC  FSO0O 90256 9025 ZAP i1, 9],48(1,%] Sannusn
ACPOA%AZ BOA3CZ2 dFFE B1dA B 33a(a,11] Wt GOEACK
ACPOAPAE BOO3Ce Pd7F D154 NI Jde[13],127 H'T.
ACPOAPAA BOOICA dFFE E1TE E I6E[0,11] M 1
--— CLEAR=EXHit 1=Help 3=End 7-5=3crall
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For PL/I programs, the statement numbers of each PL/I statement are displayed as shown
in Figure 58.

Figure 58« Disassembly Display With PL/I Statement Numbers

AEG-FHartQuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
UIEW 1--———- Oisassedbly of prograd HUPLIF  [#HUPL3IFL)
Address  Offset Instructions "Diassedbly Char-s
OCYE0EAE BwA1ZE  av7as NOFR S a
ACP0AEER Baaldd 4570 IOza LH TA32(8,3] - ETHEaO1A
ACHEOEEG @EE1dd 4070 DACA ETH 7 192(0,13) s
ACHOOEES @AE145 D204 DACZ DOFD HUC  194(5,13),240[13) K. .B.8
OCY00EEE @0aldE D2E% Dloe J0S1 HUC 265[18,13),51(3) FaTuwa ETHOOOLZ
ACY00ECHd @0al5d  DZad Diee 3056 HUOC 2E5(18,13),91(3) E.T. ¥ ETHOOOLS
OCY00ECA @malsSA 1610 LR 1,13 a ETHROALS
OCYOOECC @malsc 155D LR 52,13 .
OCYERECE @malSE  SEF0 Zoia L 15,16(8,3] 1
AcH0aED: aaale2  AaSEF EALR 14,15 a
ACHEOED BEE16d 1500 LR 0,13 . ETHOBA23
ACHEOEDE GOE16E 5300 DAl L 13,4(80,13) -
OCY00EDA @oaleR  SEEQ Doac L 1d,12(0,13) nean
ACY00EDE @EAl6E  w&2C DO1C LH 2,12,25(13) Tuus
OCY00EEZ? BmAl7Z2  A51E EALR 1,14 a
OCY00EEd @0alvd  SOEC DOAC ETH 1d,12,12(13) - ETHROALS
--- CLEAR=EXit 1=Help 3F=End ?-5=icroll

For Assembler programs, the field labels are displayed as shown in Figure 59.

Figure59 ¢ Disassembly Display with Assembler Field Labels

AZE-ERartuest 7.0.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHRand ===} _
VIEW 1-—-—— Disasserbly of prograd TE4EIT  [TEAEIT )
Address  0Offset Instructions Disassewbly Chars
HCPHEFEE Ba080E  PREC DOac =TH 1d,12,12(13) - TEAEIT
AceaaFed @ad0ad  ASCa EALR 12,8 .
ACEaaF0E aaga0s  15FD LR 15,13 e
OCHOEFOS Qa000s d1DD CA%E LA 13,150(08,12) auall
ACROAFOC Da00ac  SODF a0os T 13,5(15,0) frann
AC*OAF1E Badala  SOFD a00d T 15,4(13,8] frann
ACP0AF1d gad0lid d1i18 BFAL LA 14001 (@8] -
ACPOAFLS Ba00ls diga a0sa LA B,125(0,0)]
HCPHAFIC Bagaic  S908 001s =LL B,0,2d (0]
ACPHAF2a gadaza 1618 akr 1,8 .
aCPaaF22 -Abnd- BAAD UG 13 e
OCP0aF2d Qa0a2d asla ECTR 1,8 e
ACPOAF 26 DO00Z26 4910 COFE CH 1,246(0,12] ]
ACPOAF2A BO0EZA 4730 CO2C BE dd[B,12] s
ACPOAF2E Bad0z2E 9308 CODE TE 222(12] laus
ACPNAFIZ Ba0a32 9512 COER LH 1,2,234(12) JQuus EKIPTE
--— CLEAR=EXit 1=Help 3=End 7?-5=3crall
Top of data

Y ou can compare the information shown in the right column with your compiler output to
ensure that no source and object mismatch has occurred.
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3 Analyzing Dumps

The Mapped Display

When you select an area of non-program storage, either explicitly or by ZOOMing,
SmartQuest attempts to automatically overlay the storage area with its field names. For
most CICS and MV S control blocks, the action is successful.

For example, selecting the EXEC INTERFACE BLOCK (EIB) displays a screen similar
to Figure 60.

Figure 60« Mapped Display Screen

AEG-FHartQuest 7.0.80 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===k _
VIEM 1--———- Flap display of the EIE
Field naHe Length Type  Address Offset  Contents
EIETIHE suuennsnnsnnnnnnnnnnnn 4 Packed 90200008 EEO000 +42339
EIEDATE csuuennsnnsnnnnnnnnnnnn 4 Packed 98200004 aaa0d 1a2259
EIBTRHID e ae s smssnnmnnmnnnnn 4 Char  @6200005 099085  IQLK
EIBTAZKNa e ae e s smnsnnmnnmnnnnn 4 Packed G8200000C 900  +265
EIETRHIDasassnsnnsnnnnnnnnnnnn 4 Char HAZOO0ED Da0010 Laar
EIBREI sunnnnnnnnnnnnnnnnnnnn 2 Binary 002000Ed a0001d ti
EIBCPOEN s s s nsnnsnnsnnnnnnnnn 2 Binary 00Z000EG a00016 t1&
EIEBCALEM . s cennennsansnnnnnnnnn 2 Binary DO2000ES a0001S +50
EIEBAID . cusuannnnnnunnnnnnnnnnn 1 Char HEZHEOEA BRa01A '
EIEFNaesnsnennsnnsnnnnnannnnnn 2 Char aa20a0EE aaa0lE X GEQ2
EIBRCODE s an s nssmssnnmnnnnnnnn & Char  @E2000ED E90010 X GOO00A00HH0E
EIBDFwusmunnnnsnmssnnnnnnnnnnn & Char  0E2000FF 099023 ¥ O00000004000000E
EIEREQIDauusnnsnnsnnnnnnnnnnnn & Char HAZO0OFE D000ZE W O00000000 00000080
EIERERCEssunnnsnnsnnnnnnnnnnnn & Char HAZOE183 DOA033 TESTPROG
EIEEYHC s sanennannsnnnnnannnnnn 1 Char HAZOO10E S0003E X 00
EIBFREE . sucesnsnnsannnnnnnnnnn 1 Char HAZEO1AC DOE03IC K 00
--— CLEAR=EXit 1=Help 3=End 7-5=icroll

If you have switched from a Mapped display to a Core display, you can redisplay the area
with mapping by using the MAP command without operands. The last map name used is
remembered.

Mapped Display Features

These are the main features of the Mapped display:

- Thefield name, length, data-type, address, offset within the area, and contents at the
time of the abend are given for each field.

= Ability to scroll using accurate full page scrolling or partial page using cursor
position.

-  Ability to ZOOM on the field address to display adump format screen starting from
that field address. This feature allows you to view the entire contents of fields that
aretoo large to display completely on the Mapped display. Press PF3 to return to
the Mapped display. Y ou can also ZOOM on the field contents if they contain an
address.
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- Use of the FIND command to quickly find any field. Thisisthe format of the FIND

command:
FIND string FIRST
“quoted string’ LAST
X”hex string”’ PREV
NEXT

This command locates label s that begin with the characters specified in string.
«  Ability to switch to a Core display using the CORE command.

- For Assembler DSECTSs, any EQUate statements are included in the Mapped
display. Figure 61 is an example of the User TCB.

Figure6le Assembler Map Display

AZG-ZHAFTOUEsT T.0.8 TS0
File Filter List Details Labels Haps Toggles Help
ConMand === -
UIEW 1------ Flap display of the TCE
Field naHe LEI'IQTI"I THFIE Address  Offset Contents
TCEREF. . 4 Hex  OOSFEOFD AODEAD X OOSFDSEN
4 Hex  OOEFEAFD AOOEAL X OOAAOEAE
1 Hex  OBGSFEOFD AO0ERd X 00
T Hex  DOGFEOFS AAOOAS X ADOAAO
4 Hex  OOGFEOFE QODONE X DOSEF29E
4 Hed  OOEFEOFC AODOAC X DOEC1O00
4 Hed  DOSFELAD QADELA ¥ SOOROFAL
1 Hex  OOSFELAD Ad0Eia X &0
T Hex  OOEFELAL AOOE11 X OOOFAL
4 Hex  OOEFELAD AO0E1d X OOAAOEAE
1 Hex  OBSFELAd AODEL4 X 00
T Hex  DOGFELAS AAOELE X ADOAOD
4 Hex  OOEFELAE QODO1E X FFEOCATS
1 Hed  DOEFELAS 0ODELE
I Hed  DOSFELAG OOOO1? ¥ GDCATSE
1 Hex  OOEFELAC AE0EiC H &0
--- CLEAR=Exit 1=Help 3=End 7-&=3croll




3 Analyzing Dumps

Automatic Mapping

When source-level support is available for the abending program, other areas are
automatically mapped. These include the Assembler DFHEISTG, the COBOL Working
Storage, the PL/I procedure DSA, and COBOL COMMAREA. Figure 62 illustrates this
with an example of the working storage for a COBOL program.

Figure62« Map Display for COBOL Working Storage

ASG-EHartguest 7.8.8 TS0
File Filter List Details Labels Haps Toggles Help
CoHHand ===

UIEW 1----—- Fap display of the wks for pgH HUCOBZA [HUCOB2A 1 ---—--—-------—
Field nawWe LEI'II.]TFI THFIE Address  Offzet Contents
MERTPGH . a e eecwnemnemmannnnss & Char  OC9OOEE DADORD  HUCOB2AN
BTE=HAHE e v - s v e e wwemnemmnnnnnes I0 Char  ACHOOESD AOOAAE  012TdSETEH0L2345
UE—FTELDS e cnvnennrnnsmnnnnnnen 1 Group OCPOOETE AADO2E

UE—CHTR=PACKED - v e s s emmannnnes 1 Comp-3 OCPOOETE AADO2E X 40

FILLER s susasssasnsassnnsnsnnss 1 Group OCPO0ETE BADO2E

ME—CNTR e s ansnnsnsassnnnnsnnss 1 Char  BCYROETA RADO2E

=== CLERR=EHit 1=Help 3I=End ?~&=iCroll

Manual Mapping

Areas that are not automatically mapped, such asthe TWA, CWA, TCTUA, or
GETMAINed storage areas, can often be manually mapped. Use the MAP command on
any Core display or Disassembly display to assign amap. Thisisthe syntax of this
command:

MAP mapname

The mapname you specify must be avalid name from the map list for the abending
program, or from the general map list. If you do not know the map namesthat arein these
lists, use the Map Selection Menu pull-down screen to display alist of these names. Y ou
can access this screen by selecting the Maps action bar option or by typing MAPSEL.
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Figure 63 is an example of the Map Selection Menu.

Figure 63« Map Selection Menu Pull-down Screen

AZG-ZMartiuest 7.0.90 TS0
File Filter List Details Labels Haps Toggles Help
*

Connand === m————— Hap Zelection Henu ----—--
VIEW 1-—--- Core dizplay of the TGT Dezprogt. | ===
Address  Offset Hedadeciwnal Of hCorMarea
Ofheiblk
ADDATETE O001ldE  DOOE9000 DOR00008 8 | Wks-db2progl
BODATVEES 000158 DO000000 DOE0a0a8 g Czaopfl
BODATESS DO016E  DO0D0000 DOE000a8 g Dbpchb
ADDATEAS O001TE  QO09000 S99000808 @ | DbpchbH
ADDATSES D00150 QO009000 DORE0098 @ | Dfhabnd
Dfhczads
Ofheiblk
DOfheicds
Dfhei=sds
Ofhldchs=s
Ofhssads
Dfhtcads
Of htcady
Ofhtctrs
== PFI=End 7-&=%croll =----- ~%

-—= CLEAR=Exit 1=Help 3=End 7<&=3Zcroll d4=Roll
Position cursor at required map and press <entark

Use the Up and Down PF keys to scroll the Map Selection Menu pull-down screen. Y ou
can select amap by positioning the cursor on the map name and pressing Enter.



The Core Display

3 Analyzing Dumps

When you select an area of non-program storage that cannot be automatically mapped

with field names, a Core display is provided. The Core display is a standard dump format
with hexadecimal data on the left and character data on theright. Figure 64 is an example
of aCoredisplay.

Figure 64 « CoreDisplay of a Storage Area

File Filter

CoHHand ===

Address

AC2R020E
ACERAES
ACEa09FS
ACEaDRaS
ACEaBALS
ACEABA2E
ACPABAZS
ACPAOALS
ACRRERTE
AC2EBRES
ACERBATE
ACORBRES
ACEaBRSS
ACPAOARS
ACPAOAES
ACPABACS

offset

EEEEaa
LLILLTER]
LIl L1beda]
LTk
LLILIER)
A0AASA
AOAAER
AOAATA
Pt
EEEEEa
HEEEAD
HEEEER
HEEECa
Aaaana
AOAAER
AOAAFA

--- CLEAR=EHIit

display of the TGT for progran HUCOE2A [HUCOBZA )
Charactear

Hexadeci

aalngoal
LD L]
LD L]
LD L]
EIEIEIEIEIEER
AZA0AAaA

REG=EHartQuest F.0.0 TE0

Hal

a0l Ed2s
DEDaDaaa
DEDaDaaa
DEDaDaaa
HEaDaaE
E1828220

List Details Labels Haps

HEEaaaaa
HEaanana
HEaanana
HEEanana
F2EZCPER
AEadEATS

EBEOaaaaa
BEDa0a0a
BEDa0a0a
HEDa0a0a
HEOZEALS
L Ry g

i

HEa1 ARCE
EEEEaaa2
CRCTEREZ
LD L]
EIEIEIEIEAER

HEBaaaaEa
DRE3CICD
DEDaDaaa
HEDaDaaEa

EZESGEZDE
HEaanana
HEaanana
EEEEEaaa

E4EZd4ada
BEDa0a0a
BEDa0a0a
BRI R0

ACPRaELC

DOE4EI2 S

ACPOATES

1=Help 3I=End F«&=3Croll

2z
Ll L]

Toggles  Help

4=R011

Core Display Features

These are the main features of the Core display:

Ability to ZOOM on the hexadecimal portion of the screen by placing the cursor on
any bytein this portion of the display and pressing Enter. The 4 bytes starting with
the byte at the cursor position are used as a ZOOM address.

Ability to scroll using accurate full page scrolling or by partial page using cursor
position.

Ability to modify the starting offset of the display using these commands:

FXXXXXX

=XXXXXX

=XXXXXX

Adds the hexadecimal offset xxxxxx to the current start offset.

Subtracts the hexadecimal offset xxxxxx from the current offset.

Displays from the hexadecimal offset xxxxxx.

In these commands, xxxxxX is a hexadecimal value between 0 and FFFFFF.

Switches to a Mapped display using the MAP command.
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Disassembles any storage using the ASSEM command.

Converts a Disassembly, Source, or Mapped display to a Core display using the
CORE command.

Core displays are always shown last. That is, they are shown only for non-program
storage that cannot be automatically mapped with field names. To force a Core
display to be shown for all cases, use the ZFORMAT toggle command or use the
Toggles action bar pull-down menu.

A FIND command using conventional syntax is available using this format:

FIND string FIRST
“quoted string” LAST

X”hex string”’ PREV

NEXT

Use RFIND to repeat the last FIND command.



Utilities

This chapter describes the utilities available in SmartQuest and contains these sections:

Using the Snap Dump Facility 92
Printing Offline Dumps 92
Providing Source Support 94
Maintaining and Listing the Source File Contents 97

These offline utilities are availabl e to provide additional functions or to support the online
features.

Utility Member/Job Name - CICS Member/Job Name- MVS
Printing offline dumps VICQJIPRT VISQIPRT
Providing source-level support VICQUPST VICQUPST

(post-compile processor)

Maintaining and listing the VICQUPST VICQUPST
source file contents
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Using the Snap Dump Facility

The VISQSNAP module enables you to code CALLs that produce a dump at the point
where the CALL is made. This enables you to examine a dump before the program
abends.

These are examples of how you can invoke VISQSNAP using COBOL, PL/I, or
Assembler.

- Assembler Static CALL:

L R15,=V(VISQSNAP) Load address of SNAP module
BASSM R14,R15

e  Assembler Dynamic CALL:

LOAD EP=VISQSNAP,ERRET=error route (Load the SNAP module)
LR R15,R0 (Address SNAP module entry point)
BASSM R14,R15

- COBOL Static CALL:

CALL “VISQSNAP~
- COBOL Dynamic CALL:

WORKING-STORAGE SECTION.
77 SNAP-PGM PIC X(8) VALUE”VISQSNAP~

PROCEDURE DIVISION.
CALL SNAP-PGM

- PL/I CALL:

DCL VISQSNAP ENTRY OPTIONS(ASSEMBLER INTER);
CALL VISQSNAP;

Printing Offline Dumps

92

The member VICQJPRT (CICS) or VISQJPRT (MVS), on the SmartQuest JCL library,
contains the JCL job necessary to produce a print of any dump from your SmartQuest
dump file. The JCL job is also shown.

To modify the print job JCL

1  Change or replace the job card with your job card information.



MVS

4 Utilities

2  Change the high-level quaifier of the SmartQuest for MV S dataset names to ones
that reflect your company standards.

3 Change####### to the required dump number. Ensure the DSN for the HSDUMP
DD is complete and correct.

Note:

Y ou can dynamically build and submit this job using the online print submit facility. See
"Online Print Job Submission" on page 52 for more information.

//ASG JOB (), "ASG-SMARTQUEST" ,NOTIFY=&SYSUID
/7%

/7%

/7%
//**********************************************************************
//* ASG, INC. ASG-SMARTQUEST FOR MVS *
//* *
//* MEMBER NAME: VISQJPRT *
//* *
//* DESCRIPTION: DUMP PRINT UTILITY *
//* *
//* INSTRUCTIONS: *
//* *
//* 1. CHECK PARAMETER VALUES IN STATEMENTS BELOW *
//* 2. CHANGE ######### TO THE REQUIRED DUMP NUMBER. ENSURE THE DSN  *
/7% FOR THE MVDUMP DD BELOW IS COMPLETE AND CORRECT. *
//* *
AT ASIHH SIS KKK e KKK * *
1/ SET ASG="ASG"

1/ SET CENTER="VIACENXX"

// SET SYSDA="SYSDA"

// SET SYSOUT="*"

//VISQUPRT EXEC PGM=VISQUPRT,REGION=1M

//STEPLIB DD DISP=SHR,DSN=&ASG. .&CENTER..LOADLIB
//SYSABEND DD SYSOUT=&SYSOUT

//SYSUDUMP DD  SYSOUT=&SYSOUT

//MVDUMP DD DISP=SHR,DSN=&ASG. . &CENTER. . D#######
//MVINDEX DD SYSOUT=&SYSOUT

//MWWPRINT DD SYSOUT=&SYSOUT

/7/*
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CICS

//ASG JOB (), "ASG-SMARTQUEST " ,NOTIFY=&SYSUID

//7*

//7*

//7*

/ R R S o R o R S R R S R R R R R S S R R R R R R R R R R R R R R R R R R R R R e e o e
//* ASG, INC. ASG-SMARTQUEST FOR CICS *
//* *
//* MEMBER NAME: VICQJPRT *
//* *
//* DESCRIPTION: DUMP PRINT UTILITY. *
//* *
/ R R S R R R R S R R R R R R R R S S R R R R R R R R R R R R R R R R R R R R R R R e o e o
//7*

// SET ASG="ASG"

// SET CENTER="VIACENXX"

// SET SYSDA="SYSDA*

// SET SYSOUT="**

//VICQUPRN EXEC PGM=VICQUPRN,REGION=1M

//STEPLIB DD DISP=SHR,DSN=&ASG. .&CENTER..LOADLIB
//SYSABEND DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

//HSDUMP DD DISP=SHR,DSN=&ASG. .&CENTER. . D#######
//HSINDEX DD SYSOUT=&SYSOUT

//HSPRINT DD SYSOUT=&SYSOUT

Providing Source Support

94

To provide source-level support for your application programs, the necessary information
must be available in the SmartQuest source file. Thisinformation does not need to bein
the file when the abend occurs because you can add it later.

Note:

Y our source file information must exactly match your load modules to receive
predictable results.

Source information is added to the SmartQuest source file by running the compiler output
of your programs through a special post-compile processor. Y ou must modify your
compile and assembly JCL decks.

See the ASG-SmartQuest Installation Guide for more information about modifying your
compile JCL decks.



4 Utilities

Thisisthe basic post-compile JCL:

//VICQUPST EXEC PGM=VICQUPST,

// COND=(5,LT,COBOL2_COMPILE_STEP_NAME)

//STEPLIB DD DSN=VIASOFT.VIACENXX.LOADLIB,DISP=SHR
//SYSPRINT DD SYSOUT=*

//SYSABEND DD SYSOUT=*

//SYSUDUMP DD SYSOUT=*

//HSSOURCE DD DSN=VIAHLQ.VIAMLQ.SOURCE,DISP=SHR

//1SOURCE DD DSN=&&COBOUT,DISP=(OLD,DELETE)

//0SOURCE DD SYSOUT=*,DCB=(BLKS1ZE=1330, LRECL=133,RECFM=FBA)
//0REPORT DD SYSOUT=*,DCB=(BLKSIZE=1330,RECL=133,RECFM=FBA)
//0TEMPSRC DD DSN=&&TMPSRC,DISP=(NEW,PASS),

// SPACE=(TRK, (50,5) ,RLSE) ,UNIT=SYSDA,

// DCB=(BLKS1ZE=4096 , LRECL=4092 ,RECFM=V)

//IPARMS DD *

UPDATE , LANG=COBOL 2, LOADMOD=YOUR_LOAD_MODULE_NAME

/*

//* THE NEXT STEP IS ONLY RUN IF THE COMPILE ENDED RETURN CODE 5 OR
//* HIGHER.

//PRINT  EXEC PGM=IEBGENER,

// COND=(5,GE, COBOL2_COMPILE_STEP_NAME)

//SYSUT1 DD DSN=&&COBOUT,DISP=(OLD,DELETE)

//SYSUT2 DD SYSOUT=*

//SYSPRINT DD SYSOUT=*

//SYSIN DD DUMMY

/

//

The post-compile utility program is VICQUPST. The STEPLIB DD card specifies the
SmartQuest load library that contains this program. These are the other significant DD
cards:

- HSSOURCE isthe SmartQuest VSAM KSDS source file. Thisis where the final
source support information for the processed program is written.

- ISOURCE is a dataset containing your compiler or Assembler output listing.

=  OSOURCE iswhereacopy of your compiler or Assembler output listing iswritten,
and this DD card should therefore specify a SY SOUT dataset.

< OTEMPSRC isatemporary work file. All source file records are written to this
temporary dataset. When the post-compile processing is complete and all the
records have been built, they are copied to the VSAM source file (HSSOURCE).
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- IPARMS isthe required input parameter card. To provide source support, this
parameter card must have this format:

UPDATE, LANG=language , LOADMOD=1oad-module-name , CHG=new-name

where:

LANG= Required and must be one of these languages.
- COBOL2 (COBOL 2 release 3 and later)
- COBOL370 (COBOL for MVSandVM)
- PLI (PL/1 2.3.0)
- PLI370 (PL/I for MVSand VM)
- ASMH (Assembler H)
- HLASM (High-level Assembler)

LOADMOD= Optional and, if present, it must specify the final load
module name that this program forms apart of . If you omit
thisoperand, adefault load module nameisassigned. Inthe
case of COBOL, this name is the name on the first
PROGRAM ID card. For PL/I, thisnameisthe main
procedure name. For Assembler, this nameisthefirst
CSECT name.

CHG= Optional and, if specified, must appear last. When
information isnot stored in the source support file, itisheld
under LOAD MODULE NAME asthe main key and
CSECT NAME astheminor key. (For COBOL the CSECT
name is the name specified in the PROGRAM 1D field.) If
the CSECT name is changed during the link-edit by a
CHANGE card, source is not provided. Use the CHG=
parameter to avoid this problem. For example, if aCOBOL
program is CALLed HSCOB2A in the PROGRAM ID
field, but the link-edit contains the card CHANGE
HSCOB2A(HSCOB201), then code the IPARMS like this:

UPDATE, LANG=COBOLZ2, LOADMOD=HSCOB2A, CHG=HSCOB201

- OREPORT=isa SY SOUT dataset where the post-compile processor writes
informational and error messages. Check this output to ensure that post-compile
processing has been successfully completed.

The second step named PRINT is only executed if your actual compile step ends with an
unacceptabl e return code. This PRINT step causes the compiler output to be written
straight to a SY SOUT dataset so that compiler errors can be examined.
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Samples of these steps for each programming language can be found in these membersin

the SmartQuest JCL library:

COBOL 2 VICQJICC2 VISQJCC2
COBOL370 VICQJICC3 VISQJICCE
PL/ VICQJPLI VISQJPLI
PL/1370 VICQJ370 VI1SQJ370
ASMH VICQJICAS VISQICAS
HLASM VICQJHLA VISQIHLA

Maintaining and Listing the Source File Contents

Y ou can also use the VICQUPST program to delete or list entries on the sourcefile. The
sample JCL job issimilar to the JCL shown in the above source support section. These
are the differences:

<  ThelSOURCE, OSOURCE, and OTEMPSRC DD cards should all specify DD
DUMMY.

=  ThelPARM card should specify one of these options:
— LIST
— LIST,LOADMOD=l1oad-module-name
— DELETE,LOADMOD=load-module-name
— DELETE,DATE=yyyymmdd
— DELETE,LOADMOD=10ad-module-name,DATE=yyyymmdd
— FLIST,LOADMOD=1oad-module-name

—  LIST, specified by itself, lists all load modules for which source-level support
exists. For each module on thislist you can see the module and CSECT names,
thedatethissource support information wascreated, thelanguage of themodule
and some statistics about its source file records.

= You can specify amodule name for LIST. Use a specific name to produce a report
for asingle load module, or a generic name to produce areport for a group of load
modules. For example, LOADMOD=MY PROG or LOADMOD=MY*.
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- DELETE isused to delete asingle entry or a group of entries from the source file.
Y ou must specify aload module name, a generic load module name, or a date
parameter. Thedateisin theformat YYYYMMDD and causes al entries added to
the file before that date to be deleted. Y ou can specify bothaLOADMOD and a
DATE parameter when deleting entries.

- FLIST must have a non-generic load module name supplied on the LOADMOD
parameter. This option produces a diagnostic listing of the source file information
for asingle entry on thefile. It is not intended for customer use but may be
requested by ASG Customer Support.

A sample of the LIST option output is shown in Figure 65. The DELETE option produces
similar output.

Figure 65+« Sample LIST Option Output

(c)2002 Copyright ASG, Inc. ASG-SmartQuest 6.1.0 Page 2

Source File Program Summary Report

Load Csect Date Source Source Index Stmt/Offset Mapping Assoc. Data Assoc. Data
Module Name YYYY/MM/DD Language Records Records Records Records Records Index Records
MVMAPPRG MVMAPPRG 2002/04/30 Assembler H 81 1 2 36 0 0
VISQSASM VIAPXESA 2002/06/27 HL Assembler 28 1 2 7 0 0
VISQSCOB VISQSCOB 2002/06/27 Cobol 2 2 1 1 4 1 1
VISQSPLI VISQPLI1 2002/06/27 PLI 1 1 1 12 1 1

LIST processing completed
Total Entries 00000004
Return code = 00

Highest RC = 00

The JCL to run these different utilities are in the SmartQuest JCL library:

Lists entries on your sourcefile. VICQJILST VISQJILST
Delete entries on your sourcefile. VICQJIDEL VISQJIDEL
Produces a diagnostics listing. VICQJFIL VISQJFIL
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Reporting Problems

These sections discuss the procedures you should follow in the event of a problem with
any component of this software, and contains these sections:

Dump Viewer Problems 100
Problems With Batch Utilities 101
Note:

Dumps, tapes, and diskettes are requested only as alast resort. Every effort is made to
resolve problems quickly without having to request this type of information from our
customers. However, such information is required in some circumstances.
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Dump Viewer Problems

CICS

MVS

100

If an abend occurs in the dump viewer program, it is handled by the product’ s own abend
trapping and recovery routine. If this happens, the screen in Figure 66 appears.

Figure 66 « Abend Notification Screen

----------------- E3G-2martQuest Eor CICS - Abend Notification PanclImage
COHHAND ===;

Hodify the following panel iHage as required, press ENTER.

An error has oCCurred prOCESSingG Your Fequest.
Flease contactiXCONTACTHE+itdtttttttttttttits
Yo Aay be asked to provide the following infornationd

Date and tiWe of error -—X00.HH.YY —XHH.AH.22

CICE Applid ———-————————— =CICEAPPL
CICE Tranzaction ID =----- “TRAM
CICE Terdinal ID —====--- “TERH
CICE Abend Code —-——-----— ZAEND
CICE Tazk WuWber -—------ ZTAZKN
CICE User ID ———————-—-—— XCICEUZER

Press <CLEARY when ready to continue.

Prezz END key to return to the Henu.

Y ou should fax a hard copy of this screen immediately to ASG Customer Support. If you
are using the CICS interface, SmartQuest also capturesits own dump. Y ou should save
(Hold) this dump in case further information is required.

If adump appears as Incomp on the dump viewer list, you should expect errorsin the
display facility when you try to examine this dump. If an incomplete dump situation
occurs, it ismost likely due to an abend during the capture that is not handled and
recovered. Report any abends in the dump capture that cause dump capture failure to
ASG Customer Support.

Print and keep the CICS transaction dump that is produced for these abends and fax the
PSW and registers from the beginning of the dump.

Rerun the job after adding this DD card to your JCL and send the JES messages output to
the ASG Customer Support.

//DBGINQST DD DUMMY



5 Reporting Problems

If you have incorrect information on a Source display or aMapped display, and you have
determined that it is not a case of a source and object mismatch, send a hard copy of the
screen with any inaccurate information clearly highlighted. Y ou may be asked to supply a
copy of your compiler output and an FLIST utility printout for the program concerned.
These can be on paper, 3.5-inch diskette, or 3480 or 3490 cartridge, whichever is
convenient.

For other problems, please send hard copies of the screens and/or any other supporting
documentation. Also, if possible, please send a complete description of the events leading
up to the error.

Problems With Batch Utilities

If the post-compile processor or any of the other offline utilities abend, send the PSW and
registers from the dump and retain the dump in case further information is required. In the
case of the post-compile processor, you may also be asked to provide the compiler output
on 3480 cartridge or 3.5-inch diskette.

For other Batch utility problems, please supply hard copies clearly illustrating the nature
of the problem.
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Appendix A
Messages

These messages are produced and written to the CSSL TD QUEUE by default. Y ou can
change the TDQUEUE name for SmartQuest for CICS messages by modifying the
TDQNAME customization parameter. They are also written to the LOG file, if you have
this active.

VSA11101 Initializing SmartQuest X.xX.xX/xxXX on CICS XXXXXXXX
Issued to advise you that the SmartQuest for CICS initialization has begun.

VSA11111 SmartQuest is terminating
I ssued to advise you that the SmartQuest for CICS abend trapping mechanismis
being halted.

VSA11121 SmartQuest termination completed
Issued to inform you that the abend trapping mechanism has been successfully
halted.

VSA11131 SmartQuest is active
Information message regarding abend trapping mechanism status.

VSA11141 SmartQuest is not active
Information message regarding abend trapping mechanism status.

VSA11151 SmartQuest - Starting abend trapping transaction
Issued during initialization to inform you that the abend trapping transaction is
about to be started.

VSA11161 SmartQuest - Initialization is now complete
Issued when al initialization logic has been successfully executed.

VSA11171 SmartQuest -Customization module LOAD has failed
I ssued when the customization module fails to load.

VSA11181 SmartQuest - Input does not contain a command
Issued when you fail to enter acommand with the QST transaction.
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VSA1119E SmartQuest - Load of xxxxx has failed for EIBRESP
Error message caused by afailed attempt to load the exit program VICQCXPG.

VSA11241 Commencing installation verification
Issued during initialization when the PPT, PCT, and FILE installation verifications
commence.

VSA1125E Program Xxxxxxxxx is not defined to CICS
Issued when a PPT entry is missing for arequired SmartQuest for CICS program.

VSA1126E Program xxxxxxxx is not enabled
Issued when arequired SmartQuest for CICS program is flagged as disabled.

VSA1127E Transaction xxxx is not defined to CICS
Issued during initialization when a PCT entry for arequired SmartQuest for CICS
transaction is missing.

VSA1128E Transaction xxxx is not enabled
Issued during initialization when arequired SmartQuest for CICS transaction is
flagged as disabled.

VSA1129E File xxxxxxxx is not defined to CICS
Issued during initialization when arequired SmartQuest for CICSfile definitionis
missing.

VSA1130E Open of file xxxxxxxx has failed
Issued during initialization when an EXEC CICS OPEN for an SmartQuest for
CICS dataset fails.

VSA1131E Password XXXXXXXXXXXXXXXX s invalid
Issued during initialization when the password supplied in the customization
moduleisinvalid.

VSA1132E SmartQuest - Trial period has expired
Issued when the product has been installed on atrial basis, but the trial period has
expired.

VSA1133E SmartQuest - Product license has expired
Issued when the product has been installed under arental agreement but the rental
period and the 30-day grace period for renewal of the agreement have expired.

VSA1134W SmartQuest - Trial will expire in x day(s)
Issued when atrial period is 7 days or less from expiration.

VSA1135W SmartQuest - Product license will expire in x day(s)
Issued when arental period is 7 days or less from expiration.

VSA1136W SmartQuest - Use of product will be allowed for another
xx day(s)
Issued each day during the 30-day grace period after rental agreement expiration.
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VSA1137E SmartQuest - Initialization has failed
Issued when any serious initialization errors have been found. Other preceding
messages describe these errors.

VSA1138E SmartQuest - IQST transaction not authorized
This message displays when the current user is not authorized to run the IQST
(start/stop) transaction. In this case, thisis not due to RACF or similar external
security software, but due to the SmartQuest for CICS internal security table
settings.

VSB10751 SmartQuest - Dump capture commencing for transaction Xxxx
I ssued when dump capture commences.

VSB10761 SmartQuest - Dump capture complete for transaction Xxxx
I ssued when dump capture has been successfully completed.

VSB1078E SmartQuest - Unable to locate abending tasks TCA
Issued probably due to a storage corruption.

VSB1079E SmartQuest - Load of customization module has failed
I ssued when an EXEC CICS LOAD of the customization module VICQMCTM has
failed.

VSB1080E SmartQuest - GETMAIN of dump file 1/0 area has failed
Self explanatory.

VSB10811 SmartQuest - Capture of duplicate transaction xxxx has
been suppressed.
Issued when a duplicate dump is detected and its capture is suppressed.

VSB1082E SmartQuest - Error writing to dump file - EIBRESP=XXXXXXXX,
E I BRESP2=XXXXXXXX
Issued when an attempt to write a record to the dump file fails. Used to provide
diagnostics for your technical support group.

VSB10831 SmartQuest - Abend xxxx occurred iIn tran Xxxx, program
XXXXXXXX , OFFset XXXxXXX
Issued when an abend is processed by SmartQuest for CICS. Used to produce
statistics reports.
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These messages are produced and are written to the SmartQuest for MVS LOG file and
system log. You can print the full list of SmartQuest for MV S messages.

MVAOOO1E Load of VISQMCTM failed - RC=XXXXXXXX
Issued by the auto delete subtask when it fails to load the base customization
module VISQMCTM.

MVAO002 Auto delete commencing
Issued by the auto del ete subtask.

MVAOOO31 Auto delete completed
Issued by the auto del ete subtask.

MVA00041 Auto delete feature suppressed
Issued by the auto del ete subtask.

MVAOOOSE Open failure. FIIe=XXXXXXXX, RCEXXXXXXXX , XXXXXXXXX
Auto delete subtask attempted to open an SmartQuest for MV Sfile but received an
unexpected return code/error code.

MVAOOOG6E Invalid job PARM specified
Issued when the auto delete utility is run as a stand-alone task and incorrect PARM
data has been specified.

MVAQOOO71 Deleting. Job=xxxxxxxx,Abend=xxxx,Date=yyyy-mm-dd
I ssued when the auto delete subtask has selected a dump for deletion.

MVAOOO8W Auto delete error - GETMAIN failed
Issued by the auto del ete subtask when its dynamic storage GETMAIN request
fails.

MVAOOO9W Auto delete error - ENQ failed
To ensure the integrity of the dump file, the auto delete subtask issuesan MVS
ENQ to single thread all dump file 10. If the ENQ request fails, this messageis
issued.

MVAOO10E Dynamic allocation error. File=XXXXXXXX RC=XXXXXXXX
The auto delete subtask dynamically allocates all SmartQuest for MV Sfiles. If any
allocation request fails, this message appears followed by MVAQOL1I.

AV IO NN B S | [CE 0000 0000000000000 0000000000000 0000000000000
Issued after an MV AOOL0E dynamic allocation error message and givesthe DSN of
thefailing file.
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MVCOOO2E Load of MVCUSTOM has Failed - RC=XXXXXXXX

MVCOOOS5E Open failure. File=xXXXXXXX, RC=XXXXXXXX , XXXXXXXXX
MVCOOOBE  XXXXXXXXZXXXKXKX KX KX KX KX KX KX KX XX XK XK XXX K XK XXX KX KX KX KX
MVCOOO9E Dynamic Allocation error. File=XXXXXXXX,RC=XXXXXXXX
MVCOO10E **WARNING** Non recoverable error detected

MVCOO11E PSW address = XXXXXXXX XXXXXXXX,Code = XXXX

MVCOOL2E XXXXXXXX XXXXXXXX XXXXXXXX  XXXXXXXX

MVCO0191 ==> Job=XXXXXXXX , Pgm=XXXXXXXX ,Code=XXXX , 0/ S=XXXXXX

MVCOO023E CONFIG Name xxxxxxxx is invalid
The configuration name supplied in use could not be found in the SmartQuest
configuration file.

MVC00251 Dump capture suppressed - NONINQST DD card
Dump capture was suppressed because the JCL step contained a//NONINQST DD
card.

MVC00261 Dump capture suppressed - Excluded abend code
Dump capture was suppressed because the abend code isin the Exclusion table.

MVC00291 Dump capture suppressed - Excluded job name
Dump capture was suppressed because the job name matched a pattern in the
Exclusion table.

Note:

As shipped, thetableis set for Inclusion and specifies no Job name or patterns. This
suppresses all dump captures.

MVI00011 Initializing SmartQuest for MVS version X.X/XX
Issued to advise you that the SmartQuest for MV Sinitiaization has begun.

MVI0002E Load of VISQMCTM failed - RC=XXXXXXXX
Issued when a LOAD request for the customization base module VISQMCTM
fails. Check that you have the SmartQuest for MV S LINKLIB correctly installed in
your LNKLST.

MVIOOO3E Open for File xxxxxxxx Failed - RC=XXXXXXXX
Issued when SmartQuest for MV S start-up attempts to open the file XxXxxxxxx but
receives a bad return code. Check the return code and JES messages to determine
the cause and make any necessary corrections.
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MVIO004E Load of VISQCDTC failed - RC=XXXXXXXX
VISQCDTC islocated in the SmartQuest for MVSLINKLIB. It isthe SVC 51
hook and must be loaded for the product to function correctly. Check that the
SmartQuest for MV S LINKLIB has been correctly added to your LNKLST and has
been properly APF authorized.

MVI00051 VISQCDTC successfully loaded at XXXXXXXX
Issued to provide the load point address of SmartQuest for MV'S SV C 51 hook.

MVI00061 Activating ASG-SmartQuest for MVS SVC 51 hook
Issued during initialization to tell you that the abend trapping mechanism (the SVC
51 hook) is about to be started.

MVI0007E Attempt to hook SVC 51 failed - RC=XXXXXXXX
I ssued when the SVCUPDTE macro returned a non-zero return code.

MVI100081 ASG-SmartQuest for MVS abend trapping is now active
Issued to advise you that the SVC 51 hook has been successfully activated.

MVIOOO9E ASG-SmartQuest for MVS initialization has failed
Issued when product initialization has failed. This message is preceded by another
message describing the nature of the failure.

MVIOO10E Password XXXXXXXXXXXXXXXX is invalid
The password specified when you customized the product isinvalid. Check that this
has been entered correctly. If it has, contact ASG Customer Support immediately.

MVIOO011E Trial period has expired
I ssued when the product has been installed on trial basis but thetrial period allowed
has expired.

MVIOO12E Product license has expired
Issued when the product has been installed under arental agreement but the rental
period and the 30-day grace period for renewal of the agreement have expired.

MVI10013W Use of product will be allowed for another xxx days....
Issued each day during the 30-day grace period after rental agreement expiration.

MV10014W Trial period will expire in x day(s)
Issued when atrial period is 7 days or less from expiration.

MVI10015W Product license will expire in x day(s)
Issued when arental period is 7 days or less from expiration.

MVIO0161 Attaching auto delete subtask EP=VISQJATD
Auto deleting of dumps can be aslow task, especially if there are many dumps. In
order that the SmartQuest for MV S dump capture initialization is not slowed
dramatically, the auto deletion is performed by asubtask. This message informsyou
that it is about to be attached.
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MVI00171 Auto delete subtask attach successful
Issued when the auto delete subtask is successfully attached and auto deletionis
about to commence.

MVIO018W Auto delete subtask attach failed
Issued when the ATTACH macro returns a non-zero return code.

MVIO0191 SmartQuest for MVS version X.x/xx is currently active
Issued in response to an F MV SINQST,STATUS operator command.

MV100201 SmartQuest for MVS version x.x/xx is NOT currently active
Issued in responseto an F MV SINQST,STATUS operator command.

MV100211 SmartQuest for MVS shutdown is now complete
I ssued after successfully processing an F MV SINQST,SHUT operator command.

MV10022W SmartQuest for MVS shutdown request ignored
Issued when an F MV SINQST,SHUT command has been issued but SmartQuest
for MV Sisalready shutdown.

MVI0023E Open Failure. File=xxXXXXXXX, RC=XXXXXXXX , XXXXXXXX
Issued when an attempt to open the file XxXxxXxxxx gave a bad return code/error
code.

MV100241 True SVC 51 routine is at XXXXXXXX
Issued during initiaization. Informational message only to indicate the address of
the true SV C 51 processing routine that is replaced by our hook address.

MVIOO25E Invalid job PARM specified
Issued when invalid parameters have been specified on the MVSINQST start
command or in the MVSINQST procedure JCL.

MVIO026W Termination of SmartQuest for MVS requested
Issued in response to aP MV SINQST command.

MVI0027W SVC 51 address will be reset to XXXXXXXX
Issued in response to a P MV SINQST command after MV 10026W.

MVI0028E Reset of SVC 51 address failed, rc=xxxxxxxx
Issued when the SV CUPDTE macro failed to restore the true SV C 51 address to the
SVCtable after aP MV SINQST command was issued.

MVI00291 Reactivating SmartQuest for MVS version X.X/XxX
Issued in response to an F MV SINQST,INIT command.

MV100301 Deactivating SmartQuest for MVS version X.X/XX
Issued in response to an F MV SINQST,SHUT command.
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MVIOO34E Dynamic allocation error. File=xxXXXXXXX RC=XXXXXXXX
I ssued when an attempt to dynamically allocate arequired SmartQuest for MV Sfile
fails.

MV100351 Commencing dynamic allocation of files
Issued when file dynamic allocation routine is entered.

MVI00361 Dynamic allocation of files completed.
Issued when al files have been successfully allocated.

A2 [O[0XVA BN '9/0/00000 6000000000000 0000000000 I I IIIII0 0000000000004
Issued during dynamic allocation. 1 for each file allocated. Format is
DDNAME=DSNAME.

MV100381 Debug feature is active
Issued in response to an F MV SINQST,DON operator command. Indicates that the
global abending job trace featureis active.

MVI100391 Debug feature is not active
Issued in responseto an F MV SINQST,DOFF operator command. Indicates that the
global abending job trace featureis not active.

MVI0040E SmartQuest for MVS already started
Issued in response to an S MV SINQST command when a previous S MV SINQST
has been successfully processed.

MVI0041E SmartQuest for MVS start-up has abended
I ssued when the start-up program, VISQCSTR, abends. The PSW and registers at
the time of abend are output in the MV10042E and MV 10043E messages.

MVIOO42E PSW = XXXXXXXX XXXXXXXX .
Issued after MVI0041E and shows the PSW at the time of the start-up abend.

MVIO043E XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
Issued after MVI0041E and MV I0042E. Four messages appear, each showing 4
register contents from the start-up abend. The first shows RO-R3, the next R4-R7,
etc.
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MVLOOO2E Load of MVCUSTOM has Ffailed - RC=XXXXXXXX

MVLOOOSE Open failure. File=xXXXXXXX, RC=XXXXXXXX , XXXXXXXXX
MVLOOOBE  XXXXXXXX=XXXXXXKXXXX XXX KX XXX XXX KXHK XX KXHX KX XXX KX XXX X XXX
MVLOOO9E Dynamic Allocation error. File=XXXXXXXX,RC=XXXXXXXX
MVLOO10E **WARNING** Non recoverable error detected

MVLOO11E PSW address = XXXXXXXX XXXXXXXX,Code = XXXX

MVLOOL2E XXXXXXXX XXXXXXXX XXXXXXXX  XXXXXXXX

MVLO0191 ==> Job=XXXXXXXX , Pgm=XXXXXXXX ,Code=xXXXX , 0/ S=XXXXXX

MVTOOO1E Load of customization module has failed
Issued during SmartQuest for MV S installation when the customization module
failsto load. Contact your installation and maintenance System Programmer.

MVTOOO2E GETMAIN of control area has failed
Contact your installation and maintenance System Programmer.

MVTOOO3E Open of file xxxxxxxx has failed - reasonx=xxx
Contact your installation and maintenance System Programmer.

MVTOOO4E Use of TSO display facility not authorized
Issued during SmartQuest for MV Sinstallation. Contact your installation and
maintenance System Programmer.

MV1A0001 SmartQuest for MVS version of VISQCIEA invoked
MV1B0O001l SmartQuest for MVS version of VISQCIEB invoked
MV1C0001 SmartQuest for MVS version of VISQCIEC invoked

MV1P0O001 SmartQuest for MVS version of VISQCIEP invoked
I ssued when one of the SmartQuest for MV S PL/I 2.3.0 STAE/SPIE intercept
routinesisinvoked.

MV10002E Load of MVCUSTOM has failed - RC=XXXXXXXX
Issued when the capture process requests a load of the base customization module
and thisload fails.

MV10005E Open failure. File=xXXXXXXX, RCEXXXXXXXX , XXXXXXXXX

I ssued when an attempt to open an SmartQuest for MV Sfile returns a bad return
code/error code.
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MVIOO008E  XXXXXXXX=XXXXXXXXXXXX KX XXX KX XKXH XX XXX KX XXX KX XXX XX XXXX
Issued after MV COO09E. Reports the DDNAME=DSNAME of files that the
dynamic allocation routine has failed to allocate.

MV1009E Dynamic Allocation error. FIle=xXXXXXXX,RC=XXXXXXXX
I ssued when dynamic alocation of afile required for dump capture has failed.

MV10010E **WARNING** Non recoverable error detected
Issued when the dump capture process encounters a serious non-recoverable error.
Please report this immediately to ASG Customer Support. Thisis followed by
MV CO0011E and MV C0012E messages.

MVI0011E PSW address = XXXXXXXX XXXXXXXX,Code = XXXX
Issued after MV CO010E to give PSW address and system code of non-recoverable
eror.

MVI0012E XXXXXXXX XXXXXXXX XXXXXXXX XXXXXXXX
Issued 4 times after MV CO010E and MV COO11E to give the register contents from
a serious non-recoverable dump capture error.

MV100191 ==> Job=XXXXXXXX , PgM=XXXXXXXX ,Code=XXXX , 0/ S=XXXXXX
Issued as information message when abend capture is proceeding.
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Command Summary

This section is aquick reference summary of all the SmartQuest for CICS commands.
Y ou can perform most commands using aternative methods as indicated in the text. The
commands have been grouped logically into subsections.

Action Bar Equivalent Commands

Command Description

DETAILSor DETS  Displaysthe Dump Details Menu pull-down screen.

FILE Displays the File Selection menu.

FILTER Displays the Dump Filter Criteria pull-down screen.

HELPM Displays the Help Menu pull-down screen for access to online
help.

LABELSor LABS Displays the Labels pull-down screen. This command is only
effective if labels have been assigned to the currently selected
dump.

LIST Displays the Selected Dump List pull-down screen listing the
requested dumps.

MAPSEL Displays the Map Selection Menu pull-down screen. This
command is only effective on screens where field mapping is
allowed.

TOGGLES Displays the Toggles pull-down screen.
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Assigning and Locating Labeled Screens

Command Description

Scrolling

114

LOCATE label-name Retrieves and displays the screen with the assigned label.
or L label-name Y ou can also perform this function using the Labels action
bar option to display the Labels pull-down screen.

SET label-name or Assigns or reassigns the label 1abe I -name to the current

S label-name display. The name can be 1 to 30 charactersin length. The
first must be alphabetic (A-Z); the remaining can be any
keyboard characters, including imbedded blanks.

Note:

See "The Labels Action Bar Option" on page 60 and "Labeling Screens' on page 17 for
more information.

Command Description

DOWN Scrolls down.
LEFT Scrolls | eft.
MDOWN or M and Scrolls to the bottom.
(assigned Down PF key)
MUPor M and Scrollsto the top.
(assigned Up PF key)
RIGHT Scrollsright.
uUP Scrolls up.

Note:

If the scrolling feature is enabled, thisisindicated at the bottom of the screen. On
pull-down screens only, full page scrolling is supported. On all other scrollable screens,
partial scrolling is supported. Position the cursor and scroll up to make the cursor line the
top line of the next display. Paosition the cursor and scroll down to make the cursor line
the bottom line on the next display.
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Controlling the View Stacks

Command Description

CLOSE n Closes aview stack without losing its contents. n isthe view stack
number to be closed in the range 1 through 4.

END Drops down alevel in the current view stack. The current display is
discarded.
SWAP Switcheslogically from the current view stack to the next open view

stack. If al 4 view stacks are open, the sequence goes from 1 to 2,
to 3, to 4, and back to 1. Closed view stacks are omitted.

VIEW nor Vn Opensanew view stack or switchesthe current display to an already
opened view stack. Because there are amaximum of 4 view stacks,
n must be in the range 1 through 4.

Dump Details Command Equivalents

Command Description

DB2 Displaysthe last DB2 call information screen, if available.

DLIorDL1 Displaysthelast DL/1 call information screen, if available.

IBMHELP or IBMHELP  Displays the help information from the IBM-supplied

abend code CICS/ESA file DFHCMACD. If you do not specify an
operand, the command shows the information for the
current dump abend code. By specifying an operand, you
can view information for any other abend code.

PROGRAMS or PROGS Displaysthe Program calling chain detail screen.

PSW or REGS Displays the PSW and Registers screen.

SCRN or XSCRN Displays the last 3270 screen, if available. The SCRN
command displays the screen as the user seesit with the
cursor in place. The XSCRN command displaysitin
standard dump format and allows you to examine the buffer
control characters.

SPROGS Displays the Program calling chain summary screen.
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STORAGE or STOR Displays the CICS control block and acquired storage
screen.

SUMMARY or SUM Displays the Abend summary screen.

TRACE Displays the Trace table entries.

Mapped Display Commands
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Command Description

CORE Switches from a Mapped display to a Core display.

Fstring Searches only the field names portion of the screen looking

FIRST/LAST/NEXT/P  for aname with itsinitial characters matching the specified

REV string. NEXT isassumed if PREV, FIRST, and LAST are
omitted.

RFIND Repeats the last FIND command issued.
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Toggle Pull-down Screen Equivalent Commands

Command Description

ABAR Turns the action bar tabs items on and off. This command does not
disable the action bar itself, so you can position the cursor on an
action bar option and press Enter to display the pull-down screens.

ADATA Turns the Source Display Associated Data window on and off.

DATA Changes both the current ADATA and FDATA switch settings. It
either turns both off, turns both on, or reverses the settingsif oneis
currently off and the other ison. Y ou can also use the Toggles
pull-down menu.

FDATA Turns the Source Display Field Data Value feature on and off.

HEX Forcesall dataon the Sourcedisplay or Mapped display to be shown
in hexadecimal format or returnsto the default data type display
(i.e., actslike TSO 'HEX' and 'HEX OFF).

MODE Switches the ZOOM address AMODE from 31 bit to 24 bit and
back.
ZFORMAT Turnsthe zoom format flag on and off. When turned On, al screens

shown in responseto aZOOM are Core displays. When turned Off,
the default type displays are shown (Source or Disassembly for
program storage, Mapped with field names for non-program
storage).

Trace Display Commands (CICS Only)

Command Description

Fstring Finds the specified string in your trace. The string can be

FIRST/LAST/NEXT/P  normal characters, in single or double quotes, or a

REV start-column hexadecimal string in the format X'xXxxX..xxxx". NEXT is

end-column assumed if you do not specify PREV, LAST, or FIRST.
Start-column and end-column are optional.

RFIND Repeats the last FIND command issued.

117



ASG-SmartQuest User’s Guide

Source Display Commands

Command Description

* or INS Displays the page of source containing the failing or
calling statement.

ASSEM or ROLL Switches from a Source display to a Disassembly display.

CORE Switches from a Source display to a Core (standard dump
format) display.

Fstring Finds the specified string in your sourcelisting. The string

FIRST/LAST/NEXT/PRE can be normal characters, in single or double quotes, or a

V start-column hexadecimal string in the format X'xXxxx..xxxx". NEXT

end-column isassumed if you do not specify PREV, LAST, or FIRST.
Start-column and end-collumn are optional.

LOCATE nnnnnn or L ocates the specified source line nnnnnn, where

L nnnnnn nnnnnn isin therange 1 to the maximum line number of
the program being displayed.

RFIND Repeats the last FIND command issued.

USING Changes the default base register that is used to calculate

dsect-name,Rnn the address and contents of fieldsin the specified DSECT

(for Assembler Source displays only).
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Disassembly Display Commands

FXXXXXX Adjusts the start offset of the disassembly by adding the
hexadecimal offset xxxxxx to the current start offset.
EXXXXXX Changes the start offset of the disassembly to the offset

specified in the hexadecimal value XXXxxX.

CORE or ROLL

Switches from a Disassembly display to a Core display.

Fstring Finds the specified string, which may be charactersin single

FIRST/LAST or double quotes or a hexadecimal string in the format

INEXT/PREV X'XXXX..XxXxX'. NEXT is assumed if PREV, FIRST, and
LAST are omitted.

MAP or MAP Switchesto adisplay mapped with field names. If the areahas

map-name been shown mapped before, the MAP command by itself
suffices, because the map name is remembered. To map a
previously unmapped area or to map it with adifferent map,
specify the required map name as an operand of the command.
Use the Maps action bar option to display alist of available
maps.

RFIND Repeats the last FIND command issued.

SOURCE Switchesto a Source display if source support is available.

“XXXXXX Adjusts the start offset of the disassembly by subtracting the

hexadecimal offset xxxxxx from the current start offset.
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Core Display Commands
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FXXXXXX Adjusts the start offset of the Core display by adding the
hexadecimal offset xxxxxx to the current start offset.

EXXXXXX Changes the start offset of the Core display to the offset
specified in the hexadecimal value XXxXxxX.

ASSEM Switches from a Core display to a Disassembly display.

F string FIRST/LAST/
NEXT/PREV

Finds the specified string, which may be charactersin
single or double quotes or a hexadecimal string in the
format X'xXxxX..xxxX". NEXT isassumed if PREV,
FIRST, and LAST are omitted.

MAP or MAP map-name

Switchesto adisplay mapped with field names. If the area
has been shown mapped before, the MAP command by
itself suffices, because the map name is remembered. To
map a previously unmapped area or to map it with a
different map, specify the required map name as an
operand of the command. Use the Maps action bar option
to display alist of available maps.

RFIND

Repeats the last FIND command issued.

SOURCE or ROLL

Switchesto a Source display if source support isavailable.

= XXXXXX

Adjusts the start offset of the Core display by subtracting
the hexadecimal offset xxxxxx from the current start
offset.
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Miscellaneous Commands

address

Displays the screen for an address. While ZOOMing is the

preferred method of switching from one address to another,
you can also enter any valid hexadecimal address (without

leading zeros) on the command line.

control-block-

Displays all CICS, DL/1, and DB2 control blocks by typing

name their short name asacommand. A full list of these short names
can befoundin"Captured Control Blocks (CICS)" on page 38
and "Captured Control Blocks (MVS Only)" on page 40.

HELP Displays online help information for any type of display.

PFSHOW or KEY S

Displays a pop-up screen that lets individual users customize
the commands assigned to the 24 PF keysto satisfy their own
requirements. The changes are saved permanently in the
user’ s profile record in the SmartQuest Profilefile.

program-name

Displays any program in the program calling chain by typing
the program name as a command. Source is shown if
source-level support is available, otherwise it isshownin
disassembled format.

RETRIEVE

Recalls to the command line the last 20 commands entered in
seguence. When the required command displays, you can
press Enter to perform the command.

Rnn

Displays the storage at the address contained in register nn
(where nn isin the range O through 15). Depending on the
type of storage and the availability of source-level support, the
display is source, disassembly, mapped, or core.

Rnn+xxx

Resembles the Rnn command except the hexadecimal offset
XxxX (in the range 0-FFF) is added to the register address to
calculate the address to display.
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PF Key Summary

The PF keys for this product can be customized globally or by an individual user.
Customized PF key settings are saved permanently on the SmartQuest Profilefile. The
default PF key settings, as supplied with the product, are listed below.

Key Description

PF1 HELP

PF2 Unassigned

PF3 END

PF4 ROLL (Used to roll from a Source display to a Disassembly display,
then to a Core display and back to source)

PF5 RFIND

PF6 Unassigned

PF7 uUP

PF8 DOWN

PF9 SWAP

PF10 LEFT

PF11 RIGHT

PF12 RETRIEVE

PF13 HELP

PF14 RESUME

PF15 END

PF16 ROLL

PF17 RFIND

PF18 DEQ

PF19 uUP

PF20 DOWN
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PF21 SWAP
PF22 LEFT

PF23 RIGHT
PF24 RETRIEVE

By default, the CLEAR key is used to exit the dump viewer. Y ou can customize the

product to make PA1 or PA2 the exit key instead of CLEAR. Otherwise PA1 and PA2
have no assigned function.

To locally modify the PF keys and save the modificationsin your user profile

record

1 TypePFSHOW todisplay the User PF Key Customization screen shownin Figure 67.

Figure 67« User PF Key Customization Screen

ASG-EHartQUest 7.0.8 TE0
File Filter List Details Labels Haps Toggles Help

ConHand ===} pfshow
VIEW 1
A= mm User PF Key Custodization ----——----—-
FF1 HELFP FF13 HELFP Hettetetoth
PF2 PF14 REZUHE Hebbokekok
PFI EHND PF15% EXIT
PFd  ROLL PFi& ROLL
PFS RFIND PF17 RFIND Aotk
* PF& DETRILZ PF13 DEQ Aotk
# | PFT UP FF1% UP #k
#tk | PFS DOMN PF20 DOMN #*
btk | PF2 ZMAR FF21 ZWAP
dobbik | PFL1E LEFT PF22 LEFT
PF11 RIGHT PF23 RIGHT
PF12 RETRIEVE PF24d RETRIEVE
Co mmmm PF3=End

A proprietary product of ASG, INcC.

Uze restricted to authorized licensees.

Vizit the ASG Zupport Meb Zite at www.asgq.cod

--= CLERR=EXit

Change user

PF kews as required

2 Modify the commands for each PF key name as required and press Enter. The

changes take effect immediately.

Note:

See the ASG-SmartQuest Installation Guide for information about globally customizing
the PF keys.
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PRINT OFF 81
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VIEW 19
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control blocks captured
CICS 38
DB2 38
DL/1 38,40
MVS 40
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using 89
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PF keys 122
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control blocks captured 38
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deleting dumps manually 27
Details action bar 28
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DFHEISTG 33, 35
diagnostics, Sourcefile utility 97
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commands 119

detecting source object

mismatches 82

using 82
DL/1

control blocks captured 38, 40

IMS diagnostic information 47
DSA 33,35
dump capture

customizing 14

using SVC 51 intercept 3
dump viewer

acquired storage 37

commands 115

control block display 37

Coredisplay 89

Details action bar 28

Disassembly display 82

displaying DB2 diagnostic
information 51

displaying IMS diagnostic
information 47

displaying last 3270 42

File action bar 23

Filter action bar 24

Help action bar 70

IBM help information 43

Labels action bar 65

language environment 46

List action bar 26

Mapped storage display 85

Maps action bar 68

program calling chain detail 34

program calling chain summary 33

PSW and registersdisplay 31
reporting problems 100
Source display 73
Summary display 29
Toggles action bar 68
using 45

dumps
analyzing 5, 21
capturing 2
display list 23-24, 26
notification 5
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E

EIB
selecting 37
summary 30

Encore
accessing from ESW screen xi
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END command 18

equivalent commands
action bar 113
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dump detail 115
labeled screens 114
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Miscellaneous 121
scrolling 114
Source display 118
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accessing from ESW screen xi
description ix
ESW
description vii
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F
field data value display feature
controlling 76
using 73
File action bar 23
files
DFHCMACD 43
Filter action bar option 24
FIND command 45, 77, 86
FULINQST 14

G
genera source commands 76
GETMAINed storage 37

H
help
action bar option 70
displaying online 70
using DFHCMACD 43, 115
using IBM system abend code help 30

|
IBM Help Information display 43
IBMHELP command 115
Insight
accessing from ESW screen xi
description ix
using analysis functions xi
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J

JCL sample
dump print utility 92
post compile 95

L
labels
assigning 17, 66, 113
commands 114
using pull-down menu 17, 65
Labels action bar option 65
Language Environment
trace entries 46

Index

List action bar option 26
list contents of source file 97
LOCATE command 18, 67, 76

M
maintaining source file contents 97
MAP command 87
Mapped display commands 116
mapping
automatic mapping with field
names 85
contents and commands 85
manually 85
Maps action bar option 68
messages list of 103
miscellaneous commands 121
MODE command 69
MV'S control blocks captured 40

N
navigation aids
action bar and pull-downs 17
labels 17, 65
multiple views 19
view stacking 18
ZOOMing 20
NONINQST 14

@]
online print job submission 52

P
PF keys
modifying 122
summary of 122
PL/1 source support
coding restrictions 79
display 78
using post-compile processor 94
PRINT NOGEN command 81
PRINT OFF command 81
printing dumps
offline 92
online 52
product integration Xi
program calling chain
detail display 34
pull-down menu 28
summary display 33
PSW, displaying 31
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Recap
accessing from ESW screen xi
description ix
registers
displaying 31
using Rnn and Rnn+xxx
commands 32
using Rnn+ command 121
reliability 6

reporting problems 99
resources, requirements 6

S

screen
Analyze Submit 12

SET command 17

SmartDoc
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SmartEdit
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description x

SmartQuest
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SmartQuest for CICS
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SmartTest
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Source display
commands 76, 118
using 73

source file contents, maintaining 97

source-level support
Assembler considerations 80
COBOL considerations 77
languages 74
PL/I considerations 78
providing 94
source and object mismatch 37
Source display 73

Summary display, abend codes 29

T
TGT for COBOL, displaying 35
Toggles
action bar option 68
commands 117
Trace display
commands 117
using 45

trace table
expanded 46
formatting 45
TSO facilities, using 14
TSO interface, accessing dump viewer 9

U

utilities
maintaining source file 97
printing dumps 92
using 91

\%

VIASUB edit macro 13
VIEW command 19
view stack
commands 115
defined 18
multiple views 19

w
working storage, displaying 34

Z

ZFORMAT command 70, 90
Z0OO0M feature 69
ZOOMing 20, 89
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